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ÝÐßàïÖÕÝØÕÜ ßØâÐÝØï (RS-MMC), ÚÞâÞàÐï áÞÔÕàÖØâ ÔÞßÞÛÝØâÕÛìÝëÕ 
ßàØÛÞÖÕÝØï ÚÞàßÞàÐæØØ Nokia Ø áâÞàÞÝÝØå àÐ×àÐÑÞâçØÚÞÒ. ÁÞÔÕàÖØÜÞÕ 
RS-MMC Ø ÔÞáâãßÝÞáâì ßàØÛÞÖÕÝØÙ Ø ãáÛãÓ ×ÐÒØáØâ Þâ áâàÐÝë, ßÞáâÐÒéØÚÐ 
Ø/ØÛØ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ. ÍâØ ßàØÛÞÖÕÝØï Ø ÔÞßÞÛÝØâÕÛìÝãî 
ØÝäÞàÜÐæØî ßÞ àÐÑÞâÕ á ÝØÜØ ÜÞÖÝÞ ÝÐÙâØ ÝÐ áâàÐÝØæÕ 
www.nokia.com/support âÞÛìÚÞ ÝÐ ÝÕÚÞâÞàëå ï×ëÚÐå.
½ÐÛØçØÕ ÝÕÚÞâÞàëå äãÝÚæØÙ Ø ÒÞ×ÜÞÖÝÞáâÕÙ ×ÐÒØáØâ Þâ SIM-ÚÐàâë 
Ø/ØÛØ áÞâÞÒÞÙ áÕâØ, Þâ ãáÛãÓØ MMS, Ð âÐÚÖÕ Þâ áÞÒÜÕáâØÜÞáâØ ãáâàÞÙáâÒ 
Ø ßÞÔÔÕàÖÚØ àÐ×ÛØçÝëå äÞàÜÐâÞÒ áÞÔÕàÖØÜÞÓÞ. ·Ð ßÞÛì×ÞÒÐÝØÕ 
ÝÕÚÞâÞàëÜØ ãáÛãÓÐÜØ Ò×ØÜÐÕâáï ÔÞßÞÛÝØâÕÛìÝÐï ßÛÐâÐ.

¾Âº°· ¾Â ¿Àµ´¾ÁÂ°²»µ½¸Ï ³°À°½Â¸¸
¿àØÛÞÖÕÝØï áâÞàÞÝÝØå àÐ×àÐÑÞâçØÚÞÒ, ßàÕÔÞáâÐÒÛïÕÜëÕ ÝÐ ÜØÝØÐâîàÝÞÙ 
ÚÐàâÕ ÜãÛìâØÜÕÔØÐ (RS-MMC), áÞ×ÔÐÝë äØ×ØçÕáÚØÜØ ØÛØ îàØÔØçÕáÚØÜØ 
ÛØæÐÜØ, ÚÞâÞàëÕ ØÜÕîâ ÝÐ ÝØå ßàÐÒÞ ÒÛÐÔÕÝØï Ø ÚÞâÞàëÕ ÝÕ ØÜÕîâ 
ÞâÝÞèÕÝØï Ú ÚÞàßÞàÐæØØ Nokia. ºÞÜßÐÝØï Nokia ÝÕ ÞÑÛÐÔÐÕâ ÐÒâÞàáÚØÜØ 
ßàÐÒÐÜØ Ø/ØÛØ ßàÐÒÐÜØ ÝÐ ÞÑêÕÚâë ØÝâÕÛÛÕÚâãÐÛìÝÞÙ áÞÑáâÒÕÝÝÞáâØ 
Ò ÞâÝÞèÕÝØØ ãÚÐ×ÐÝÝëå ßàØÛÞÖÕÝØÙ áâÞàÞÝÝØå àÐ×àÐÑÞâçØÚÞÒ. ² áÒï×Ø 
á íâØÜ ÚÞÜßÐÝØï Nokia ÝÕ ßàØÝØÜÐÕâ ÝÐ áÕÑï ÞÑï×ÐâÕÛìáâÒ ßÞ ÚÐÚÞÙ-ÛØÑÞ 
ßÞÔÔÕàÖÚÕ ÚÞÝÕçÝëå ßÞÛì×ÞÒÐâÕÛÕÙ ØÛØ ÞÑÕáßÕçÕÝØî äãÝÚæØÞÝØàÞÒÐÝØï 
íâØå ßàØÛÞÖÕÝØÙ áâÞàÞÝÝØå àÐ×àÐÑÞâçØÚÞÒ, Ð âÐÚÖÕ ÝÕ ÝÕáÕâ ÞâÒÕâáâÒÕÝÝÞáâØ 
×Ð ØÝäÞàÜÐæØî, áÞÔÕàÖÐéãîáï Ò ßàØÛÞÖÕÝØïå ØÛØ Ò íâØå ÜÐâÕàØÐÛÐå. 
ºÞàßÞàÐæØï Nokia ÝÕ ßàÕÔÞáâÐÒÛïÕâ ÝØÚÐÚØå ÓÐàÐÝâØÙ Ò ÞâÝÞèÕÝØØ 
ãÚÐ×ÐÝÝëå ßàØÛÞÖÕÝØÙ.

²Ë ¿À¸·½°µÂµ, ÇÂ¾ ¿À¾³À°¼¼½¾µ ¾±µÁ¿µÇµ½¸µ ¸/¸»¸ ¿À¸»¾¶µ½¸Ï 
(Á¾²¼µÁÂ½¾ «¿¾») ¿Àµ´¾ÁÂ°²»ÏÎÂÁÏ ½° ÃÁ»¾²¸¸ «º°º µÁÂÌ» ±µ· 
º°º¸Å-»¸±¾, ² ¼°ºÁ¸¼°»Ì½¾ ´¾¿ÃÁÂ¸¼¾¹ ¿À¸¼µ½¸¼Ë¼ 
·°º¾½¾´°Âµ»ÌÁÂ²¾¼ ÁÂµ¿µ½¸, Ï²½¾ ²ËÀ°¶µ½½ËÅ ¸»¸ 
¿¾´À°·Ã¼µ²°µ¼ËÅ ³°À°½Â¸¹. NOKIA ¸ °ÄÄ¸»¸À¾²°½½Ëµ Á ½µ¹ »¸Æ° 
½µ ´µ»°ÎÂ ½¸º°º¸Å ·°Ï²»µ½¸¹ ¸ ½µ ¿Àµ´¾ÁÂ°²»ÏÎÂ ³°À°½Â¸¹, º°º 
Ï²½¾ ²ËÀ°¶µ½½ËÅ, Â°º ¸ ¿¾´À°·Ã¼µ²°µ¼ËÅ, ²º»ÎÇ°Ï, ² Ç°ÁÂ½¾ÁÂ¸, 
³°À°½Â¸Î ¿À°²° Á¾±ÁÂ²µ½½¾ÁÂ¸, Á¾¾Â²µÂÁÂ²¸Ï ½¾À¼°»Ì½Ë¼ 
ÀË½¾Ç½Ë¼ ÂÀµ±¾²°½¸Ï¼, ¿À¸³¾´½¾ÁÂ¸ ´»Ï ¸Á¿¾»Ì·¾²°½¸Ï 
² ¾¿Àµ´µ»µ½½ËÅ Æµ»ÏÅ, ° Â°º¶µ ³°À°½Â¸¹ Â¾³¾, ÇÂ¾ ¿¾ ½µ ½°ÀÃÈ°µÂ 
¿°Âµ½Â½ËÅ ¸»¸ °²Â¾ÀÁº¸Å ¿À°², ¿À°² ²»°´µ»ÌÆ° Â¾À³¾²¾¹ ¼°Àº¸, 
´ÀÃ³¸Å ¿À°² ÂÀµÂÌ¸Å »¸Æ. ½¸ º¾À¿¾À°Æ¸Ï NOKIA, ½¸ µµ 

°ÄÄ¸»¸À¾²°½½Ëµ »¸Æ° ½°ÁÂ¾ÏÉ¸¼ ½µ ³°À°½Â¸ÀÃÎÂ, ÇÂ¾ 
²Áµ ÄÃ½ºÆ¸¸ ´°½½¾³¾ ¿À¾³À°¼¼½¾³¾ ¾±µÁ¿µÇµ½¸Ï ±Ã´ÃÂ 
Á¾¾Â²µÂÁÂ²¾²°ÂÌ ²°È¸¼ ÂÀµ±¾²°½¸Ï¼, ÇÂ¾ ¿À¾³À°¼¼½¾µ 
¾±µÁ¿µÇµ½¸µ ±Ã´µÂ À°±¾Â°ÂÌ ±µ· Á±¾µ² ¸ ½µ ±Ã´µÂ Á¾´µÀ¶°ÂÌ 
º°º¸Å-»¸±¾ ¾È¸±¾º. ²Ë ¿À¸½¸¼°µÂµ ½° Áµ±Ï ²ÁÎ ¾Â²µÂÁÂ²µ½½¾ÁÂÌ 
¸ À¸Áº, Á²Ï·°½½Ëµ Á ²Ë±¾À¾¼ ´°½½¾³¾ ¿À¾³À°¼¼½¾³¾ ¾±µÁ¿µÇµ½¸Ï, 
½µ¾±Å¾´¸¼¾³¾ ²°¼ ´»Ï ´¾ÁÂ¸¶µ½¸Ï ¶µ»°µ¼ËÅ Àµ·Ã»ÌÂ°Â¾², 
° Â°º¶µ Á²Ï·°½½Ëµ Á ÃÁÂ°½¾²º¾¹, ¸Á¿¾»Ì·¾²°½¸µ¼ ¸ Àµ·Ã»ÌÂ°Â°¼¸ 
¸Á¿¾»Ì·¾²°½¸Ï ¿À¾³À°¼¼½¾³¾ ¾±µÁ¿µÇµ½¸Ï. ² ¼°ºÁ¸¼°»Ì½¾ 
´¾¿ÃÁÂ¸¼¾¹ ´µ¹ÁÂ²ÃÎÉ¸¼ ·°º¾½¾´°Âµ»ÌÁÂ²¾¼ ÁÂµ¿µ½¸ 
º¾À¿¾À°Æ¸Ï NOKIA, µµ À°±¾Â½¸º¸ ¸»¸ °ÄÄ¸»¸À¾²°½½Ëµ »¸Æ° ½¸ 
¿À¸ º°º¸Å ¾±ÁÂ¾ÏÂµ»ÌÁÂ²°Å ½µ ½µÁÃÂ ¾Â²µÂÁÂ²µ½½¾ÁÂ¸ ·° Ã¿ÃÉµ½½ÃÎ 
²Ë³¾´Ã, ½µ´¾¿¾»ÃÇµ½½Ëµ ´¾Å¾´Ë, ¿¾ÂµÀÏ½½Ë¹ Á±ËÂ, ÃÂÀ°Çµ½½Ëµ 
´°½½Ëµ ¸ ¸½Ä¾À¼°Æ¸Î, À°ÁÅ¾´Ë ½° ¿À¸¾±ÀµÂµ½¸µ ·°¼µÉ°ÎÉ¸Å 
Â¾²°À¾² ̧ »¸ ÃÁ»Ã³, ¿¾ÀÇÃ ̧ ¼ÃÉµÁÂ²°, ²Àµ´, ¿À¸Ç¸½µ½½Ë¹ »¸Ç½¾ÁÂ¸, 
¿À¸¾ÁÂ°½¾²ºÃ ´µÏÂµ»Ì½¾ÁÂ¸, ° Â°º¶µ ·° ¸½Ëµ ¿ÀÏ¼Ëµ, º¾Á²µ½½Ëµ, 
Á»ÃÇ°¹½Ëµ, Ä¸½°½Á¾²Ëµ Ã±ËÂº¸, Ã±ËÂº¸, ¿À¸ÁÃ¶´°µ¼Ëµ ² º°ÇµÁÂ²µ 
²¾·¼µÉµ½¸Ï ¸»¸ ÈÂÀ°Ä°, ¸½Ëµ ¿ÀÏ¼Ëµ ¸»¸ º¾Á²µ½½Ëµ Ã±ËÂº¸, 
²¾·½¸ºÈ¸µ ¿¾ º°º¾¹-»¸±¾ ¿À¸Ç¸½µ, ½µ·°²¸Á¸¼¾ ¾Â Â¾³¾, ²¾·½¸º»¸ 
»¸ ¾½¸ ² Á²Ï·¸ Á ¸Á¿¾»½µ½¸µ¼ ´¾³¾²¾À°, ½°ÀÃÈµ½¸µ¼ 
³À°¶´°½Áº¾³¾ ·°º¾½¾´°Âµ»ÌÁÂ²°, ½µ±Àµ¶½¾ÁÂÌÎ, ¸½Ë¼¸ 
¾±Ï·°Âµ»ÌÁÂ²°¼¸, ²¾·½¸ºÈ¸¼¸ ² Àµ·Ã»ÌÂ°Âµ ÃÁÂ°½¾²º¸, 
¸Á¿¾»Ì·¾²°½¸Ï ̧ »¸ ½µ²¾·¼¾¶½¾ÁÂ¸ ̧ Á¿¾»Ì·¾²°½¸Ï ¿À¾³À°¼¼½¾³¾ 
¾±µÁ¿µÇµ½¸Ï ´°¶µ ² Â¾¼ Á»ÃÇ°µ, µÁ»¸ º¾À¿¾À°Æ¸Ï NOKIA ¸»¸ µµ 
°ÄÄ¸»¸À¾²°½½Ëµ »¸Æ° ±Ë»¸ Ã²µ´¾¼»µ½Ë ¾ ²¾·¼¾¶½¾ÁÂ¸ Â°º¸Å 
Ã±ËÂº¾². ½µº¾Â¾ÀËµ ÁÂÀ°½Ë/³¾ÁÃ´°ÀÁÂ²°/¿À°²¾²Ëµ Á¸ÁÂµ¼Ë ½µ 
´¾¿ÃÁº°ÎÂ ¾Âº°·° ¾Â ¾Â²µÂÁÂ²µ½½¾ÁÂ¸ ¸»¸ µµ ¾³À°½¸Çµ½¸Ï, ½¾ 
´¾¿ÃÁº°ÎÂ ¾³À°½¸Çµ½¸µ ¼°ÂµÀ¸°»Ì½¾¹ ¾Â²µÂÁÂ²µ½½¾ÁÂ¸, ¿¾ÍÂ¾¼Ã 
² Â°º¸Å Á»ÃÇ°ÏÅ ¾Â²µÂÁÂ²µ½½¾ÁÂÌ º¾À¿¾À°Æ¸¸ NOKIA, µµ À°±¾Â½¸º¾² 
¸»¸ °ÄÄ¸»¸À¾²°½½ËÅ »¸Æ ¾³À°½¸Ç¸²°µÂÁÏ 50 µ²À¾. ¿¾»¾¶µ½¸Ï 
½°ÁÂ¾ÏÉµ³¾ ¾Âº°·° ¾Â ¿Àµ´¾ÁÂ°²»µ½¸Ï ³°À°½Â¸¸ ½µ ¾³À°½¸Ç¸²°ÎÂ 
ÃÁÂ°½¾²»µ½½ËÅ ·°º¾½¾¼ ¿À°² ÁÂ¾À¾½Ë, ²ËÁÂÃ¿°ÎÉµ¹ ² º°ÇµÁÂ²µ 
¿¾ÂÀµ±¸Âµ»Ï.
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²ÒÕÔÕÝØÕ
½ÞÜÕà ÜÞÔÕÛØ: Nokia N72-5

² ÔÐÛìÝÕÙèÕÜ ãáâàÞÙáâÒÞ ØÜÕÝãÕâáï Nokia N72.

ÂÕÛÕäÞÝ Nokia N72 – íâÞ ÜÝÞÓÞäãÝÚæØÞÝÐÛìÝÞÕ 
ØÝâÕÛÛÕÚâãÐÛìÝÞÕ ãáâàÞÙáâÒÞ ÜãÛìâØÜÕÔØÐ. 
ÀÐ×ÝÞÞÑàÐ×ÝëÕ ßàØÛÞÖÕÝØï, ßàÕÔÞáâÐÒÛïÕÜëÕ 
ÚÞÜßÐÝØÕÙ Nokia Ø ÔàãÓØÜØ áâÞàÞÝÝØÜØ 
àÐ×àÐÑÞâçØÚÐÜØ ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï, 
ßÞÜÞÓÐîâ ãáÞÒÕàèÕÝáâÒÞÒÐâì ÒÞ×ÜÞÖÝÞáâØ Nokia N72.

½ÕÚÞâÞàëÕ Ø× ßàÕÔÞáâÐÒÛïÕÜëå ßàØÛÞÖÕÝØÙ 
ÝÐåÞÔïâáï Ò ßÐÜïâØ ãáâàÞÙáâÒÐ, Ð ÝÕÚÞâÞàëÕ 
áÞÔÕàÖÐâáï ÝÐ ÚÞÜßÐÚâ-ÔØáÚÕ, ßÞáâÐÒÛïÕÜÞÜ 
ÒÜÕáâÕ á ãáâàÞÙáâÒÞÜ.

½ÐÛØçØÕ íâØå ßàØÛÞÖÕÝØÙ Ò ßàÞÔÐÖÕ ×ÐÒØáØâ 
Þâ áâàÐÝë Ø Þâ âÞàÓÞÒÞÙ âÞçÚØ.

´Ûï àÐÑÞâë á ÝÕÚÞâÞàëÜØ ßàØÛÞÖÕÝØïÜØ ÝÕÞÑåÞÔØÜÞ 
ßàØÝïâì ãáÛÞÒØï áÞÞâÒÕâáâÒãîéÕÙ ÛØæÕÝ×ØØ.

² ÔÐÝÝÞÜ ÔÞÚãÜÕÝâÕ ÝÐÛØçØÕ ßàØÛÞÖÕÝØï 
ÞÑÞ×ÝÐçÐÕâáï áÛÕÔãîéØÜØ ×ÝÐçÚÐÜØ: ÝÐ ÚÐàâÕ 
ßÐÜïâØ ( ) ØÛØ ÝÐ ÚÞÜßÐÚâ-ÔØáÚÕ ( ).

 ¿àØÜÕçÐÝØÕ. µáÛØ ÚÐàâÐ ßÐÜïâØ Ø×ÒÛÕçÕÝÐ, 
ßàØÛÞÖÕÝØÕ, ãáâÐÝÞÒÛÕÝÝÞÕ ÝÐ íâÞÙ ÚÐàâÕ ßÐÜïâØ, 
ÝÕ àÐÑÞâÐÕâ. ´Ûï ÔÞáâãßÐ Ú ßàØÛÞÖÕÝØïÜ ÒÝÞÒì 
ãáâÐÝÞÒØâÕ ÚÐàâã ßÐÜïâØ.

 ¿àØÜÕçÐÝØÕ. ´Ûï àÐÑÞâë á ßàØÛÞÖÕÝØïÜØ 
ÝÐ ÚÞÜßÐÚâ-ÔØáÚÕ ÝÕÞÑåÞÔØÜÞ ãáâÐÝÞÒØâì Øå ÝÐ 
áÞÒÜÕáâØÜëÙ ÚÞÜßìîâÕà.

ÃáÛãÓØ áÕâØ
ÀÐÑÞâÐ âÕÛÕäÞÝÐ ÒÞ×ÜÞÖÝÐ âÞÛìÚÞ ßàØ ÝÐÛØçØØ 
ÞÑáÛãÖØÒÐÝØï, ßàÕÔÞáâÐÒÛïÕÜÞÓÞ ßÞáâÐÒéØÚÞÜ ãáÛãÓ 
áÞâÞÒÞÙ áÒï×Ø. ¼ÝÞÓØÕ äãÝÚæØØ ãáâàÞÙáâÒÐ ×ÐÒØáïâ Þâ 
âÞÓÞ, ßÞÔÔÕàÖØÒÐÕâ ÛØ Øå áÞâÞÒÐï áÕâì. ² ÝÕÚÞâÞàëå 
áÞâÞÒëå áÕâïå ßàÕÔÞáâÐÒÛïîâáï ÝÕ ÒáÕ ãáÛãÓØ, ÚàÞÜÕ 
âÞÓÞ, ÔÛï ØáßÞÛì×ÞÒÐÝØï ÝÕÚÞâÞàëå ãáÛãÓ áÕâØ 
âàÕÑãÕâáï ÞäÞàÜÛÕÝØÕ áßÕæØÐÛìÝÞÓÞ áÞÓÛÐèÕÝØï 
á ßÞáâÐÒéØÚÞÜ ãáÛãÓ. ´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï 
ßÞ ØáßÞÛì×ÞÒÐÝØî ãáÛãÓ áÕâØ, Ð âÐÚÖÕ Þ âÐàØäÐå 
ßàÕÔÞáâÐÒÛïÕâáï ßÞáâÐÒéØÚÞÜ ãáÛãÓ. ² ÝÕÚÞâÞàëå 
áÞâÞÒëå áÕâïå ØÜÕîâáï ÞÓàÐÝØçÕÝØï ÝÐ ßÞÛì×ÞÒÐÝØÕ 
ãáÛãÓÐÜØ áÕâØ. ½ÐßàØÜÕà, ÝÕ ßÞÔÔÕàÖØÒÐîâáï ãáÛãÓØ 
ÝÐ ÞßàÕÔÕÛÕÝÝëå ï×ëÚÐå Ø ÝÕ ÞâÞÑàÐÖÐîâáï 
ÝÕÚÞâÞàëÕ áØÜÒÞÛë ÝÐæØÞÝÐÛìÝëå ÐÛäÐÒØâÞÒ.
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¿ÞÔÔÕàÖÚÐ
¿àØÛÞÖÕÝØï, ßàÕÔÞáâÐÒÛÕÝÝëÕ áâÞàÞÝÝØÜØ 
àÐ×àÐÑÞâçØÚÐÜØ ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï, 
ßÞÔÔÕàÖØÒÐîâáï íâØÜØ àÐ×àÐÑÞâçØÚÐÜØ. ² áÛãçÐÕ 
ÒÞ×ÝØÚÝÞÒÕÝØï ×ÐâàãÔÝÕÝØÙ á ßàØÛÞÖÕÝØÕÜ 
ßÞÛãçØâÕ ßÞÔÔÕàÖÚã ÝÐ áÞÞâÒÕâáâÒãîéÕÜ ÒÕÑ-áÐÙâÕ. 
ÁÜ. ÒÕÑ-ááëÛÚØ Ò ÚÞÝæÕ ÞßØáÐÝØï ÚÐÖÔÞÓÞ 
ßàØÛÞÖÕÝØï Ò ÝÐáâÞïéÕÜ àãÚÞÒÞÔáâÒÕ.
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¾äØá
Symantec Mobile 
Security

Symantec Mobile Security – íâÞ àÕèÕÝØÕ ßÞ 
ÞÑÕáßÕçÕÝØî ÑÕ×ÞßÐáÝÞáâØ ÜÞÑØÛìÝëå ãáâàÞÙáâÒ, 
ÒÚÛîçÐîéÕÕ ÐÝâØÒØàãáÝãî ×ÐéØâã Ø ×ÐéØâã 
á ßÞÜÞéìî ÑàÐÝÔÜÐãíàÐ. ´ÐÝÝÞÕ àÕèÕÝØÕ 
ßàÕÔÝÐ×ÝÐçÕÝÞ ÔÛï ×ÐéØâë ãáâàÞÙáâÒÐ Þâ 
ÒàÕÔÞÝÞáÝÞÓÞ áÞÔÕàÖØÜÞÓÞ Ø ×ÛÞãÜëèÛÕÝÝëå ÐâÐÚ.

 ¿àØÜÕçÐÝØÕ. ÍâÞ ßàØÛÞÖÕÝØÕ àÕÐÛØ×ÞÒÐÝÞ ÝÕ 
ÔÛï ÒáÕå ï×ëÚÞÒ.

´Ûï ãáâÐÝÞÒÚØ ßàØÛÞÖÕÝØï ÝÐÖÜØâÕ  Ø ÒëÑÕàØâÕ 
¾äØá, ×ÐâÕÜ ÒëÑÕàØâÕ ãáâÐÝÞÒÞçÝëÙ äÐÙÛ Symantec 
Mobile Security. ´Ûï ÒëßÞÛÝÕÝØï ãáâÐÝÞÒÚØ áÛÕÔãÙâÕ 
ØÝáâàãÚæØïÜ ÝÐ íÚàÐÝÕ. ¿àØÛÞÖÕÝØÕ ãáâÐÝÐÒÛØÒÐÕâáï 
Ò ßÐßÚã ¾äØá.

´ÐÝÝÞÕ ßàØÛÞÖÕÝØÕ ïÒÛïÕâáï ÞæÕÝÞçÝÞÙ ÒÕàáØÕÙ. 
¾æÕÝÞçÝëÙ ßÕàØÞÔ ÝÐçØÝÐÕâáï á ÜÞÜÕÝâÐ ãáâÐÝÞÒÚØ 
Symantec Mobile Security. ÇâÞÑë ßàÞÔÞÛÖØâì 
ØáßÞÛì×ÞÒÐÝØÕ ßàØÛÞÖÕÝØï ßÞ ØáâÕçÕÝØØ ÞæÕÝÞçÝÞÓÞ 
ßÕàØÞÔÐ, ÒÞáßÞÛì×ãÙâÕáì ãáÛãÓÞÙ LiveUpdate ÔÛï 
ßÞÚãßÚØ ÞÑÝÞÒÛÕÝÝÞÙ ÒÕàáØØ ßàÞÔãÚâÐ Ø ÒëßÞÛÝØâÕ 
ØÝáâàãÚæØØ ÝÐ íÚàÐÝÕ.

¿àØÛÞÖÕÝØÕ àÐÑÞâÐÕâ Ò äÞÝÞÒÞÜ àÕÖØÜÕ ÒÞ ÒàÕÜï 
ØáßÞÛì×ÞÒÐÝØï ãáâàÞÙáâÒÐ Ø ÐÒâÞÜÐâØçÕáÚØ ßàÞÒÕàïÕâ 
äÐÙÛë ßàØ Øå ßÞÛãçÕÝØØ ÝÐ ÝÐÛØçØÕ ÒØàãáÞÒ. ´Ûï 
ßàÞÒÕàÚØ ãáâàÞÙáâÒÐ ÒàãçÝãî ÒëÑÕàØâÕ ¿ÐàÐÜÕâàë > 
¾áÜÞâà. ¿àØ ÞÑÝÐàãÖÕÝØØ äÐÙÛÐ, ×ÐàÐÖÕÝÝÞÓÞ 
ÒØàãáÞÜ, ÝÐ ÔØáßÛÕÕ ÞâÞÑàÐÖÐÕâáï áÞÞÑéÕÝØÕ Ø ÜÞÖÝÞ 
ÒëÑàÐâì ÔÕÙáâÒØÕ, ÚÞâÞàÞÕ ÑãÔÕâ ÒëßÞÛÝÕÝÞ ÝÐÔ 
äÐÙÛÞÜ.

±àÐÝÔÜÐãíà ÞâáÛÕÖØÒÐÕâ áÞÕÔØÝÕÝØï, ÒÞ ÒàÕÜï 
ÚÞâÞàëå ÔÐÝÝëÕ ßÕàÕÔÐîâáï á ãáâàÞÙáâÒÐ ØÛØ ÝÐ 
ãáâàÞÙáâÒÞ, Ø àÕÓØáâàØàãÕâ ÝÕáÐÝÚæØÞÝØàÞÒÐÝÝëÕ 
áÞÕÔØÝÕÝØï. ´Ûï ßàÞáÜÞâàÐ ÖãàÝÐÛÐ ÒëÑÕàØâÕ 
¿ÐàÐÜÕâàë > ¶ãàÝÐÛ ÞßÕàÐæØÙ.

´ÞÑÐÒìâÕ Ò ãáâàÞÙáâÒÞ áÐÜëÕ ßÞáÛÕÔÝØÕ äÐÙÛë 
àÐáßÞ×ÝÐÒÐÝØï ÒØàãáÞÒ Ø ÞÑÝÞÒÛÕÝÝëÕ ÒÕàáØØ 
ßàÞÔãÚâÞÒ. ´Ûï íâÞÓÞ ÒëÑÕàØâÕ ¿ÐàÐÜÕâàë > 
LiveUpdate. ´Ûï ÒëßÞÛÝÕÝØï ÞÑÝÞÒÛÕÝØï ÒàãçÝãî 
ÒëÑÕàØâÕ âàÕÑãÕÜëÕ ÞÑêÕÚâë, ×ÐâÕÜ ÒëÑÕàØâÕ 
¿ÐàÐÜÕâàë > ¿ÞØáÚ. ´Ûï ÝÐ×ÝÐçÕÝØï ÐÒâÞÜÐâØçÕáÚØå 
ÞÑÝÞÒÛÕÝØÙ Ø ÝÐßÞÜØÝÐÝØÙ ÒëÑÕàØâÕ ¿ÐàÐÜÕâàë > 
Settings.

´Ûï ØáßÞÛì×ÞÒÐÝØï ãáÛãÓØ ÞÑÝÞÒÛÕÝØï ÝÕÞÑåÞÔØÜÞ 
ÝÐáâàÞØâì âÞçÚã ÔÞáâãßÐ Ò ¸ÝâÕàÝÕâ Ò ãáâàÞÙáâÒÕ. 
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´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî Þ âÞçÚÐå ÔÞáâãßÐ 
áÜ. Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ ãáâàÞÙáâÒÐ.

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
ÇâÞÑë ÞâÚàëâì áßàÐÒÚã ÔÛï ßàØÛÞÖÕÝØï, ÒëÑÕàØâÕ 
¿ÐàÐÜÕâàë > ÁßàÐÒÚÐ.

´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî ÜÞÖÝÞ ÝÐÙâØ ÝÐ 
ÒÕÑ-áÐÙâÕ www.symantec.com/techsupp. 

Quickword 

¿àØÛÞÖÕÝØÕ Quickword ÔÛï ãáâàÞÙáâÒÐ Nokia N72 
ßÞÔÔÕàÖØÒÐÕâ ÝÐØÑÞÛÕÕ çÐáâÞ ØáßÞÛì×ãÕÜëÕ äãÝÚæØØ 
Microsoft Word 97, 2000 Ø XP, Ð âÐÚÖÕ íÛÕÚâàÞÝÝëÕ 
ÚÝØÓØ Palm Ò äÞàÜÐâÕ «.doc». Á ßÞÜÞéìî ßàØÛÞÖÕÝØï 
Quickword ÜÞÖÝÞ çØâÐâì ØáåÞÔÝëÕ ÔÞÚãÜÕÝâë 
Microsoft Word ÝÐ ÔØáßÛÕÕ ãáâàÞÙáâÒÐ. ¿àØÛÞÖÕÝØÕ 
Quickword ßÞÔÔÕàÖØÒÐÕâ ÞâÞÑàÐÖÕÝØÕ æÒÕâÞÒ, 
ßÞÛãÖØàÝÞÓÞ èàØäâÐ, ÚãàáØÒÐ Ø ßÞÔçÕàÚØÒÐÝØï, 
Ð âÐÚÖÕ àÕÖØÜ ÞâÞÑàÐÖÕÝØï ÝÐ ÒÕáì íÚàÐÝ.

 ÁÞÒÕâ. ¿àØÛÞÖÕÝØÕ Quickword ßàÕÔÝÐ×ÝÐçÕÝÞ 
ÔÛï àÐÑÞâë á ÔÞÚãÜÕÝâÐÜØ, áÞåàÐÝÕÝÝëÜØ 
Ò Microsoft Word 97, 2000 Ø XP Ò äÞàÜÐâÕ «.doc», 
Ð âÐÚÖÕ á íÛÕÚâàÞÝÝëÜØ ÚÝØÓÐÜØ Palm Ò äÞàÜÐâÕ 
«.doc».

 ¿àØÜÕçÐÝØÕ. ¿ÞÔÔÕàÖØÒÐîâáï ÝÕ ÒáÕ ÒÕàáØØ 
Ø äãÝÚæØØ ãßÞÜïÝãâëå äÞàÜÐâÞÒ äÐÙÛÞÒ.

¾áÞÑÕÝÝÞáâØ ßàØÛÞÖÕÝØï Quickword:
• ÁÞÒÜÕáâØÜÞáâì á ÚÞÜßìîâÕàÐÜØ Ø ÔàãÓØÜØ 

ãáâàÞÙáâÒÐÜØ Palm.
• ÅàÐÝÕÝØÕ ÔÞÚãÜÕÝâÞÒ ÝÐ ÚÐàâÕ ßÐÜïâØ ÔÛï 

ÜÓÝÞÒÕÝÝÞÓÞ ÔÞáâãßÐ.

´Ûï ßÞØáÚÐ Ø ÞâÚàëâØï ÔÞÚãÜÕÝâÞÒ ßàÕÔãáÜÞâàÕÝë 
áÛÕÔãîéØÕ áßÞáÞÑë:
• ½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Quickword. 

²ëÑÕàØâÕ ÄãÝÚæØØ > ¾Ñ×Þà ÔÛï ßÞØáÚÐ Ø ÞâÚàëâØï 
ÔÞÚãÜÕÝâÞÒ, áÞåàÐÝÕÝÝëå Ò ßÐÜïâØ ãáâàÞÙáâÒÐ ØÛØ 
ÝÐ ÚÐàâÕ ßÐÜïâØ.

• ¾âÚàÞÙâÕ ÒÛÞÖÕÝØÕ Ò ßÞÛãçÕÝÝÞÕ áÞÞÑéÕÝØÕ 
íÛÕÚâàÞÝÝÞÙ ßÞçâë (ãáÛãÓÐ áÕâØ).

• ¿ÕàÕÔÐÙâÕ ÔÞÚãÜÕÝâ ßÞ ÚÐÝÐÛã áÒï×Ø Bluetooth 
Ò ßÐßÚã ²åÞÔïéØÕ ßàØÛÞÖÕÝØï ÁÞÞÑé..

• Á ßÞÜÞéìî ßàØÛÞÖÕÝØï ´áßç äÛÒ ÝÐÙÔØâÕ 
Ø ÞâÚàÞÙâÕ ÔÞÚãÜÕÝâë, áÞåàÐÝÕÝÝëÕ Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

• ¿àÞáÜÐâàØÒÐÙâÕ ÒÕÑ-áâàÐÝØæë. ¿ÕàÕÔ ßàÞáÜÞâàÞÜ 
ÒëßÞÛÝØâÕ Ò ãáâàÞÙáâÒÕ ÝÐáâàÞÙÚã âÞçÚØ ÔÞáâãßÐ 
Ò ¸ÝâÕàÝÕâ.
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ÀÐÑÞâÐ á äÐÙÛÐÜØ Word
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Quickword. ´Ûï âÞÓÞ, 
çâÞÑë ÞâÚàëâì äÐÙÛ ÔÞÚãÜÕÝâÐ, ÒëÔÕÛØâÕ ÕÓÞ 
Ø ÝÐÖÜØâÕ .

¼ÞÖÝÞ âÐÚÖÕ ÒëÑàÐâì ÄãÝÚæØØ; ÜÕÝî áÞÔÕàÖØâ 
áÛÕÔãîéØÕ äãÝÚæØØ:

ÄÐÙÛë > ÁÞàâØàÞÒÚÐ - áÞàâØàÞÒÚÐ ÞâÞÑàÐÖÐÕÜëå 
äÐÙÛÞÒ ßÞ ØÜÕÝØ, àÐ×ÜÕàã, ÔÐâÕ ØÛØ àÐáèØàÕÝØî 
äÐÙÛÐ.

ÄÐÙÛë > ¿ÞØáÚ – ßÞØáÚ äÐÙÛÞÒ âÞÛìÚÞ Ò ßÐßÚÕ 
¿ÞçâÞÒëÙ ïéØÚ ÛØÑÞ ÒÞ ÒáÕå ßÐßÚÐå Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

¸ÝäÞàÜÐæØï - ÞâÞÑàÐÖÕÝØÕ àÐ×ÜÕàÐ âÕÚãéÕÓÞ 
äÐÙÛÐ Ø ÒàÕÜï ÕÓÞ ßÞáÛÕÔÝÕÓÞ Ø×ÜÕÝÕÝØï.

¿àÞáÜÞâà ÔÞÚãÜÕÝâÞÒ Word
´Ûï ÞâÚàëâØï ÔÞÚãÜÕÝâÐ Word ÔÛï ßàÞáÜÞâàÐ ÝÐÖÜØâÕ 

 Ø ÒëÑÕàØâÕ ¾äØá > Quickword. ²ëÑÕàØâÕ ÔÞÚãÜÕÝâ 
Ø ÝÐÖÜØâÕ .

´Ûï ßÕàÕÜÕéÕÝØï Ò ÔÞÚãÜÕÝâÕ áÛãÖØâ ÚÛÐÒØèÐ 
ßàÞÚàãâÚØ.

´Ûï ßÞØáÚÐ âÕÚáâÐ ÔÞÚãÜÕÝâÐ ÒëÑÕàØâÕ ÄãÝÚæØØ > 
½ÐÙâØ > ÄãÝÚæØØ.

¼ÞÖÝÞ âÐÚÖÕ ÒëÑàÐâì ÄãÝÚæØØ; ÜÕÝî áÞÔÕàÖØâ 
áÛÕÔãîéØÕ äãÝÚæØØ:

¿ÕàÕÙâØ - ßÕàÕåÞÔ Ò ÝÐçÐÛÞ, Ò ÒëÑàÐÝÝãî ßÞ×ØæØî 
ÔÞÚãÜÕÝâÐ ØÛØ Ò ÕÓÞ ÚÞÝÕæ.

¼ÐáèâÐÑ - ãÒÕÛØçÕÝØÕ ØÛØ ãÜÕÝìèÕÝØÕ.

°ÒâÞßàÞÚàãâÚÐ - ×ÐßãáÚ ÐÒâÞÜÐâØçÕáÚÞÙ ßàÞÚàãâÚØ 
ÔÞÚãÜÕÝâÐ; ÔÛï ÞáâÐÝÞÒÚØ ßàÞÚàãâÚØ ÝÐÖÜØâÕ .

 ÁÞÒÕâ. ½ÐÖÜØâÕ  ÔÛï ×ÐÜÕÔÛÕÝØï ØÛØ  ÔÛï 
ãáÚÞàÕÝØï ÐÒâÞÜÐâØçÕáÚÞÙ ßàÞÚàãâÚØ.

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
¿àØ ÒÞ×ÝØÚÝÞÒÕÝØØ ßàÞÑÛÕÜ á ßàØÛÞÖÕÝØÕÜ 
Quickword ÔÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî 
áÜ. ÝÐ ÒÕÑ-áÐÙâÕ www.quickoffice.com.

¿ÞÔÔÕàÖÚã ÜÞÖÝÞ âÐÚÖÕ ßÞÛãçØâì, ÞâßàÐÒØÒ 
áÞÞÑéÕÝØÕ íÛÕÚâàÞÝÝÞÙ ßÞçâë ßÞ ÐÔàÕáã 
supportS60@quickoffice.com.

Quicksheet 

¿àØÛÞÖÕÝØÕ Quicksheet ÔÛï ãáâàÞÙáâÒÐ Nokia N72 
ßÞÔÔÕàÖØÒÐÕâ ÝÐØÑÞÛÕÕ çÐáâÞ ØáßÞÛì×ãÕÜëÕ äãÝÚæØØ 
Microsoft Excel 97, 2000, 2003 Ø XP. ² ßàØÛÞÖÕÝØØ 
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Quicksheet ÜÞÖÝÞ ßàØÝØÜÐâì äÐÙÛë Excel 
Ø ßàÞáÜÐâàØÒÐâì Øå ÝÐ ÔØáßÛÕÕ ãáâàÞÙáâÒÐ.

¿àØÛÞÖÕÝØÕ Quicksheet ßÞÔÔÕàÖØÒÐÕâ äÐÙÛë 
íÛÕÚâàÞÝÝëå âÐÑÛØæ, áÞåàÐÝÕÝÝëÕ Ò äÞàÜÐâÕ .xls 
Ò ßàØÛÞÖÕÝØïå Microsoft Excel 97, 2000, 2003 Ø XP.

 ¿àØÜÕçÐÝØÕ. ¿ÞÔÔÕàÖØÒÐîâáï ÝÕ ÒáÕ ÒÕàáØØ 
Ø äãÝÚæØØ ãßÞÜïÝãâëå äÞàÜÐâÞÒ äÐÙÛÞÒ.

¾áÞÑÕÝÝÞáâØ ßàØÛÞÖÕÝØï Quicksheet:
• ¿ÕàÕÚÛîçÕÝØÕ ÜÕÖÔã âÐÑÛØæÐÜØ ÔÒãÜï 

ÝÐÖÐâØïÜØ.
• ¿ÞØáÚ âÕÚáâÐ, ×ÐßØáÐÝÝÞÓÞ Ò ×ÝÐçÕÝØØ ØÛØ 

äÞàÜãÛÕ, ßÞ ÒáÕÙ âÐÑÛØæÕ.
• ¸×ÜÕÝÕÝØÕ àÐ×ÜÕàÞÒ áâÞÛÑæÞÒ, ×ÐÚàÕßÛÕÝØÕ 

áâàÞÚ Ø áâÞÛÑæÞÒ.
• ÁÞåàÐÝÕÝØÕ âÐÑÛØæ ÝÐ ÚÐàâã ßÐÜïâØ ÔÛï 

ÜÓÝÞÒÕÝÝÞÓÞ ÔÞáâãßÐ.

½ÐåÞÔØâÕ Ø ÞâÚàëÒÐÙâÕ äÐÙÛë áÛÕÔãîéØÜØ 
áßÞáÞÑÐÜØ:
• ½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Quicksheet. 

²ëÑÕàØâÕ ÄãÝÚæØØ > ¾Ñ×Þà ÔÛï ßÞØáÚÐ 
Ø ÞâÚàëâØï ÔÞÚãÜÕÝâÞÒ, áÞåàÐÝÕÝÝëå Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

• ¾âÚàÞÙâÕ ÒÛÞÖÕÝØÕ Ò ßÞÛãçÕÝÝÞÕ áÞÞÑéÕÝØÕ 
íÛÕÚâàÞÝÝÞÙ ßÞçâë (ãáÛãÓÐ áÕâØ).

• ¿ÕàÕÔÐÙâÕ ÔÞÚãÜÕÝâ ßÞ ÚÐÝÐÛã áÒï×Ø Bluetooth 
Ò ßÐßÚã ²åÞÔïéØÕ ßàØÛÞÖÕÝØï ÁÞÞÑé..

• Á ßÞÜÞéìî ßàØÛÞÖÕÝØï ´áßç äÛÒ ÝÐÙÔØâÕ 
Ø ÞâÚàÞÙâÕ ÔÞÚãÜÕÝâë, áÞåàÐÝÕÝÝëÕ Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

• ¿àÞáÜÐâàØÒÐÙâÕ ÒÕÑ-áâàÐÝØæë. ¿ÕàÕÔ ßàÞáÜÞâàÞÜ 
ãáâÐÝÞÒØâÕ Ò ãáâàÞÙáâÒÕ âÞçÚã ÔÞáâãßÐ Ò ¸ÝâÕàÝÕâ.

ÀÐÑÞâÐ á âÐÑÛØæÐÜØ
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Quicksheet. ´Ûï âÞÓÞ, 
çâÞÑë ÞâÚàëâì äÐÙÛ íÛÕÚâàÞÝÝÞÙ âÐÑÛØæë, ÒëÔÕÛØâÕ 
ÕÓÞ Ø ÝÐÖÜØâÕ .

¼ÞÖÝÞ âÐÚÖÕ ÒëÑàÐâì ÄãÝÚæØØ; ÜÕÝî áÞÔÕàÖØâ 
áÛÕÔãîéØÕ äãÝÚæØØ:

ÄÐÙÛë > ÁÞàâØàÞÒÚÐ - áÞàâØàÞÒÚÐ ÞâÞÑàÐÖÐÕÜëå 
äÐÙÛÞÒ ßÞ ØÜÕÝØ, àÐ×ÜÕàã, ÔÐâÕ ØÛØ àÐáèØàÕÝØî 
äÐÙÛÐ.

ÄÐÙÛë > ¿ÞØáÚ - ßÞØáÚ äÐÙÛÞÒ âÞÛìÚÞ Ò ßÐßÚÕ 
¿ÞçâÞÒëÙ ïéØÚ ÛØÑÞ ÒÞ ÒáÕå ßÐßÚÐå Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

¸ÝäÞàÜÐæØï - ÞâÞÑàÐÖÕÝØÕ àÐ×ÜÕàÐ âÕÚãéÕÓÞ 
äÐÙÛÐ Ø ÒàÕÜï ÕÓÞ ßÞáÛÕÔÝÕÓÞ Ø×ÜÕÝÕÝØï.

¿àÞáÜÞâà âÐÑÛØæ
´Ûï ÞâÚàëâØï íÛÕÚâàÞÝÝÞÙ âÐÑÛØæë ÔÛï ßàÞáÜÞâàÐ 
ÝÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Quicksheet. ²ëÑÕàØâÕ 
äÐÙÛ íÛÕÚâàÞÝÝÞÙ âÐÑÛØæë Ø ÝÐÖÜØâÕ .
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´Ûï ßÕàÕÜÕéÕÝØï Ò âÐÑÛØæÕ áÛãÖØâ ÚÛÐÒØèÐ 
ßàÞÚàãâÚØ.

´Ûï ßÕàÕåÞÔÐ ÜÕÖÔã âÐÑÛØæÐÜØ ÒëÑÕàØâÕ ÄãÝÚæØØ > 
¿ÕàÕÙâØ, ÒëÔÕÛØâÕ âÐÑÛØæã Ø ÒëÑÕàØâÕ OK.

´Ûï ßÞØáÚÐ âÕÚáâÐ Ò ×ÝÐçÕÝØïå Ø äÞàÜãÛÐå 
íÛÕÚâàÞÝÝÞÙ âÐÑÛØæë ÒëÑÕàØâÕ ÄãÝÚæØØ > ½ÐÙâØ > 
ÄãÝÚæØØ.

´Ûï Ø×ÜÕÝÕÝØï áßÞáÞÑÐ ÞâÞÑàÐÖÕÝØï íÛÕÚâàÞÝÝÞÙ 
âÐÑÛØæë ÒëÑÕàØâÕ ÄãÝÚæØØ Ø ÞÔØÝ Ø× áÛÕÔãîéØå 
áßÞáÞÑÞÒ:

¸×Ü. àÐ×ÜÕà íÚàÐÝÐ - ßÕàÕÚÛîçÕÝØÕ ÜÕÖÔã àÕÖØÜÞÜ 
ÞâÞÑàÐÖÕÝØï ÝÐ ÒÕáì íÚàÐÝ ØÛØ ÝÐ çÐáâì íÚàÐÝÐ.

¼ÐáèâÐÑ - ãÒÕÛØçÕÝØÕ ØÛØ ãÜÕÝìèÕÝØÕ.

·ÐÚàÕßØâì - ×ÐÚàÕßÛÕÝØÕ ÒëÔÕÛÕÝÝÞÙ áâàÞÚØ, áâÞÛÑæÐ 
ØÛØ áâàÞÚØ Ø áâÞÛÑæÐ ßàØ ßàÞÚàãâÚÕ ÞáâÐÛìÝÞÙ çÐáâØ 
âÐÑÛØæë.

ÈØàØÝÐ áâÞÛÑæÐ - ÝÐÖÜØâÕ  ØÛØ  - ãÜÕÝìèÕÝØÕ 
ØÛØ ãÒÕÛØçÕÝØÕ èØàØÝë áâÞÛÑæÐ. ¿àØ ÔÞáâØÖÕÝØØ 
âàÕÑãÕÜÞÙ èØàØÝë ÝÐÖÜØâÕ .

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
¿àØ ÒÞ×ÝØÚÝÞÒÕÝØØ ßàÞÑÛÕÜ á ßàØÛÞÖÕÝØÕÜ 
Quicksheet áÜ. ÔÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî 
ÝÐ ÒÕÑ-áÐÙâÕ www.quickoffice.com.

¿ÞÔÔÕàÖÚã ÜÞÖÝÞ âÐÚÖÕ ßÞÛãçØâì, ÞâßàÐÒØÒ 
áÞÞÑéÕÝØÕ íÛÕÚâàÞÝÝÞÙ ßÞçâë ßÞ ÐÔàÕáã 
supportS60@quickoffice.com.

Quickpoint 

¿àØÛÞÖÕÝØÕ Quickpoint ÔÛï ãáâàÞÙáâÒÐ Nokia N72 
ßÞÔÔÕàÖØÒÐÕâ ÝÐØÑÞÛÕÕ çÐáâÞ ØáßÞÛì×ãÕÜëÕ äãÝÚæØØ 
Microsoft PowerPoint 97, 2000 Ø XP. ² ßàØÛÞÖÕÝØØ 
Quickpoint ÜÞÖÝÞ ßàØÝØÜÐâì ßàÕ×ÕÝâÐæØØ PowerPoint 
Ø ßàÞáÜÐâàØÒÐâì Øå ÝÐ ÔØáßÛÕÕ ãáâàÞÙáâÒÐ.

 ÁÞÒÕâ. ¿àØÛÞÖÕÝØÕ Quickpoint ßàÕÔÝÐ×ÝÐçÕÝÞ 
ÔÛï àÐÑÞâë á ßàÕ×ÕÝâÐæØïÜØ, áÞ×ÔÐÝÝëÜØ 
Ò äÞàÜÐâÕ «.ppt» Ò ßàØÛÞÖÕÝØïå Microsoft 
PowerPoint 97, 2000 Ø XP.

 ¿àØÜÕçÐÝØÕ. ¿ÞÔÔÕàÖØÒÐîâáï ÝÕ ÒáÕ ÒÕàáØØ 
Ø äãÝÚæØØ ãßÞÜïÝãâëå äÞàÜÐâÞÒ äÐÙÛÞÒ.

¾áÞÑÕÝÝÞáâØ ßàØÛÞÖÕÝØï Quickpoint:
• ÇÕâëàÕ àÕÖØÜÐ ßàÞáÜÞâàÐ: áâàãÚâãàÐ, ßàØÜÕçÐÝØï, 

áÛÐÙÔë Ø ÜØÝØ-ÚÐàâØÝÚØ (ßÞ çÕâëàÕ).
• ÅàÐÝÕÝØÕ ßàÕ×ÕÝâÐæØÙ ÝÐ ÚÐàâÕ ßÐÜïâØ ÔÛï 

ÜÓÝÞÒÕÝÝÞÓÞ ÔÞáâãßÐ.
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½ÐåÞÔØâÕ Ø ÞâÚàëÒÐÙâÕ äÐÙÛë áÛÕÔãîéØÜØ 
áßÞáÞÑÐÜØ:
• ½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Quickpoint. 

²ëÑÕàØâÕ ÄãÝÚæØØ > ¾Ñ×Þà ÔÛï ßÞØáÚÐ Ø 
ÞâÚàëâØï ÔÞÚãÜÕÝâÞÒ, áÞåàÐÝÕÝÝëå Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

• ¾âÚàÞÙâÕ ÒÛÞÖÕÝØÕ Ò ßÞÛãçÕÝÝÞÕ áÞÞÑéÕÝØÕ 
íÛÕÚâàÞÝÝÞÙ ßÞçâë (ãáÛãÓÐ áÕâØ).

• ¿ÕàÕÔÐÙâÕ ÔÞÚãÜÕÝâ ßÞ ÚÐÝÐÛã áÒï×Ø Bluetooth 
Ò ßÐßÚã ²åÞÔïéØÕ ßàØÛÞÖÕÝØï ÁÞÞÑé..

• Á ßÞÜÞéìî ßàØÛÞÖÕÝØï ´áßç äÛÒ ÝÐÙÔØâÕ 
Ø ÞâÚàÞÙâÕ ÔÞÚãÜÕÝâë, áÞåàÐÝÕÝÝëÕ Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

• ¿àÞáÜÐâàØÒÐÙâÕ ÒÕÑ-áâàÐÝØæë. ¿ÕàÕÔ ßàÞáÜÞâàÞÜ 
ãáâÐÝÞÒØâÕ Ò ãáâàÞÙáâÒÕ âÞçÚã ÔÞáâãßÐ Ò ¸ÝâÕàÝÕâ.

ÀÐÑÞâÐ á ßàÕ×ÕÝâÐæØïÜØ
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Quickpoint.

¼ÞÖÝÞ âÐÚÖÕ ÒëÑàÐâì ÄãÝÚæØØ; ÜÕÝî áÞÔÕàÖØâ 
áÛÕÔãîéØÕ äãÝÚæØØ:

ÄÐÙÛë > ÁÞàâØàÞÒÚÐ - áÞàâØàÞÒÚÐ ÞâÞÑàÐÖÐÕÜëå 
äÐÙÛÞÒ ßÞ ØÜÕÝØ, àÐ×ÜÕàã, ÔÐâÕ ØÛØ àÐáèØàÕÝØî 
äÐÙÛÐ.

ÄÐÙÛë > ¿ÞØáÚ - ßÞØáÚ äÐÙÛÞÒ âÞÛìÚÞ Ò ßÐßÚÕ 
¿ÞçâÞÒëÙ ïéØÚ ÛØÑÞ ÒÞ ÒáÕå ßÐßÚÐå Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

¸ÝäÞàÜÐæØï - ÞâÞÑàÐÖÕÝØÕ àÐ×ÜÕàÐ âÕÚãéÕÓÞ 
äÐÙÛÐ Ø ÒàÕÜï ÕÓÞ ßÞáÛÕÔÝÕÓÞ Ø×ÜÕÝÕÝØï.

¿àÞáÜÞâà ßàÕ×ÕÝâÐæØÙ
ÇâÞÑë ÞâÚàëâì ßàÕ×ÕÝâÐæØî ÔÛï ßàÞáÜÞâàÐ, 
ÝÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Quickpoint. 
²ëÔÕÛØâÕ ßàÕ×ÕÝâÐæØî Ø ÝÐÖÜØâÕ .

´Ûï ßÕàÕåÞÔÐ ÜÕÖÔã àÕÖØÜÐÜØ ÞâÞÑàÐÖÕÝØï 
ÀÐ×ÜÕâÚÐ, ·ÐÜÕâÚØ, ÁÛÐÙÔ Ø ÍáÚØ× ÝÐÖÜØâÕ  
ØÛØ .

½ÐÖÜØâÕ  ØÛØ  ÔÛï ßÕàÕåÞÔÐ Ú ßàÕÔëÔãéÕÜã 
ØÛØ áÛÕÔãîéÕÜã áÛÐÙÔã Ò ßàÕ×ÕÝâÐæØØ.

´Ûï ßÕàÕÚÛîçÕÝØï ÜÕÖÔã àÕÖØÜÞÜ ÞâÞÑàÐÖÕÝØï ÝÐ 
ÒÕáì íÚàÐÝ Ø ÝÐ çÐáâì íÚàÐÝÐ ÒëÑÕàØâÕ ÄãÝÚæØØ > 
¸×Ü. àÐ×ÜÕà íÚàÐÝÐ.

ÇâÞÑë àÐáÚàëâì ØÛØ áÚàëâì íÛÕÜÕÝâë áâàãÚâãàë 
ßàÕ×ÕÝâÐæØØ Ò àÕÖØÜÕ áâàãÚâãàë, ÒëÑÕàØâÕ 
ÄãÝÚæØØ > ÀÐ×ÜÕâÚÐ.

² àÕÖØÜÕ ßàÞáÜÞâàÐ áÛÐÙÔÞÒ ßàØ ÞâÞÑàÐÖÕÝØØ 
ÝÐ ÒÕáì íÚàÐÝ ÝÐÖÜØâÕ:
• 1 - ãÜÕÝìèÕÝØÕ ÜÐáèâÐÑÐ;
• 2 - ãÒÕÛØçÕÝØÕ ÜÐáèâÐÑÐ;
• 3 - àÐ×ÜÕéÕÝØÕ áÛÐÙÔÐ ÝÐ íÚàÐÝÕ.
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´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
¿àØ ÒÞ×ÝØÚÝÞÒÕÝØØ ßàÞÑÛÕÜ á ßàØÛÞÖÕÝØÕÜ 
Quickpoint ÔÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî 
áÜ. ÝÐ ÒÕÑ-áÐÙâÕ www.quickoffice.com.

¿ÞÔÔÕàÖÚã ÜÞÖÝÞ âÐÚÖÕ ßÞÛãçØâì, ÞâßàÐÒØÒ 
áÞÞÑéÕÝØÕ íÛÕÚâàÞÝÝÞÙ ßÞçâë ßÞ ÐÔàÕáã 
supportS60@quickoffice.com.

Adobe Reader 

¿àØÛÞÖÕÝØÕ Adobe Reader ÔÐÕâ ÒÞ×ÜÞÖÝÞáâì 
ßàÞáÜÐâàØÒÐâì ÔÞÚãÜÕÝâë Ò äÞàÜÐâÕ PDF ÝÐ 
ÔØáßÛÕÕ ãáâàÞÙáâÒÐ.

 ¿àØÜÕçÐÝØÕ. ÍâÞ ßàØÛÞÖÕÝØÕ ÞßâØÜØ×ØàÞÒÐÝÞ 
ÔÛï ßàÞáÜÞâàÐ áÞÔÕàÖØÜÞÓÞ ÔÞÚãÜÕÝâÞÒ Ò äÞàÜÐâÕ 
PDF ÝÐ íÚàÐÝÕ âÕÛÕäÞÝÞÒ Ø ÔàãÓØå ÜÞÑØÛìÝëå 
ãáâàÞÙáâÒ Ø ÒëßÞÛÝïÕâ ÞÓàÐÝØçÕÝÝëÙ ÝÐÑÞà 
äãÝÚæØÙ ßÞ áàÐÒÝÕÝØî á ÒÕàáØïÜØ ÔÛï ÚÞÜßìîâÕàÐ.

 ¿àØÜÕçÐÝØÕ. ÍâÞ ßàØÛÞÖÕÝØÕ àÕÐÛØ×ÞÒÐÝÞ ÝÕ 
ÔÛï ÒáÕå ï×ëÚÞÒ.

´Ûï ßÞØáÚÐ Ø ÞâÚàëâØï ÔÞÚãÜÕÝâÞÒ ßàÕÔãáÜÞâàÕÝë 
áÛÕÔãîéØÕ áßÞáÞÑë:
• ½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Adobe PDF. 

²ëÑÕàØâÕ ÄãÝÚæØØ > ½ÐÙâØ äÐÙÛ, çâÞÑë ÝÐÙâØ 

Ø ÞâÚàëâì ÔÞÚãÜÕÝâë, áÞåàÐÝÕÝÝëÕ Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

• ¾âÚàÞÙâÕ ÒÛÞÖÕÝØÕ Ò ßÞÛãçÕÝÝÞÕ áÞÞÑéÕÝØÕ 
íÛÕÚâàÞÝÝÞÙ ßÞçâë (ãáÛãÓÐ áÕâØ).

• ¿ÕàÕÔÐÙâÕ ÔÞÚãÜÕÝâ ßÞ ÚÐÝÐÛã áÒï×Ø Bluetooth 
Ò ßÐßÚã ²åÞÔïéØÕ ßàØÛÞÖÕÝØï ÁÞÞÑé..

• Á ßÞÜÞéìî ßàØÛÞÖÕÝØï ´áßç äÛÒ ÝÐÙÔØâÕ 
Ø ÞâÚàÞÙâÕ ÔÞÚãÜÕÝâë, áÞåàÐÝÕÝÝëÕ Ò ßÐÜïâØ 
ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

• ¿àÞáÜÐâàØÒÐÙâÕ ÒÕÑ-áâàÐÝØæë. ¿ÕàÕÔ ßàÞáÜÞâàÞÜ 
ãáâÐÝÞÒØâÕ Ò ãáâàÞÙáâÒÕ âÞçÚã ÔÞáâãßÐ Ò ¸ÝâÕàÝÕâ.

ÀÐÑÞâÐ á äÐÙÛÐÜØ PDF
´Ûï ßàÞáÜÞâàÐ Ø àÐÑÞâë á äÐÙÛÐÜØ PDF ÝÐÖÜØâÕ  
Ø ÒëÑÕàØâÕ ¾äØá > Adobe PDF. ½Ð íÚàÐÝÕ áßØáÚÐ 
äÐÙÛÞÒ ßÕàÕçØáÛÕÝë ßÞáÛÕÔÝØÕ ßàÞáÜÞâàÕÝÝëÕ 
äÐÙÛë. ´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì ÔÞÚãÜÕÝâ, ÒëÔÕÛØâÕ 
ÕÓÞ Ø ÝÐÖÜØâÕ .

ºàÞÜÕ âÞÓÞ, ÜÞÖÝÞ ÒëÑàÐâì ÄãÝÚæØØ Ø ÞÔØÝ Ø× 
íÛÕÜÕÝâÞÒ ÜÕÝî:

½ÐÙâØ äÐÙÛ – ßàÞáÜÞâà äÐÙÛÞÒ Ò äÞàÜÐâÕ PDF, 
áÞåàÐÝÕÝÝëå Ò ßÐÜïâØ ãáâàÞÙáâÒÐ ØÛØ ÝÐ ÚÐàâÕ 
ßÐÜïâØ.

½ÐáâàÞÙÚØ - Ø×ÜÕÝÕÝØÕ ÜÐáèâÐÑÐ ßÞ ãÜÞÛçÐÝØî 
Ø àÕÖØÜÐ ÞâÞÑàÐÖÕÝØï ÔÞÚãÜÕÝâÞÒ PDF.
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¿àÞáÜÞâà äÐÙÛÞÒ PDF
¿àØ ÞâÚàëâÞÜ äÐÙÛÕ PDF ÒëÑÕàØâÕ ÄãÝÚæØØ; 
ÜÕÝî áÞÔÕàÖØâ áÛÕÔãîéØÕ äãÝÚæØØ:

¼ÐáèâÐÑ - ãÒÕÛØçÕÝØÕ, ãÜÕÝìèÕÝØÕ ØÛØ ÒëÑÞà 
ÞßàÕÔÕÛÕÝÝÞÓÞ ÚÞíääØæØÕÝâÐ ÜÐáèâÐÑØàÞÒÐÝØï. 
¼ÞÖÝÞ âÐÚÖÕ ãáâÐÝÞÒØâì àÐ×ÜÕà ÔÞÚãÜÕÝâÐ ßÞ 
èØàØÝÕ íÚàÐÝÐ ØÛØ àÐ×ÜÕáâØâì ÝÐ íÚàÐÝÕ 
áâàÐÝØæã PDF æÕÛØÚÞÜ.

½ÐÙâØ - ßÞØáÚ âÕÚáâÐ Ò ÔÞÚãÜÕÝâÕ.

¿ÞÚÐ×Ðâì - ßàÞáÜÞâà ÔÞÚãÜÕÝâÐ Ò àÕÖØÜÕ 
ÞâÞÑàÐÖÕÝØï ÝÐ ÒÕáì íÚàÐÝ. ¼ÞÖÝÞ âÐÚÖÕ ßÞÒÕàÝãâì 
ÔÞÚãÜÕÝâ PDF ÝÐ 90 ÓàÐÔãáÞÒ Ò ÛîÑÞÜ ÝÐßàÐÒÛÕÝØØ.

¿ÕàÕÙâØ - ßÕàÕåÞÔ Ú ÒëÑàÐÝÝÞÙ, áÛÕÔãîéÕÙ, 
ßàÕÔëÔãéÕÙ, ßÕàÒÞÙ ØÛØ ßÞáÛÕÔÝÕÙ áâàÐÝØæÕ. 

ÁÞåàÐÝØâì – áÞåàÐÝÕÝØÕ äÐÙÛÐ Ò ßÐÜïâØ ãáâàÞÙáâÒÐ 
ØÛØ ÝÐ ÚÐàâÕ ßÐÜïâØ.

½ÐáâàÞÙÚØ - Ø×ÜÕÝÕÝØÕ ÜÐáèâÐÑÐ ßÞ ãÜÞÛçÐÝØî 
Ø àÕÖØÜÐ ÞâÞÑàÐÖÕÝØï.

¸ÝäÞàÜÐæØï - ÞâÞÑàÐÖÕÝØÕ áÒÞÙáâÒ ÔÞÚãÜÕÝâÐ PDF.

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî ÜÞÖÝÞ ÝÐÙâØ ÝÐ 
ÒÕÑ-áÐÙâÕ www.adobe.com.

¾âÒÕâë ÝÐ ÒÞßàÞáë, àÕÚÞÜÕÝÔÐæØØ Ø ÔàãÓØÕ áÒÕÔÕÝØï 
Þ ßàØÛÞÖÕÝØØ áÜ. ÝÐ äÞàãÜÕ ßÞÛì×ÞÒÐâÕÛÕÙ 
Adobe Reader ÔÛï ¾Á Symbian ßÞ ÐÔàÕáã 
http://adobe.com/support/forums/main.html.

¿àØÛÞÖÕÝØÕ Info Print

 ¿àØÜÕçÐÝØÕ. ÍâÞ ßàØÛÞÖÕÝØÕ àÕÐÛØ×ÞÒÐÝÞ 
ÝÕ ÔÛï ÒáÕå ï×ëÚÞÒ.

½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¾äØá > Info print. ¿àØÛÞÖÕÝØÕ 
Info print ßÞ×ÒÞÛïÕâ ÞáãéÕáâÒÛïâì ÝÕßÞáàÕÔáâÒÕÝÝëÙ 
ÑÕáßàÞÒÞÔÝÞÙ ÒëÒÞÔ ÝÐ ßÕçÐâì á ãáâàÞÙáâÒÐ. 
¼ÞÖÝÞ ßÕçÐâÐâì àÐ×ÛØçÝÞÕ áÞÔÕàÖØÜÞÕ ãáâàÞÙáâÒÐ 
ÝÐ ßàØÝâÕàÐå, ÞáÝÐéÕÝÝëå áÒï×ìî Bluetooth 
Ø ÞáÝÞÒÝëÜ ßàÞäØÛÕÜ ßÕçÐâØ (Basic Print Profile – BPP) 
(ÝÐßàØÜÕà ÝÐ ßàØÝâÕàÕ HP Deskjet 450 Mobile Printer 
Ø HP Photosmart 8150). ¿àØÛÞÖÕÝØÕ ßÞ×ÒÞÛïÕâ 
ßÕçÐâÐâì ÜãÛìâØÜÕÔØÙÝëÕ Ø âÕÚáâÞÒëÕ áÞÞÑéÕÝØï, 
âÕÚáâ áÞÞÑéÕÝØÙ íÛÕÚâàÞÝÝÞÙ ßÞçâë, áÞÔÕàÖØÜÞÕ 
áßØáÚÐ ÚÞÝâÐÚâÞÒ Ø ÚÐÛÕÝÔÐàï, Ð âÐÚÖÕ ×ÐÜÕâÚØ.
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¿àØ ßÕçÐâØ ÚÞÝâÐÚâÞÒ ßàØÛÞÖÕÝØÕ ßÞÔÔÕàÖØÒÐÕâ 
ßÕçÐâì áÛÕÔãîéØå ßÞÛÕÙ ÚÞÝâÐÚâÐ: âÕÛÕäÞÝ, äÐÚá, 
ÜÞÑØÛìÝëÙ âÕÛÕäÞÝ, ÐÔàÕá íÛÕÚâàÞÝÝÞÙ ßÞçâë, 
URL-ÐÔàÕá Ø ßÞçâÞÒëÙ ÐÔàÕá.

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî áÜ. ßÞ ÐÔàÕáã 
www.hp.com/eur/phoneprinting.
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ÁÒï×ì
±ÕáßàÞÒÞÔÝÐï 
ÚÛÐÒØÐâãàÐ

´Ûï ÝÐáâàÞÙÚØ ÑÕáßàÞÒÞÔÝÞÙ ÚÛÐÒØÐâãàë Nokia 
ØÛØ ÔàãÓÞÙ áÞÒÜÕáâØÜÞÙ ÑÕáßàÞÒÞÔÝÞÙ ÚÛÐÒØÐâãàë, 
ßÞÔÔÕàÖØÒÐîéÕÙ àÕÖØÜ ßÞÛì×ÞÒÐâÕÛìáÚÞÓÞ 
ØÝâÕàäÕÙáÐ Bluetooth (Human Interface Devices – HID), 
ØáßÞÛì×ãÙâÕ ßàØÛÞÖÕÝØÕ Wireless Keyboard. 
ºÛÐÒØÐâãàÐ áÛãÖØâ ÔÛï ãÔÞÑÝÞÓÞ ÒÒÞÔÐ âÕÚáâÐ 
á ØáßÞÛì×ÞÒÐÝØÕÜ ßÞÛÝÞÙ àÐáÚÛÐÔÚØ QWERTY ÔÛï 
âÕÚáâÞÒëå áÞÞÑéÕÝØÙ, áÞÞÑéÕÝØÙ íÛÕÚâàÞÝÝÞÙ 
ßÞçâë Ø ×ÐßØáÕÙ ÚÐÛÕÝÔÐàï.

 ¿àØÜÕçÐÝØÕ. ÍâÞ ßàØÛÞÖÕÝØÕ àÕÐÛØ×ÞÒÐÝÞ ÝÕ 
ÔÛï ÒáÕå ï×ëÚÞÒ.

1 ²ÚÛîçØâÕ áÒï×ì Bluetooth Ò ãáâàÞÙáâÒÕ.
2 ²ÚÛîçØâÕ ÚÛÐÒØÐâãàã.
3 ½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ÁÒï×ì > Wireless Keyboard.
4 ²ëÑÕàØâÕ ÄãÝÚæØØ > Find keyboards - ßÞØáÚ 

ãáâàÞÙáâÒ á äãÝÚæØÕÙ Bluetooth.
5 ²ëÑÕàØâÕ ÚÛÐÒØÐâãàã Ò áßØáÚÕ.
6 ´Ûï áÞßàïÖÕÝØï ÚÛÐÒØÐâãàë á ãáâàÞÙáâÒÞÜ 

ÒÒÕÔØâÕ ÚÞÔ ÔÞáâãßÐ (Þâ 1 ÔÞ 9 æØäà) Ò ãáâàÞÙáâÒÕ, 
ÒÒÕÔØâÕ âÞâ ÖÕ ÚÞÔ ÔÞáâãßÐ ÝÐ ÚÛÐÒØÐâãàÕ 

Ò âÕçÕÝØÕ 30 áÕÚãÝÔ Ø ÝÐÖÜØâÕ ÚÛÐÒØèã Enter ÝÐ 
ÚÛÐÒØÐâãàÕ. ·ÐßÞÜØÝÐâì ÚÞÔ ÔÞáâãßÐ ÝÕ âàÕÑãÕâáï, 
âÐÚ ÚÐÚ ßàØ ÝÕÞÑåÞÔØÜÞáâØ ßÞÒâÞàÝÞÓÞ áÞßàïÖÕÝØï 
ÚÛÐÒØÐâãàë á ãáâàÞÙáâÒÞÜ ÜÞÖÝÞ ØáßÞÛì×ÞÒÐâì 
ÔàãÓÞÙ ÚÞÔ ÔÞáâãßÐ.
´Ûï ÒÒÞÔÐ æØäà ÚÞÔÐ ÔÞáâãßÐ, ÒÞ×ÜÞÖÝÞ, áÝÐçÐÛÐ 
ßÞâàÕÑãÕâáï ÝÐÖÐâì äãÝÚæØÞÝÐÛìÝãî ÚÛÐÒØèã Fn.

7 µáÛØ Ò ãáâàÞÙáâÒÕ ÞâÞÑàÐÖÐÕâáï ×ÐßàÞá Þ àÐáÚÛÐÔÚÕ 
ÚÛÐÒØÐâãàë, ÒëÑÕàØâÕ àÐáÚÛÐÔÚã Ò áßØáÚÕ.

8 ºÛÐÒØÐâãàÐ ÓÞâÞÒÐ Ú àÐÑÞâÕ, ÕáÛØ ÞâÞÑàÐÖÐÕâáï ØÜï 
ÚÛÐÒØÐâãàë, ÕÕ áÞáâÞïÝØÕ Ø×ÜÕÝïÕâáï ÝÐ Connected 
Ø ÝÐ ÚÛÐÒØÐâãàÕ ÝÐçØÝÐÕâ ÜÕÔÛÕÝÝÞ ÜØÓÐâì ×ÕÛÕÝëÙ 
ØÝÔØÚÐâÞà.

´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî ÞÑ íÚáßÛãÐâÐæØØ 
Ø ÞÑáÛãÖØÒÐÝØØ ÚÛÐÒØÐâãàë áÜ. Ò àãÚÞÒÞÔáâÒÕ ßÞ 
íÚáßÛãÐâÐæØØ.

ÃáÛãÓÐ PTT 

ÃáÛãÓÐ PTT (ãáÛãÓÐ áÕâØ) ßÞ×ÒÞÛïÕâ ÞâßàÐÒÛïâì 
ÓÞÛÞáÞÒëÕ áÞÞÑéÕÝØï Ò àÕÐÛìÝÞÜ ÒàÕÜÕÝØ 
á ØáßÞÛì×ÞÒÐÝØÕÜ IP-áÛãÖÑë ÝÐ ÑÐ×Õ áÕâØ ßÐÚÕâÝÞÙ 
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ßÕàÕÔÐçØ ÔÐÝÝëå. ÃáÛãÓÐ PTT ÞÑÕáßÕçØÒÐÕâ 
ÝÕßÞáàÕÔáâÒÕÝÝãî ÓÞÛÞáÞÒãî áÒï×ì ÞÔÝØÜ ÝÐÖÐâØÕÜ 
ÚÛÐÒØèØ. ¸áßÞÛì×ãÙâÕ ãáÛãÓã PTT ÔÛï ÞâßàÐÒÚØ 
áÞÞÑéÕÝØï ÐÑÞÝÕÝâã ØÛØ ÓàãßßÕ ÛØæ. 

ÇâÞÑë ØáßÞÛì×ÞÒÐâì ãáÛãÓã ÀÂÂ, ÝÕÞÑåÞÔØÜÞ 
ÞßàÕÔÕÛØâì áÞÞâÒÕâáâÒãîéãî âÞçÚã ÔÞáâãßÐ 
Ø ÝÐáâàÞÙÚØ ÀÂÂ. ½ÐáâàÞÙÚØ ÜÞÖÝÞ ßÞÛãçØâì 
Ò áßÕæØÐÛìÝÞÜ âÕÚáâÞÒÞÜ áÞÞÑéÕÝØØ Þâ ßÞáâÐÒéØÚÐ 
ãáÛãÓØ ÀÂÂ. ´Ûï ÚÞÝäØÓãàØàÞÒÐÝØï ÜÞÖÝÞ âÐÚÖÕ 
ØáßÞÛì×ÞÒÐâì SettingWizard, ÕáÛØ âÐÚÞÕ ßàØÛÞÖÕÝØÕ 
ßÞÔÔÕàÖØÒÐÕâáï ÞßÕàÐâÞàÞÜ áÞâÞÒÞÙ áÕâØ. ÁÜ. àÐ×ÔÕÛ 
«SettingWizard» ÝÐ áâà. 27.

½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ Connect. > Push to talk.

²Þ ÒàÕÜï áÕÐÝáÐ áÒï×Ø PTT ÞÔØÝ ÐÑÞÝÕÝâ ÓÞÒÞàØâ çÕàÕ× 
ÒáâàÞÕÝÝëÙ ÓàÞÜÚÞÓÞÒÞàØâÕÛì, Ò âÞ ÒàÕÜï ÚÐÚ 
ÞáâÐÛìÝëÕ áÛãèÐîâ. ÃçÐáâÝØÚØ ÓÞÒÞàïâ Ø ÞâÒÕçÐîâ ÝÐ 
áÞÞÑéÕÝØï ßÞ ÞçÕàÕÔØ. ÂÐÚ ÚÐÚ ÞÔÝÞÒàÕÜÕÝÝÞ ÜÞÖÕâ 
ÓÞÒÞàØâì âÞÛìÚÞ ÞÔØÝ ãçÐáâÝØÚ, ÜÐÚáØÜÐÛìÝÐï 
ßàÞÔÞÛÖØâÕÛìÝÞáâì àÕçØ ÞÓàÐÝØçÕÝÐ. ¼ÐÚáØÜÐÛìÝÐï 
ßàÞÔÞÛÖØâÕÛìÝÞáâì ÞÑëçÝÞ àÐÒÝÐ 30 áÕÚãÝÔÐÜ. ´Ûï 
ßÞÛãçÕÝØï ØÝäÞàÜÐæØØ Þ ßàÞÔÞÛÖØâÕÛìÝÞáâØ àÕçØ 
ÞÑàÐâØâÕáì Ú ÞßÕàÐâÞàã áÞâÞÒÞÙ áÕâØ ØÛØ Ú 
ßÞáâÐÒéØÚã ãáÛãÓ.

 ²ÝØÜÐÝØÕ! ½Õ ßÞÔÝÞáØâÕ Ø×ÔÕÛØÕ Ú ãåã ßàØ 
ÒÚÛîçÕÝÝÞÜ ÓàÞÜÚÞÓÞÒÞàØâÕÛÕ, âÐÚ ÚÐÚ ÓàÞÜÚÞáâì 
Ò íâÞÜ àÕÖØÜÕ ÜÞÖÕâ Ñëâì áÛØèÚÞÜ ÒÕÛØÚÐ.

ÂÕÛÕäÞÝÝëÕ Òë×ÞÒë ïÒÛïîâáï ÑÞÛÕÕ 
ßàØÞàØâÕâÝëÜØ, çÕÜ Òë×ÞÒë ÀÂÂ.

¾ßàÕÔÕÛÕÝØÕ âÞçÚØ ÔÞáâãßÐ ÀÂÂ
½ÕÚÞâÞàëÕ ßÞáâÐÒéØÚØ ãáÛãÓ âàÕÑãîâ ØáßÞÛì×ÞÒÐâì 
âÞçÚã ÔÞáâãßÐ Ò ¸ÝâÕàÝÕâ (IAP) Ò ÚÐçÕáâÒÕ 
áâÐÝÔÐàâÝÞÙ âÞçÚØ ÔÞáâãßÐ. ´àãÓØÕ ßÞáâÐÒéØÚØ 
ÔÞßãáÚÐîâ ØáßÞÛì×ÞÒÐÝØÕ âÞçÚØ ÔÞáâãßÐ WAP. 
´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî ÜÞÖÝÞ ßÞÛãçØâì 
ã ßÞáâÐÒéØÚÐ ãáÛãÓ.

¿àØ ÞâáãâáâÒØØ áÞÕÔØÝÕÝØï á áÕàÒÕàÞÜ WAP 
ÜÞÖÝÞ ßÞÛãçØâì ÝÕÞÑåÞÔØÜãî ØÝäÞàÜÐæØî ÞÑ 
ãáâÐÝÞÒÛÕÝØØ ßÕàÒÞÓÞ áÞÕÔØÝÕÝØï ã ßÞáâÐÒéØÚÐ 
ãáÛãÓ ØÛØ ÝÐ ÒÕÑ-áÐÙâÕ www.nokia.com/phonesettings.

½ÐáâàÞÙÚØ PTT
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ Connect. > Push to talk > 
Options > PTT settings.

²ëÑÕàØâÕ User settings Ø ãÚÐÖØâÕ áÛÕÔãîéãî 
ØÝäÞàÜÐæØî:

Incoming PTT calls – ÒëÑÕàØâÕ Notify ÔÛï 
ÞâÞÑàÐÖÕÝØï ãÒÕÔÞÜÛÕÝØï Þ ÒåÞÔïéØå Òë×ÞÒÐå. 
²ëÑÕàØâÕ Auto-accept, çâÞÑë ÐÒâÞÜÐâØçÕáÚØ 
ÞâÒÕçÐâì ÝÐ Òë×ÞÒë PTT. ²ëÑÕàØâÕ Not allowed, 
çâÞÑë ÐÒâÞÜÐâØçÕáÚØ ÞâÚÛÞÝïâì Òë×ÞÒë PTT.
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PTT call alert tone – ÒëÑÕàØâÕ Set by profile, 
çâÞÑë ÝÐáâàÞÙÚÐ áØÓÝÐÛÐ ÒåÞÔïéÕÓÞ Òë×ÞÒÐ PTT 
áÞÞâÒÕâáâÒÞÒÐÛÐ áØÓÝÐÛã ÒåÞÔïéÕÓÞ Òë×ÞÒÐ ÔÛï 
ÐÚâØÒÝÞÓÞ àÕÖØÜÐ.

Callback request tone – ÒëÑÞà ÜÕÛÞÔØØ ÔÛï ×ÐßàÞáÞÒ 
ÞÑàÐâÝÞÓÞ Òë×ÞÒÐ.

Application start-up – ÒëÑÞà ßÐàÐÜÕâàÐ ÒåÞÔÐ 
Ò ãáÛãÓã PTT ßàØ ÒÚÛîçÕÝØØ ãáâàÞÙáâÒÐ.

Default nickname – ÒÒÞÔ áâÐÝÔÐàâÝÞÓÞ ßáÕÒÔÞÝØÜÐ, 
ÞâÞÑàÐÖÐÕÜÞÓÞ ÔÛï ÔàãÓØå ßÞÛì×ÞÒÐâÕÛÕÙ. ¿ÞáâÐÒéØÚ 
ãáÛãÓ ÜÞÖÕâ ×ÐßàÕâØâì Ø×ÜÕÝÕÝØÕ íâÞÙ äãÝÚæØØ 
Ò ãáâàÞÙáâÒÕ.

Show my PTT address – ÒëÑÕàØâÕ In 1 to 1 calls, 
In group calls, In all calls ØÛØ Never. ¿ÞáâÐÒéØÚ ãáÛãÓ 
ÜÞÖÕâ ×ÐßàÕâØâì ØáßÞÛì×ÞÒÐÝØÕ ÝÕÚÞâÞàëå Ø× íâØå 
äãÝÚæØÙ Ò ãáâàÞÙáâÒÕ.

Show my login status – ÒëÑÕàØâÕ Yes ÔÛï 
ÞâÞÑàÐÖÕÝØï ØÝäÞàÜÐæØØ Þ áÞáâÞïÝØØ ØÛØ No ÔÛï 
×ÐßàÕâÐ ÞâÞÑàÐÖÕÝØï íâØå áÒÕÔÕÝØÙ.

²ëÑÕàØâÕ Connection settings Ø ÒÒÕÔØâÕ áÛÕÔãîéãî 
ØÝäÞàÜÐæØî:

Domain – ÒÒÕÔØâÕ ÔÞÜÕÝÝÞÕ ØÜï, ßÞÛãçÕÝÝÞÕ Þâ 
ßÞáâÐÒéØÚÐ ãáÛãÓ.

Access point name – ÒÒÕÔØâÕ ØÜï âÞçÚØ ÔÞáâãßÐ PTT. 
¸Üï âÞçÚØ ÔÞáâãßÐ ÝÕÞÑåÞÔØÜÞ ÔÛï ãáâÐÝÞÒÛÕÝØï 
áÞÕÔØÝÕÝØï á áÕâìî GSM/GPRS. 

Server address – ÒÒÕÔØâÕ IP-ÐÔàÕá ØÛØ ÔÞÜÕÝÝÞÕ ØÜï 
áÕàÒÕàÐ PTT, ßÞÛãçÕÝÝÞÕ Þâ ßÞáâÐÒéØÚÐ ãáÛãÓ.

User name – ÒÒÕÔØâÕ ØÜï ßÞÛì×ÞÒÐâÕÛï, ßÞÛãçÕÝÝÞÕ Þâ 
ßÞáâÐÒéØÚÐ ãáÛãÓ.

PTT password – ßàØ ÝÕÞÑåÞÔØÜÞáâØ ÒÒÕÔØâÕ ßÐàÞÛì 
ÔÛï ßÞÔÚÛîçÕÝØï Ò àÕÖØÜÕ ßÕàÕÔÐçØ ÔÐÝÝëå. ¿ÐàÞÛì 
ÞÑëçÝÞ ßàÕÔÞáâÐÒÛïÕâáï ßÞáâÐÒéØÚÞÜ ãáÛãÓ Ø çÐáâÞ 
×ÐÒØáØâ Þâ àÕÓØáâàÐ.

²åÞÔ Ò ãáÛãÓã PTT
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ Connect. > Push to talk. 
¿àØ ×ÐßãáÚÕ ãáÛãÓØ ÀÂÂ ÐÒâÞÜÐâØçÕáÚØ ÒëßÞÛÝïÕâáï 
ÒåÞÔ Ò ãáÛãÓã.

¿àØ ãáßÕèÝÞÜ ÒåÞÔÕ Ò ãáÛãÓã ÀÀÂ ÒëßÞÛÝïÕâáï 
ÐÒâÞÜÐâØçÕáÚÞÕ ßÞÔÚÛîçÕÝØÕ Ú ÚÐÝÐÛÐÜ, ÚÞâÞàëÕ 
ÑëÛØ ÐÚâØÒÝë ÒÞ ÒàÕÜï ×ÐÒÕàèÕÝØï ßÞáÛÕÔÝÕÓÞ 
áÕÐÝáÐ. µáÛØ áÒï×ì ßàÕàëÒÐÕâáï, ãáâàÞÙáâÒÞ 
ÐÒâÞÜÐâØçÕáÚØ ßÞÒâÞàïÕâ ßÞßëâÚã ÒåÞÔÐ ÔÞ âÕå ßÞà, 
ßÞÚÐ ßÞÛì×ÞÒÐâÕÛì ÝÕ ÒëÑÕàÕâ ÒëåÞÔ Ø× ãáÛãÓØ PTT.
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²ëåÞÔ Ø× ãáÛãÓØ PTT
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ Connect. > Push to talk > 
Options > Exit. ¾âÞÑàÐÖÐÕâáï áÞÞÑéÕÝØÕ Switch Push 
to talk off after exiting application?. ²ëÑÕàØâÕ Yes ÔÛï 
ÒëåÞÔÐ Ø× ãáÛãÓØ Ø ÕÕ ×ÐÚàëâØï. ²ëÑÕàØâÕ No, çâÞÑë 
ßàØÛÞÖÕÝØÕ ßàÞÔÞÛÖÐÛÞ àÐÑÞâÐâì Ò äÞÝÞÒÞÜ àÕÖØÜÕ. 
µáÛØ ÞâÚàëâÞ ÝÕáÚÞÛìÚÞ ßàØÛÞÖÕÝØÙ, âÞ ÔÛï 
ßÕàÕÚÛîçÕÝØï ÜÕÖÔã ÝØÜØ ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ 
ÝÐÖÐâÞÙ ÚÛÐÒØèã .

²ëßÞÛÝÕÝØÕ ÔÒãáâÞàÞÝÝÕÓÞ Òë×ÞÒÐ
²ëÑÕàØâÕ Options > PTT contacts.

²ëÑÕàØâÕ Ø× áßØáÚÐ âàÕÑãÕÜëÙ ÚÞÝâÐÚâ Ø ÒëÑÕàØâÕ 
Options > Talk 1 to 1. 

½ÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã  ÒÞ 
ÒàÕÜï ßàÞØ×ÝÕáÕÝØï áÞÞÑéÕÝØï. ·ÐÚÞÝçØÒ ÓÞÒÞàØâì, 
ÞâßãáâØâÕ ÚÛÐÒØèã .

¼ÞÖÝÞ ÝÐçÐâì àÐ×ÓÞÒÞà á ÒëÑàÐÝÝëÜ ÚÞÝâÐÚâÞÜ, ÝÐÖÐÒ 
Ø ãÔÕàÖØÒÐï ÚÛÐÒØèã  Ø× ÔàãÓØå íÚàÐÝÞÒ 
ßàØÛÞÖÕÝØï Push to talk, ÝÐßàØÜÕà Ø× íÚàÐÝÐ 
ÚÞÝâÐÚâÞÒ. ´Ûï ÒëßÞÛÝÕÝØï ÝÞÒÞÓÞ âÕÛÕäÞÝÝÞÓÞ 
Òë×ÞÒÐ áÝÐçÐÛÐ ÝÕÞÑåÞÔØÜÞ ×ÐÒÕàèØâì ÔÒãáâÞàÞÝÝØÙ 
Òë×ÞÒ. ²ëÑÕàØâÕ Disconnect ØÛØ ÝÐÖÜØâÕ ÚÛÐÒØèã .

 ÁÞÒÕâ. ²Þ ÒàÕÜï Òë×ÞÒÐ PTT ÔÕàÖØâÕ ãáâàÞÙáâÒÞ 
ßÕàÕÔ áÞÑÞÙ âÐÚ, çâÞÑë ÒØÔÕâì ÔØáßÛÕÙ. ³ÞÒÞàØâÕ 

Ò ÜØÚàÞäÞÝ, áâÐàÐïáì ÝÕ ×ÐÚàëÒÐâì 
ÓàÞÜÚÞÓÞÒÞàØâÕÛì àãÚÐÜØ.

¾âÒÕâ ÝÐ ÔÒãáâÞàÞÝÝØÙ Òë×ÞÒ
½ÐÖÜØâÕ ÚÛÐÒØèã , çâÞÑë ÝÐçÐâì ÔÒãáâÞàÞÝÝØÙ 
Òë×ÞÒ, ØÛØ ÚÛÐÒØèã , çâÞÑë ÞâÚÛÞÝØâì Òë×ÞÒ.

 ÁÞÒÕâ. ¼ÞÖÝÞ ÒëßÞÛÝØâì ÔÒãáâÞàÞÝÝØÙ Òë×ÞÒ 
ØÛØ ÓàãßßÞÒÞÙ Òë×ÞÒ Ø× ÜÕÝî «ºÞÝâÐÚâë». 
²ëÑÕàØâÕ Options > PTT > Talk 1 to 1 ØÛØ 
Make PTT group call.

²ëßÞÛÝÕÝØÕ ÓàãßßÞÒÞÓÞ Òë×ÞÒÐ
´Ûï ÒëßÞÛÝÕÝØï ÓàãßßÞÒÞÓÞ Òë×ÞÒÐ ÒëÑÕàØâÕ 
Options > PTT contacts, ÞâÜÕâìâÕ ÝÕÞÑåÞÔØÜëÕ 
ÚÞÝâÐÚâë Ø ÒëÑÕàØâÕ Options > Make PTT group call.

¸ÝäÞàÜÐæØï Þ áÞáâÞïÝØØ ÒåÞÔÐ 
ÐÑÞÝÕÝâÞÒ
ÇâÞÑë ßÞÔßØáÐâìáï ØÛØ ÞâÜÕÝØâì ßÞÔßØáÚã ÝÐ 
ßÞÛãçÕÝØÕ ØÝäÞàÜÐæØØ Þ áÞáâÞïÝØØ ÒåÞÔÐ 
ÐÑÞÝÕÝâÞÒ ÒëÑÕàØâÕ Options > PTT contacts, ÚÞÝâÐÚâ 
Ø Options > Show login status ØÛØ Hide login status.
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¿ÕàÕÔÐçÐ ×ÐßàÞáÐ ÞÑàÐâÝÞÓÞ Òë×ÞÒÐ
² ÜÕÝî PTT contacts ÒëÔÕÛØâÕ ÝÕÞÑåÞÔØÜÞÕ ØÜï 
Ø ÒëÑÕàØâÕ Options > Send callback request.

¾âÒÕâ ÝÐ ×ÐßàÞá ÞÑàÐâÝÞÓÞ Òë×ÞÒÐ
µáÛØ ÚâÞ-ÛØÑÞ ßÕàÕÔÐÕâ ²ÐÜ ×ÐßàÞá ÞÑàÐâÝÞÓÞ Òë×ÞÒÐ, 
Ò àÕÖØÜÕ ÞÖØÔÐÝØï ÞâÞÑàÐÖÐÕâáï áÞÞÑéÕÝØÕ 1 new 
callback request. ²ëÑÕàØâÕ Show, çâÞÑë ÞâÚàëâì 
áßØáÞÚ Callback inbox. ²ëÑÕàØâÕ ÚÞÝâÐÚâ Ø Options > 
Talk 1 to 1, çâÞÑë ÒëßÞÛÝØâì ÔÒãáâÞàÞÝÝØÙ Òë×ÞÒ. 

ºÐÝÐÛë
¼ÞÖÝÞ ßàØáÞÕÔØÝØâìáï Ú ÞâÚàëâÞÜã ßàÕÔÒÐàØâÕÛìÝÞ 
áÚÞÝäØÓãàØàÞÒÐÝÝÞÜã ÚÐÝÐÛã. ¾âÚàëâëÕ ÚÐÝÐÛë 
ÔÞáâãßÝë ÔÛï ÒáÕå, ÚâÞ ×ÝÐÕâ URL-ÐÔàÕá ÚÐÝÐÛÐ. 

µáÛØ ²ë ßÞÔÚÛîçØÛØáì Ú ÚÐÝÐÛã Ø ãçÐáâÒãÕâÕ 
Ò àÐ×ÓÞÒÞàÕ, íâÞâ àÐ×ÓÞÒÞà áÛëèÐâ ÒáÕ ßÞÛì×ÞÒÐâÕÛØ, 
ßàØáÞÕÔØÝØÒèØÕáï Ú ÚÐÝÐÛã. ¾ÔÝÞÒàÕÜÕÝÝÞ ÜÞÓãâ 
Ñëâì ÐÚâØÒÝë ÔÞ ßïâØ ÚÐÝÐÛÞÒ. µáÛØ ÐÚâØÒÝÞ 
ÝÕáÚÞÛìÚÞ ÚÐÝÐÛÞÒ, ØáßÞÛì×ãÙâÕ äãÝÚæØî Swap ÔÛï 
ÒëÑÞàÐ ÝÕÞÑåÞÔØÜÞÓÞ ÚÐÝÐÛÐ. 

²ëÑÕàØâÕ Options > PTT channels.

´Ûï ßÕàÒÞÓÞ ßÞÔÚÛîçÕÝØï Ú ÞâÚàëâÞÜã 
ßàÕÔÒÐàØâÕÛìÝÞ áÚÞÝäØÓãàØàÞÒÐÝÝÞÜã ÚÐÝÐÛã 
ÒëÑÕàØâÕ Options > New channel > Add existing. 

¿àØ ßàØáÞÕÔØÝÕÝØØ Ú ßàÕÔÒÐàØâÕÛìÝÞ 
áÚÞÝäØÓãàØàÞÒÐÝÝÞÜã ÚÐÝÐÛã ÝÕÞÑåÞÔØÜÞ ãÚÐ×Ðâì 
URL-ÐÔàÕá ÔÛï íâÞÓÞ ÚÐÝÐÛÐ.

ÁÞ×ÔÐÝØÕ áÞÑáâÒÕÝÝëå ÚÐÝÐÛÞÒ
´Ûï áÞ×ÔÐÝØï ÝÞÒÞÓÞ ßàÕÔÒÐàØâÕÛìÝÞ 
áÚÞÝäØÓãàØàÞÒÐÝÝÞÓÞ ÚÐÝÐÛÐ ÒëÑÕàØâÕ Options > 
New channel > Create new. 

²ë ÜÞÖÕâÕ áÞ×ÔÐÒÐâì áÒÞØ áÞÑáâÒÕÝÝëÕ ÞâÚàëâëÕ 
ÚÐÝÐÛë, ÝÐ×ÝÐçÐâì ØÜ ØÜÕÝÐ Ø ßàØÓÛÐèÐâì ãçÐáâÝØÚÞÒ. 
ÍâØ ãçÐáâÝØÚØ ÜÞÓãâ ßàØÓÛÐèÐâì ÔàãÓØå ßÞÛì×ÞÒÐâÕÛÕÙ 
Ò ÚÐçÕáâÒÕ ãçÐáâÝØÚÞÒ ÞâÚàëâëå ÚÐÝÐÛÞÒ. 

¼ÞÖÝÞ âÐÚÖÕ ÝÐáâàÐØÒÐâì ×ÐÚàëâëÕ ÚÐÝÐÛë. 
¿àØáÞÕÔØÝØâìáï Ø ØáßÞÛì×ÞÒÐâì ×ÐÚàëâëÕ ÚÐÝÐÛë 
àÐ×àÕèÐÕâáï âÞÛìÚÞ âÕÜ ãçÐáâÝØÚÐÜ, ÚÞâÞàëå 
ßàØÓÛÐáØÛ ÒÛÐÔÕÛÕæ ÚÐÝÐÛÐ.

´Ûï ÚÐÖÔÞÓÞ ÚÐÝÐÛÐ ãÚÐÖØâÕ áÛÕÔãîéãî ØÝäÞàÜÐæØî: 
Channel name, Channel privacy, Nickname in channel 
Ø Channel thumbnail (ÝÕÞÑï×ÐâÕÛìÝÞ). 

¿ÞáÛÕ ãáßÕèÝÞÓÞ áÞ×ÔÐÝØï ÚÐÝÐÛÐ ²ÐÜ ÑãÔÕâ 
ßàÕÔÛÞÖÕÝÞ ÝÐßàÐÒØâì ßàØÓÛÐèÕÝØï ÔÛï ãçÐáâØï 
Ò ÚÐÝÐÛÕ. ¿àØÓÛÐèÕÝØï ÔÛï ãçÐáâØï Ò ÚÐÝÐÛÕ – íâÞ 
âÕÚáâÞÒëÕ áÞÞÑéÕÝØï.
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ÀÐ×ÓÞÒÞà ßÞ ÚÐÝÐÛã
´Ûï ÒëßÞÛÝÕÝØï àÐ×ÓÞÒÞàÐ ßÞ ÚÐÝÐÛã ßÞáÛÕ ÒåÞÔÐ 
Ò ãáÛãÓã PTT ÝÐÖÜØâÕ ÚÛÐÒØèã . ²ë ãáÛëèØâÕ 
áØÓÝÐÛ, áÒØÔÕâÕÛìáâÒãîéØÙ Þ âÞÜ, çâÞ ÔÞáâãß 
àÐ×àÕèÕÝ.

½ÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã  ÒÞ 
ÒàÕÜï ßàÞØ×ÝÕáÕÝØï áÞÞÑéÕÝØï. ·ÐÚÞÝçØÒ ÓÞÒÞàØâì, 
ÞâßãáâØâÕ ÚÛÐÒØèã . 

¿àØ ßÞßëâÚÕ ßàÞØ×ÝÕáâØ ÞâÒÕâ Ò ÚÐÝÐÛÕ ßãâÕÜ ÝÐÖÐâØï 
ÚÛÐÒØèØ  Ò âÞ ÒàÕÜï, ÚÞÓÔÐ ÓÞÒÞàØâ ÔàãÓÞÙ 
ãçÐáâÝØÚ, ÑãÔÕâ ÞâÞÑàÐÖÕÝÞ áÞÞÑéÕÝØÕ Wait. 
¾âßãáâØâÕ ÚÛÐÒØèã , ÔÞÖÔØâÕáì, ÚÞÓÔÐ ÔàãÓÞÙ 
ãçÐáâÝØÚ ×ÐÚÞÝçØâ ÓÞÒÞàØâì, Ø ÝÐÖÜØâÕ ÚÛÐÒØèã  
ÕéÕ àÐ×, ßÞÚÐ ÚÐÝÐÛ áÒÞÑÞÔÕÝ. ¼ÞÖÝÞ âÐÚÖÕ ÞáâÐÒØâì 
ÝÐÖÐâÞÙ ÚÛÐÒØèã  Ø ÔÞÖÔÐâìáï ÞâÞÑàÐÖÕÝØï 
áÞÞÑéÕÝØï Talk.

²Þ ÒàÕÜï ÑÕáÕÔë Ò ÚÐÝÐÛÕ áÛÕÔãîéØÜ ÓÞÒÞàØâ âÞâ, 
ÚâÞ ßÕàÒëÜ ÝÐÖÐÛ ÚÛÐÒØèã  ßÞáÛÕ ×ÐÒÕàèÕÝØï 
ßàÞØ×ÝÕáÕÝØï áÞÞÑéÕÝØï ÔàãÓØÜ ãçÐáâÝØÚÞÜ.

¿ÞáÛÕ ÞÚÞÝçÐÝØï Òë×ÞÒÐ PTT ÒëÑÕàØâÕ Disconnect ØÛØ 
ÝÐÖÜØâÕ ÚÛÐÒØèã . 

ÇâÞÑë ßàÞáÜÞâàÕâì âÕÚãéØå ÐÚâØÒÝëå ãçÐáâÝØÚÞÒ 
ÑÕáÕÔë Ò ÚÐÝÐÛÕ, ÒëÑÕàØâÕ Options > Active members.

ÇâÞÑë ßàØÓÛÐáØâì ÝÞÒëå ßÞÛì×ÞÒÐâÕÛÕÙ ÔÛï ãçÐáâØï 
Ò ÚÐÝÐÛÕ, Ú ÚÞâÞàÞÜã ²ë ßÞÔÚÛîçÕÝë, ÒëÑÕàØâÕ 

Options > Send invitation, ßÞáÛÕ çÕÓÞ ÞâÚàÞÕâáï 
íÚàÐÝ ßàØÓÛÐèÕÝØï. ¿àØÓÛÐèÐâì ÝÞÒëå ãçÐáâÝØÚÞÒ 
ÜÞÖÝÞ âÞÛìÚÞ Ò âÞÜ áÛãçÐÕ, ÕáÛØ íâÞ ÞâÚàëâëÙ 
ÚÐÝÐÛ, ØÛØ ÕáÛØ ²ë ïÒÛïÕâÕáì ÒÛÐÔÕÛìæÕÜ ×ÐÚàëâÞÓÞ 
ÚÐÝÐÛÐ. ¿àØÓÛÐèÕÝØï ÔÛï ãçÐáâØï Ò ÚÐÝÐÛÕ – íâÞ 
âÕÚáâÞÒëÕ áÞÞÑéÕÝØï.

¾âÒÕâ ÝÐ ßàØÓÛÐèÕÝØÕ ÝÐ ãçÐáâØÕ 
Ò ÚÐÝÐÛÕ
ÇâÞÑë áÞåàÐÝØâì ßÞÛãçÕÝÝÞÕ ßàØÓÛÐèÕÝØÕ ÝÐ 
ãçÐáâØÕ Ò ÚÐÝÐÛÕ, ÒëÑÕàØâÕ Options > Save PTT 
channel. ºÐÝÐÛ ÔÞÑÐÒÛïÕâáï Ò áßØáÞÚ ÚÐÝÐÛÞÒ ÔÛï 
ÚÞÝâÐÚâÞÒ PTT.

¿ÞáÛÕ áÞåàÐÝÕÝØï ßàØÓÛÐèÕÝØï ÑãÔÕâ ÒëÔÐÝ ×ÐßàÞá 
ÝÐ ßÞÔÚÛîçÕÝØÕ Ú ÚÐÝÐÛã. ²ëÑÕàØâÕ Yes ÔÛï 
ÞâÚàëâØï íÚàÐÝÐ áÕÐÝáÞÒ PTT. ÃáâàÞÙáâÒÞ ÒëßÞÛÝïÕâ 
ÒåÞÔ Ò ãáÛãÓã, ÕáÛØ ÞÝ ÕéÕ ÝÕ ÒëßÞÛÝÕÝ.

² áÛãçÐÕ ÞâÚÛÞÝÕÝØï ØÛØ ÞçØáâÚØ ßàØÓÛÐèÕÝØï ÞÝÞ 
áÞåàÐÝïÕâáï Ò ßÐßÚÕ ÒåÞÔïéØå áÞÞÑéÕÝØÙ. ÇâÞÑë 
ßàØáÞÕÔØÝØâìáï Ú ÚÐÝÐÛã ßÞ×ÔÝÕÕ, ÞâÚàÞÙâÕ 
áÞÞÑéÕÝØÕ á ßàØÓÛÐèÕÝØÕÜ Ø áÞåàÐÝØâÕ ÕÓÞ. 
² ÔØÐÛÞÓÞÒÞÜ ÞÚÝÕ ÒëÑÕàØâÕ Yes, çâÞÑë 
ßàØáÞÕÔØÝØâìáï Ú ÚÐÝÐÛã.
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¿àÞáÜÞâà ÖãàÝÐÛÐ PTT
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ Connect. > Push to talk > 
Options > PTT log. ¶ãàÝÐÛ áÞÔÕàÖØâ áÛÕÔãîéØÕ 
ßÐßÚØ: Missed calls, Received PTT calls Ø Created calls.

ÇâÞÑë ÝÐçÐâì ÔÒãáâÞàÞÝÝØÙ Òë×ÞÒ Ø× ÖãàÝÐÛÐ PTT log, 
ÝÐÖÜØâÕ ÚÛÐÒØèã .
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¼ÞØ ßàØÛÞÖÕÝØï
ºÐâÐÛÞÓØ 

Catalogs (ãáÛãÓÐ áÕâØ) – íâÞ ãáÛãÓÐ ßÞÚãßÚØ ÜÞÑØÛìÝÞÓÞ 
áÞÔÕàÖØÜÞÓÞ, ÚÞâÞàÞÙ ÜÞÖÝÞ ÒÞáßÞÛì×ÞÒÐâìáï á 
ãáâàÞÙáâÒÐ.

Á ßÞÜÞéìî ßàØÛÞÖÕÝØï Catalogs ÜÞÖÝÞ ÝÐÙâØ, 
ßàÞáÜÞâàÕâì, ßàØÞÑàÕáâØ, ×ÐÓàã×Øâì Ø ÞÑÝÞÒØâì 
áÞÔÕàÖØÜÞÕ, ãáÛãÓØ Ø ßàØÛÞÖÕÝØï, àÐÑÞâÐîéØÕ 
á ãáâàÞÙáâÒÞÜ Nokia N72. ¸Óàë, ÜÕÛÞÔØØ, äÞÝÞÒëÕ 
Ø×ÞÑàÐÖÕÝØï, ßàØÛÞÖÕÝØï Ø ÜÝÞÓÞÕ ÔàãÓÞÕ ÒáÕÓÔÐ ßÞÔ 
àãÚÞÙ. ´ÞáâãßÝÞÕ áÞÔÕàÖØÜÞÕ ×ÐÒØáØâ Þâ ßÞáâÐÒéØÚÐ 
ãáÛãÓ Ø ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ.

½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¼ÞØ ßàØÛ. > ºÐâÐÛÞÓØ. 
²ëÑÕàØâÕ OK, ÕáÛØ ²ë áÞÓÛÐáÝë á ãáÛÞÒØïÜØ 
ßÞÛÞÖÕÝØï ÞÑ ÞâÚÐ×Õ Þâ ÞÑï×ÐâÕÛìáâÒ.

¿àØÛÞÖÕÝØÕ Catalogs ØáßÞÛì×ãÕâ ãáÛãÓØ áÕâØ ÔÛï 
ÔÞáâãßÐ Ú ßÞáÛÕÔÝØÜ ÒÕàáØïÜ áÞÔÕàÖØÜÞÓÞ ÚÐâÐÛÞÓÞÒ. 
¸ÝäÞàÜÐæØî Þ ÔÞßÞÛÝØâÕÛìÝëå ÒÞ×ÜÞÖÝÞáâïå 
ßàØÛÞÖÕÝØï Catalogs ÜÞÖÝÞ ßÞÛãçØâì ã ßÞáâÐÒéØÚÐ 
ãáÛãÓ ØÛØ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ.

¿àØÛÞÖÕÝØÕ Catalogs ßÞÛãçÐÕâ ÔÕÙáâÒãîéØÕ 
ÞÑÝÞÒÛÕÝØï, ÚÞâÞàëÕ ÒÚÛîçÐîâ ÐÚâãÐÛìÝÞÕ 

áÞÔÕàÖØÜÞÕ, ßàÕÔÛÐÓÐÕÜÞÕ ÔÛï ãáâàÞÙáâÒÐ 
ÞßÕàÐâÞàÞÜ áÞâÞÒÞÙ áÕâØ ØÛØ ßÞáâÐÒéØÚÞÜ ãáÛãÓ. 
´Ûï ÞÑÝÞÒÛÕÝØï ÚÐâÐÛÞÓÞÒ ÒàãçÝãî ÒëÑÕàØâÕ 
Options > ¾ÑÝÞÒØâì áßØáÞÚ.

½ÐáâàÞÙÚØ ßàØÛÞÖÕÝØï Catalogs
¿àØÛÞÖÕÝØÕ ãáâÐÝÐÒÛØÒÐÕâ ÝÐ ãáâàÞÙáâÒÕ ÝÞÒëÕ 
ÒÕàáØØ ÚÐâÐÛÞÓÞÒ, ßàÕÔÞáâÐÒÛïÕÜëÕ ßÞáâÐÒéØÚÞÜ 
ãáÛãÓ, ÞßÕàÐâÞàÞÜ áÞâÞÒÞÙ áÒï×Ø ØÛØ ßÞ ÔàãÓØÜ 
ÔÞáâãßÝëÜ ÚÐÝÐÛÐÜ. ´Ûï Ø×ÜÕÝÕÝØï ÝÐáâàÞÕÚ 
ÒëÑÕàØâÕ ¿ÐàÐÜÕâàë > ½ÐáâàÞÙÚØ >

ÂÞçÚÐ ÔÞáâãßÐ – ÒëÑÞà âÞçÚØ ÔÞáâãßÐ ÔÛï 
ßÞÔÚÛîçÕÝØï Ú áÕàÒÕàã ßÞáâÐÒéØÚÐ ãáÛãÓ.

Automatic open – ÒëÑÕàØâÕ ´Ð ÔÛï ÐÒâÞÜÐâØçÕáÚÞÓÞ 
ÞâÚàëâØï áÞÔÕàÖØÜÞÓÞ ØÛØ ßàØÛÞÖÕÝØï ßÞáÛÕ 
×ÐÓàã×ÚØ:.

Preview confirmation – ÒëÑÕàØâÕ ½Õâ, ÕáÛØ 
ÝÕÞÑåÞÔØÜÞ ÐÒâÞÜÐâØçÕáÚØ ×ÐÓàãÖÐâì áÞÔÕàÖØÜÞÕ 
ØÛØ ßàØÛÞÖÕÝØÕ ÔÛï ßàÕÔÒÐàØâÕÛìÝÞÓÞ ßàÞáÜÞâàÐ. 
²ëÑÕàØâÕ ´Ð ÔÛï ÞâÞÑàÐÖÕÝØï ÞâÔÕÛìÝÞÓÞ ×ÐßàÞáÐ 
ßÕàÕÔ ÚÐÖÔÞÙ ×ÐÓàã×ÚÞÙ ÞÑêÕÚâÐ ÔÛï 
ßàÕÔÒÐàØâÕÛìÝÞÓÞ ßàÞáÜÞâàÐ.
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ÃÒÕÔÞÜÛ. Þ ßÞÚãßÚÕ – ÒëÑÕàØâÕ Yes ÔÛï ÞâÞÑàÐÖÕÝØÕ 
×ÐßàÞáÐ ÝÐ ßÞÔâÒÕàÖÔÕÝØÕ ßÕàÕÔ ßÞÚãßÚÞÙ 
áÞÔÕàÖØÜÞÓÞ ØÛØ ßàØÛÞÖÕÝØï. ¿àØ ÒëÑÞàÕ ½Õâ 
ßàÞæÕáá ßÞÚãßÚØ ÝÐçØÝÐÕâáï áàÐ×ã ßÞáÛÕ ÒëÑÞàÐ 
äãÝÚæØØ ºãßØâì.

¿Þ ×ÐÒÕàèÕÝØØ ÝÐáâàÞÙÚØ ÒëÑÕàØâÕ ½Ð×ÐÔ. 

±àÐã×Õà Opera 

´Ûï ÔÞáâãßÐ Ú ¸ÝâÕàÝÕâã ÝÐÖÜØâÕ  Ø ÒëÑÕàØâÕ 
¼ÞØ ßàØÛ. > www. Á ßÞÜÞéìî ÑàÐã×ÕàÐ Opera ÜÞÖÝÞ 
ßÞÛãçØâì ÔÞáâãß Ú áâàÐÝØæÐÜ, ÝÐ ÚÞâÞàëå 
ØáßÞÛì×ãÕâáï ÞâÚàëâëÙ ï×ëÚ àÐ×ÜÕâÚØ ÓØßÕàâÕÚáâÐ 
(XHTML), ï×ëÚ àÐ×ÜÕâÚØ ÓØßÕàâÕÚáâÐ (HTML), ÞâÚàëâëÙ 
ï×ëÚ àÐ×ÜÕâÚØ (XML) ØÛØ ï×ëÚ àÐ×ÜÕâÚØ áâàÐÝØæ ÔÛï 
ÑÕáßàÞÒÞÔÝëå ßàØÛÞÖÕÝØÙ (WML).

 ¿àØÜÕçÐÝØÕ. ÍâÞ ßàØÛÞÖÕÝØÕ àÕÐÛØ×ÞÒÐÝÞ 
ÝÕ ÔÛï ÒáÕå ï×ëÚÞÒ.

ÁÒÕÔÕÝØï Þ ßàÕÔÞáâÐÒÛÕÝØØ àÐ×ÛØçÝëå ãáÛãÓ, Ð âÐÚÖÕ 
ØÝäÞàÜÐæØî Þ æÕÝÐå Ø âÐàØäÐå ÜÞÖÝÞ ßÞÛãçØâì 
ã ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ ØÛØ ßÞáâÐÒéØÚÐ ãáÛãÓ. 
½ÕÞÑåÞÔØÜëÕ ØÝáâàãÚæØØ ßÞ ØáßÞÛì×ÞÒÐÝØî ãáÛãÓ 
âÐÚÖÕ ÜÞÖÝÞ ßÞÛãçØâì ã ßÞáâÐÒéØÚÞÒ 
áÞÞâÒÕâáâÒãîéØå ãáÛãÓ.

´Ûï ßÞÛãçÕÝØï ÔÞáâãßÐ Ú ¸ÝâÕàÝÕâã ÝÕÞÑåÞÔØÜÞ 
ÝÐáâàÞØâì âÞçÚã ÔÞáâãßÐ Ò ¸ÝâÕàÝÕâ Ò ãáâàÞÙáâÒÕ. 
´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî Þ âÞçÚÐå ÔÞáâãßÐ 
áÜ. Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ ãáâàÞÙáâÒÐ.

¿àÞáÜÞâà ÒÕÑ-áâàÐÝØæ
 ²ÐÖÝÞÕ ×ÐÜÕçÐÝØÕ. ¿ÞÛì×ãÙâÕáì âÞÛìÚÞ 

ãáÛãÓÐÜØ, ×ÐáÛãÖØÒÐîéØÜØ ÔÞÒÕàØï, ÚÞâÞàëÕ 
ßàÕÔÞáâÐÒÛïîâ ÝÐÔÕÖÝãî ×ÐéØâã Þâ ÒàÕÔÞÝÞáÝÞÓÞ 
ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï.

´Þáâãß Ò ¸ÝâÕàÝÕâ ÒÞ×ÜÞÖÕÝ ßÞáÛÕ ÝÐáâàÞÙÚØ ÒáÕå 
ÝÕÞÑåÞÔØÜëå ßÐàÐÜÕâàÞÒ ßÞÔÚÛîçÕÝØï Ò ãáâàÞÙáâÒÕ. 
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¼ÞØ ßàØÛ. > www. ÇâÞÑë 
ÞâÚàëâì ÒÕÑ-áâàÐÝØæã, ÝÐÖÜØâÕ 1 ÔÛï ÞâÚàëâØï ßÞÛï 
ÒÒÞÔÐ URL-ÐÔàÕáÐ ØÛØ ÝÐÖÜØâÕ 2 ÔÛï ßàÞáÜÞâàÐ 
×ÐÚÛÐÔÞÚ.

±àÐã×Õà Opera ÒëßÞÛÝïÕâ äÞàÜÐâØàÞÒÐÝØÕ 
ÒÕÑ-áâàÐÝØæ, ßàÕÔÝÐ×ÝÐçÕÝÝëå ÔÛï ßàÞáÜÞâàÐ 
ÝÐ ÚÞÜßìîâÕàÕ, âÐÚØÜ ÞÑàÐ×ÞÜ, çâÞÑë ÞÝØ 
áÞÞâÒÕâáâÒÞÒÐÛØ èØàØÝÕ ÔØáßÛÕï ãáâàÞÙáâÒÐ 
(àÕÖØÜ ßÞÔÑÞàÐ ßÞ èØàØÝÕ). ´Ûï ßÕàÕÜÕéÕÝØï ßÞ 
áâàÐÝØæÕ ÒëßÞÛÝØâÕ ßàÞÚàãâÚã ÒÒÕàå ØÛØ ÒÝØ×. ´Ûï 
ÒëÑÞàÐ ÞÑêÕÚâÞÒ ÝÐ áâàÐÝØæÕ, ÝÐßàØÜÕà, ááëÛÞÚ, 
ÚÝÞßÞÚ ØÛØ ßÞÛÕÙ äÞàÜë, ßÕàÕÙÔØâÕ Ú ÞÑêÕÚâã, 
ÒëßÞÛÝØÒ ßàÞÚàãâÚã ÒÛÕÒÞ ØÛØ ÒßàÐÒÞ, Ø ÝÐÖÜØâÕ . 
½Ð ÝÕÚÞâÞàëå áâàÐÝØæÐå, ßàÕÔÝÐ×ÝÐçÕÝÝëå áßÕæØÐÛìÝÞ 
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ÔÛï ÜÞÑØÛìÝëå âÕÛÕäÞÝÞÒ, ÒëÑÞà ÞÑêÕÚâÞÒ 
ÞáãéÕáâÒÛïÕâáï ßÞáàÕÔáâÒÞÜ ßàÞÚàãâÚØ Ò ÛîÑÞÜ 
ÝÐßàÐÒÛÕÝØØ.

´Ûï ßàÞáÜÞâàÐ ØáåÞÔÝÞÓÞ ÜÐÚÕâÐ áâàÐÝØæë ÝÐÖÜØâÕ #. 
´Ûï ßÕàÕÜÕéÕÝØï ßÞ áâàÐÝØæÕ ØáßÞÛì×ãÙâÕ ÚÛÐÒØèã 
ßàÞÚàãâÚØ. ´Ûï ÒëÔÕÛÕÝØï ÞÑêÕÚâÞÒ ÝÐ áâàÐÝØæÕ 
ÒëÑÕàØâÕ ÄÞÚãá, ßÕàÕÙÔØâÕ Ú ÞÑêÕÚâã Ø ÝÐÖÜØâÕ . 
´Ûï ßàÞÔÞÛÖÕÝØï ßàÞÚàãâÚØ áâàÐÝØæë ÒëÑÕàØâÕ 
¿àÞÚà.. ´Ûï ÒÞ×ÒàÐâÐ Ò àÕÖØÜ ßÞÔÑÞàÐ ßÞ èØàØÝÕ 
ÝÐÖÜØâÕ #.

´Ûï ßàÞáÜÞâàÐ Ø×ÞÑàÐÖÕÝØï ÒÞ ÒÕáì íÚàÐÝ ÝÐÖÜØâÕ *. 
´Ûï ÒÞ×ÒàÐâÐ Ò àÕÖØÜ ÞÑëçÝÞÓÞ ßàÞáÜÞâàÐ ÝÐÖÜØâÕ * 
ÕéÕ àÐ×.

´Ûï ßÕàÕåÞÔÐ ÝÐ ßàÕÔëÔãéãî áâàÐÝØæã ÒëÑÕàØâÕ ½Ð×..

ÇâÞÑë áÞåàÐÝØâì ×ÐÚÛÐÔÚã ÔÛï âÕÚãéÕÙ áâàÐÝØæë, 
ÝÐÖÜØâÕ 7.

¼ÞÖÝÞ ×ÐÓàãÖÐâì äÐÙÛë, ÚÞâÞàëÕ ÝÕ ÞâÞÑàÐÖÐîâáï 
ÝÐ ßàÞáÜÐâàØÒÐÕÜÞÙ áâàÐÝØæÕ, âÐÚØÕ ÚÐÚ âÕÜë 
Ø ÒØÔÕÞÚÛØßë. ´Ûï ×ÐÓàã×ÚØ ÞÑêÕÚâÐ ßÕàÕÙÔØâÕ 
ßÞ ááëÛÚÕ Ø ÝÐÖÜØâÕ .

 ²ÐÖÝÞÕ ×ÐÜÕçÐÝØÕ. ÃáâÐÝÐÒÛØÒÐÙâÕ 
Ø ØáßÞÛì×ãÙâÕ ßàØÛÞÖÕÝØï Ø ÔàãÓÞÕ ßàÞÓàÐÜÜÝÞÕ 
ÞÑÕáßÕçÕÝØÕ âÞÛìÚÞ Ø× ØáâÞçÝØÚÞÒ á ÝÐÔÕÖÝÞÙ 
×ÐéØâÞÙ Þâ ÒàÕÔÞÝÞáÝÞÓÞ ßàÞÓàÐÜÜÝÞÓÞ 
ÞÑÕáßÕçÕÝØï.

·ÐÚÞÝÞÜ ÞÑ ÞåàÐÝÕ ÐÒâÞàáÚØå ßàÐÒ ÜÞÓãâ Ñëâì 
ãáâÐÝÞÒÛÕÝë ÞÓàÐÝØçÕÝØï ÝÐ ÚÞßØàÞÒÐÝØÕ, 
ÜÞÔØäØÚÐæØî, ßÕàÕÔÐçã Ø ×ÐÓàã×Úã ÝÕÚÞâÞàëå 
ÚÐàâØÝÞÚ, Üã×ëÚÐÛìÝëå ÚÞÜßÞ×ØæØÙ (Ò âÞÜ çØáÛÕ 
ÜÕÛÞÔØÙ) Ø ÔàãÓØå ÔÐÝÝëå.

´Ûï Ø×ÜÕÝÕÝØï ÝÐáâàÞÕÚ ÔØáßÛÕï, ÞÑéØå ØÛØ 
ÔÞßÞÛÝØâÕÛìÝëå ÝÐáâàÞÕÚ ÒëÑÕàØâÕ ¾ßæØØ > Settings.

·ÐÒÕàèÕÝØÕ áÞÕÔØÝÕÝØï
´Ûï ×ÐÒÕàèÕÝØï áÞÕÔØÝÕÝØï Ø ×ÐÚàëâØï ÑàÐã×ÕàÐ 
ÒëÑÕàØâÕ ¾ßæØØ > ²ëÙâØ.

¾çØáâÚÐ Úíè-ßÐÜïâØ
ºíè-ßÐÜïâì - íâÞ ÞÑÛÐáâì ßÐÜïâØ, ßàÕÔÝÐ×ÝÐçÕÝÝÐï 
ÔÛï ÒàÕÜÕÝÝÞÓÞ åàÐÝÕÝØï ÔÐÝÝëå. ´Ûï ßÞÒëèÕÝØï 
ÑÕ×ÞßÐáÝÞáâØ ßàØ ÞÑàÐéÕÝØØ Ú ÚÞÝäØÔÕÝæØÐÛìÝÞÙ 
ØÝäÞàÜÐæØØ á ØáßÞÛì×ÞÒÐÝØÕÜ ßÐàÞÛÕÙ ÞçØéÐÙâÕ 
Úíè-ßÐÜïâì ßÞáÛÕ ÚÐÖÔÞÓÞ ÞÑàÐéÕÝØï (ØÛØ ßÞßëâÚØ 
ÞÑàÐéÕÝØï). ¸ÝäÞàÜÐæØï Ø ÐÔàÕáÐ ãáÛãÓ, Ú ÚÞâÞàëÜ 
ÒëßÞÛÝïÛÞáì ÞÑàÐéÕÝØÕ, áÞåàÐÝïîâáï Ò Úíè-ßÐÜïâØ. 
´Ûï ÞçØáâÚØ Úíè-ßÐÜïâØ ÒëÑÕàØâÕ ¾ßæØØ > 
¸ÝáâàãÜÕÝâë > ÃÔÐÛØâì ÛØçÝëÕ ÔÐÝÝëÕ > 
¾çØáâØâì Úíè.
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´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
´Ûï ßÞÛãçÕÝØï ÔÞßÞÛÝØâÕÛìÝÞÙ ØÝäÞàÜÐæØØ 
Þ äãÝÚæØïå ßàÞÓàÐÜÜë ÒëÑÕàØâÕ ¾ßæØØ > 
¸ÝáâàãÜÕÝâë > Áßà..

´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî áÜ. ßÞ ÐÔàÕáã 
www.opera.com/support/tutorials/s60/.
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ÁàÕÔáâÒÐ 
SettingWizard 

¿àØÛÞÖÕÝØÕ SettingWizard ßÞ×ÒÞÛïÕâ ãáâÐÝÞÒØâì 
ÝÐ ãáâàÞÙáâÒÕ ÝÐáâàÞÙÚØ ÞßÕàÐâÞàÐ (MMS, GPRS 
Ø ¸ÝâÕàÝÕâ), íÛÕÚâàÞÝÝÞÙ ßÞçâë, ãáÛãÓØ PPT 
(ãáÛãÓÐ áÕâØ) Ø ÞÑéÕÓÞ ÔÞáâãßÐ Ú ÒØÔÕÞ (ãáÛãÓÐ áÕâØ) 
ÝÐ ÞáÝÞÒÕ ØÝäÞàÜÐæØØ, ßàÕÔÞáâÐÒÛÕÝÝÞÙ ÞßÕàÐâÞàÞÜ 
áÞâÞÒÞÙ áÕâØ.

 ¿àØÜÕçÐÝØÕ. ´Ûï ßÞÛì×ÞÒÐÝØï íâØÜØ ãáÛãÓÐÜØ 
ÞÑàÐâØâÕáì Ú ßÞáâÐÒéØÚã ãáÛãÓ ØÛØ ÞßÕàÐâÞàã 
áÞâÞÒÞÙ áÕâØ ÔÛï ÐÚâØÒØ×ÐæØØ äãÝÚæØØ áÞÕÔØÝÕÝØï 
Ò àÕÖØÜÕ ßÕàÕÔÐçØ ÔÐÝÝëå ØÛØ ÔàãÓØå ãáÛãÓ.

½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ÁàÕÔáâÒÐ > SettingWizard.

²ëÑÕàØâÕ Ò ÜÕÝî ßãÝÚâ, ÔÛï ÚÞâÞàÞÓÞ âàÕÑãÕâáï 
ÝÐáâàÞØâì ãáâàÞÙáâÒÞ, Ø ÝÐÖÜØâÕ .

ÍÛÕÚâàÞÝÝÐï ßÞçâÐ
1 µáÛØ ÒëÑàÐÝÐ ÝÐáâàÞÙÚÐ ßÐàÐÜÕâàÞÒ íÛÕÚâàÞÝÝÞÙ 

ßÞçâë, ßàØÛÞÖÕÝØÕ SettingWizard ÞßàÕÔÕÛïÕâ 
ÔÞáâãßÝÞÓÞ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ Ø ×ÐßàÐèØÒÐÕâ 

ßÞÔâÒÕàÖÔÕÝØÕ. ²ëÑÕàØâÕ ¾K ØÛØ ÒëÔÕÛØâÕ 
ÔàãÓÞÓÞ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ Ø ÒëÑÕàØâÕ ¾K.

2 ²ëÑÕàØâÕ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ Ø× áßØáÚÐ.
3 ²ëÑÕàØâÕ áÕàÒÕà ØáåÞÔïéÕÙ ßÞçâë. µáÛØ ÒÞ×ÝØÚÛØ 

áÞÜÝÕÝØï, ØáßÞÛì×ãÙâÕ áÕàÒÕà ßÞ ãÜÞÛçÐÝØî.
4 ¿àØÛÞÖÕÝØÕ SettingWizard ÒëÒÞÔØâ ×ÐßàÞá ÝÐ 

ÒÒÞÔ ÐÔàÕáÐ íÛÕÚâàÞÝÝÞÙ ßÞçâë, ØÜÕÝØ 
ßÞÛì×ÞÒÐâÕÛï Ø ßÐàÞÛï. ²ëÑÕàØâÕ 
ßÞáÛÕÔÞÒÐâÕÛìÝÞ ÚÐÖÔëÙ ßÐàÐÜÕâà Ø ÒëÑÕàØâÕ 
ÄãÝÚæØØ > ¸×ÜÕÝØâì. ²ÒÕÔØâÕ ÔÐÝÝëÕ 
Ø ÒëÑÕàØâÕ ¾K.

5 ·ÐÒÕàèØÒ Ø×ÜÕÝÕÝØÕ, ÒëÑÕàØâÕ ÄãÝÚæØØ > ¾K.
6 ²ëÑÕàØâÕ OK ÔÛï ßÞÔâÒÕàÖÔÕÝØï ÝÕÞÑåÞÔØÜÞáâØ 

ÝÐáâàÞÙÚØ ßÞçâÞÒÞÓÞ ïéØÚÐ ÔÛï ãÚÐ×ÐÝÝÞÓÞ 
ÞßÕàÐâÞàÐ.

7 ²ëÑÕàØâÕ ¾K.

ÃáÛãÓÐ PTT
1 µáÛØ ÒëÑàÐÝÐ ÝÐáâàÞÙÚÐ ßÐàÐÜÕâàÞÒ ãáÛãÓØ 

PTT (ãáÛãÓÐ áÕâØ) ßàØÛÞÖÕÝØÕ SettingWizard 
ÞßàÕÔÕÛïÕâ ÔÞáâãßÝÞÓÞ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ 
Ø ×ÐßàÐèØÒÐÕâ ßÞÔâÒÕàÖÔÕÝØÕ. ²ëÑÕàØâÕ ¾K 
ØÛØ ÒëÔÕÛØâÕ ÔàãÓÞÓÞ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ 
Ø ÒëÑÕàØâÕ ¾K.
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2 ´Ûï ÝÕÚÞâÞàëå ÞßÕàÐâÞàÞÒ âàÕÑãÕâáï ÒÒÕáâØ ØÜï 
ßÞÛì×ÞÒÐâÕÛï, ßÐàÞÛì Ø ßáÕÒÔÞÝØÜ. ²ëÑÕàØâÕ 
ßÞáÛÕÔÞÒÐâÕÛìÝÞ ÚÐÖÔëÙ ßÐàÐÜÕâà Ø ÒëÑÕàØâÕ 
ÄãÝÚæØØ > ¸×ÜÕÝØâì. ²ÒÕÔØâÕ ÔÐÝÝëÕ 
Ø ÒëÑÕàØâÕ ¾K.

3 ·ÐÒÕàèØÒ Ø×ÜÕÝÕÝØÕ, ÒëÑÕàØâÕ ÄãÝÚæØØ > ¾K.
4 ²ëÑÕàØâÕ ¾K ÔÛï ßÞÔâÒÕàÖÔÕÝØï ÝÕÞÑåÞÔØÜÞáâØ 

ÝÐáâàÞÙÚØ ãáÛãÓØ PTT ÔÛï ãÚÐ×ÐÝÝÞÓÞ ÞßÕàÐâÞàÐ.

¾ßÕàÐâÞà
1 µáÛØ ÒëÑàÐÝÐ ÝÐáâàÞÙÚÐ ßÐàÐÜÕâàÞÒ ÞßÕàÐâÞàÐ, 

ßàØÛÞÖÕÝØÕ SettingWizard ÞßàÕÔÕÛïÕâ ÔÞáâãßÝÞÓÞ 
ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ Ø ×ÐßàÐèØÒÐÕâ 
ßÞÔâÒÕàÖÔÕÝØÕ. ²ëÑÕàØâÕ ¾K ØÛØ ÒëÔÕÛØâÕ 
ÔàãÓÞÓÞ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ Ø ÒëÑÕàØâÕ ¾K.

2 ²ëÑÕàØâÕ ¾K, çâÞÑë ßÞÔâÒÕàÔØâì ÝÐáâàÞÙÚØ 
ãáâàÞÙáâÒÐ ÔÛï ãÚÐ×ÐÝÝÞÓÞ ÞßÕàÐâÞàÐ.

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
¿àØ ÒÞ×ÝØÚÝÞÒÕÝØØ ßàÞÑÛÕÜ á ßàØÛÞÖÕÝØÕÜ 
SettingWizard ßÕàÕÙÔØâÕ ÝÐ ÒÕÑ-áÐÙâ 
ßÐàÐÜÕâàÞÒ âÕÛÕäÞÝÞÒ Nokia ßÞ ÐÔàÕáã 
www.nokia.com/phonesettings.
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Mobile Search
Mobile Search 

Á ßÞÜÞéìî Mobile Search (ãáÛãÓÐ ßÞØáÚÐ) ÜÞÖÝÞ 
ßÞÛãçØâì ÔÞáâãß Ú ÞáÝÞÒÝëÜ ßÞÔáØáâÕÜÐÜ ßÞØáÚÐ. 
ÍâÞ ßàÞáâÞÙ, ãÔÞÑÝëÙ Ø ÑëáâàëÙ áßÞáÞÑ ßÞØáÚÐ 
ÜÕáâÝëå ãáÛãÓ, ÒÕÑ-ã×ÛÞÒ, Ø×ÞÑàÐÖÕÝØÙ, áÞÔÕàÖØÜÞÓÞ 
ÔÛï ÜÞÑØÛìÝëå ãáâàÞÙáâÒ Ø ßÞÔÚÛîçÕÝØï Ú ÝØÜ. 
¼ÞÖÝÞ ÝÐÙâØ ØÝäÞàÜÐæØî Þ ÜÕáâÝëå àÕáâÞàÐÝÐå 
Ø ÜÐÓÐ×ØÝÐå, ã×ÝÐâì ÝÞÜÕàÐ Øå âÕÛÕäÞÝÞÒ, Ð âÐÚÖÕ 
ÞßàÕÔÕÛØâì Øå ÜÕáâÞÝÐåÞÖÔÕÝØÕ á ßÞÜÞéìî 
ãÛãçèÕÝÝÞÙ âÕåÝÞÛÞÓØØ ÚÐàâØàÞÒÐÝØï.

¸áßÞÛì×ÞÒÐÝØÕ ãáÛãÓØ Mobile Search
½ÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¿ÞØáÚ.

 ¿àØÜÕçÐÝØÕ. ´ÞáâãßÝÞáâì íâÞÙ ãáÛãÓØ ×ÐÒØáØâ 
Þâ áâàÐÝë Ø Þâ âÞàÓÞÒÞÙ âÞçÚØ.

¿àØ ÞâÚàëâØØ Mobile Search ÞâÞÑàÐÖÐÕâáï áßØáÞÚ 
ÚÐâÕÓÞàØÙ. ²ëÑÕàØâÕ ÚÐâÕÓÞàØî (ÝÐßàØÜÕà, «Images») 
Ø ÒÒÕÔØâÕ âÕÚáâ Ò ßÞÛÕ ßÞØáÚÐ. ²ëÑÕàØâÕ ¿ÞØáÚ, 
Ø ÞâÞÑàÐ×ïâáï àÕ×ãÛìâÐâë ßÞØáÚÐ.

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
´Ûï ßÞÛãçÕÝØï ÔÞßÞÛÝØâÕÛìÝëå áÒÕÔÕÝØÙ Þ äãÝÚæØïå 
ßàÞÓàÐÜÜë ÒëÑÕàØâÕ ÄãÝÚæØØ > ÁßàÐÒÚÐ.

´ÞßÞÛÝØâÕÛìÝëÕ áÒÕÔÕÝØï áÜ. ßÞ ÐÔàÕáã 
www.mobilesearch.nokia.com/.
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Yahoo! Go
Yahoo! Go 

¿ÞÛãçÐÙâÕ ÔÞáâãß Ú áÞÞÑéÕÝØïÜ íÛÕÚâàÞÝÝÞÙ ßÞçâë, 
äÞâÞÐÛìÑÞÜÐÜ, çÐâã Ø ÔàãÓØÜ äãÝÚæØïÜ, ÓÔÕ Ñë ²ë 
ÝÕ ÝÐåÞÔØÛØáì. ÅàÐÝØâì ÔÐÝÝëÕ âÕßÕàì ßàÞáâÞ 
Ø ÑÕ×ÞßÐáÝÞ. Á ßÞÜÞéìî Yahoo! Go (ÔÞáâãß Ú ãáÛãÓÐÜ) 
ÜÞÖÝÞ ßÞÔÔÕàÖØÒÐâì áÞÕÔØÝÕÝØÕ á ßÞÜÞéìî ãçÕâÝÞÙ 
×ÐßØáØ Yahoo! Ø× ÛîÑÞÓÞ ÜÕáâÞßÞÛÞÖÕÝØï.

 ¿àØÜÕçÐÝØÕ. ½ÕÚÞâÞàëÕ ßàØÛÞÖÕÝØï 
àÕÐÛØ×ÞÒÐÝë ÝÕ ÔÛï ÒáÕå ï×ëÚÞÒ.

Yahoo! Go ßÞ×ÒÞÛïÕâ ßÞÛãçÐâì ÔÞáâãß Ú ãáÛãÓÐÜ, 
ÒÚÛîçÐï Yahoo! Mail (ãáÛãÓÐ íÛÕÚâàÞÝÝÞÙ ßÞçâë), 
Yahoo! Messenger (ãáÛãÓÐ ÞÑÜÕÝÐ áÞÞÑéÕÝØïÜØ), 
Yahoo! Photos (ãáÛãÓÐ àÐÑÞâë á äÞâÞÓàÐäØïÜØ), Yahoo! 
Search (ãáÛãÓÐ ßÞØáÚÐ), Ð âÐÚÖÕ ßàÞáÜÐâàØÒÐâì ÝÞÒÞáâØ 
Ø ×ÐÓàãÖÐâì ØÓàë Ø ÜÕÛÞÔØØ.

Yahoo! Go ØáßÞÛì×ãÕâ äãÝÚæØî ÕÔØÝÞÙ àÕÓØáâàÐæØØ, 
ßÞíâÞÜã ÒÞ ÒàÕÜï ÝÐáâàÞÙÚØ ßÞâàÕÑãÕâáï 
×ÐàÕÓØáâàØàÞÒÐâìáï âÞÛìÚÞ ÞÔØÝ àÐ×.

Yahoo! Go ßàÕÔÞáâÐÒÛïÕâ çÕâëàÕ ÞáÝÞÒÝëÕ äãÝÚæØØ:
• Yahoo! Mail
• Yahoo! Messenger

• Yahoo! Connections
• Yahoo! Photos

Yahoo! Mail
Yahoo! Mail ßÞ×ÒÞÛïÕâ ßÞÛãçÐâì áÞÞÑéÕÝØï 
íÛÕÚâàÞÝÝÞÙ ßÞçâë Ø× ÛîÑÞÓÞ ÜÕáâÞßÞÛÞÖÕÝØï. 
°ÒâÞÜÐâØçÕáÚÐï áØÝåàÞÝØ×ÐæØï á ãçÕâÝÞÙ ×ÐßØáìî 
Yahoo! Mail ÞÑÕáßÕçØÒÐÕâ ÝÕÜÕÔÛÕÝÝÞÕ ÞâàÐÖÕÝØÕ 
Ò ãçÕâÝÞÙ ×ÐßØáØ Yahoo! ÛîÑëå ÒÝÞáØÜëå Ø×ÜÕÝÕÝØÙ 
(ÝÐßàØÜÕà, ßÕàÕÔÐçã áÞÞÑéÕÝØÙ íÛÕÚâàÞÝÝÞÙ ßÞçâë, 
ÞâÜÕâÚã áÞÞÑéÕÝØÙ ÚÐÚ ßàÞçØâÐÝÝëå ØÛØ Øå ãÔÐÛÕÝØÕ).

Yahoo! Messenger
Yahoo! Messenger ßÞ×ÒÞÛïÕâ á ßÞÜÞéìî ãáâàÞÙáâÒÐ 
ÞÑÜÕÝØÒÐâìáï áÞÞÑéÕÝØïÜØ çÐâÐ á ÚÞÝâÐÚâÐÜØ. ¼ÞÖÝÞ 
ßÕàÕÔÐÒÐâì Ø ßàØÝØÜÐâì áÞÞÑéÕÝØï çÐâÐ, ×ÝÐçÚØ 
ÝÐáâàÞÕÝØï, ×ÒãÚØ, ÓÞÛÞáÞÒëÕ áÞÞÑéÕÝØï çÐâÐ, 
ÒÚÛÐÔëÒÐâì Ø×ÞÑàÐÖÕÝØï Ò áÞÞÑéÕÝØï çÐâÐ, Ð âÐÚÖÕ 
ãßàÐÒÛïâì ãçÕâÝÞÙ ×ÐßØáìî Yahoo! Messenger.

Á ßÞÜÞéìî ÞÔÝÞÓÞ éÕÛçÚÐ ÜÞÖÝÞ ×ÐàÕÓØáâàØàÞÒÐâìáï 
Ò Yahoo! Messenger, çâÞÑë ÞâÞÑàÐ×Øâìáï 
Ò ßÞÔÚÛîçÕÝÝÞÜ áÞáâÞïÝØØ ÔÛï ÒáÕå ÚÞÝâÐÚâÞÒ. 
¸ÝäÞàÜÐæØï Þ ÒåÞÔÕ áÞåàÐÝïÕâáï Ò ãáâàÞÙáâÒÕ, 
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ßÞíâÞÜã ÝÕâ ÝÕÞÑåÞÔØÜÞáâØ ÒÒÞÔØâì ÕÕ ÕéÕ àÐ× ßàØ 
ÞâßàÐÒÚÕ áÞÞÑéÕÝØï çÐâÐ. ÁâÐÝÔÐàâÝÐï ÝÐáâàÞÙÚÐ 
àÕÓØáâàÐæØØ Ò ãáÛãÓÕ Messenger — ÜÐÚáØÜãÜ 10 ÜØÝãâ 
á ÜÞÜÕÝâÐ ßÕàÕåÞÔÐ ãáâàÞÙáâÒÐ Ò ÝÕÐÚâØÒÝëÙ àÕÖØÜ. 
ÃÒÕÛØçÕÝØÕ ÒàÕÜÕÝØ ÔÛï íâÞÙ ÝÐáâàÞÙÚØ ßàØÒÕÔÕâ 
Ú ãÜÕÝìèÕÝØî ÒàÕÜÕÝØ ÞÖØÔÐÝØï ãáâàÞÙáâÒÐ. 

² ÝÕÚÞâÞàëå áÕâïå ÝÕ ßÞÔÔÕàÖØÒÐÕâáï ÞÔÝÞÒàÕÜÕÝÝÞÕ 
ØáßÞÛì×ÞÒÐÝØÕ Yahoo! Messenger Ø ßàØÕÜ 
ÒØÔÕÞÒë×ÞÒÞÒ ØÛØ ÜãÛìâØÜÕÔØÙÝëå 
áÞÞÑéÕÝØÙ (MMS).

Yahoo! Connections
Yahoo! Connections (ãáÛãÓÐ ßÞÔÚÛîçÕÝØï) ßÞ×ÒÞÛïÕâ 
áØÝåàÞÝØ×ØàÞÒÐâì ãáâàÞÙáâÒÞ á ãçÕâÝÞÙ ×ÐßØáìî 
Yahoo!.

Yahoo! Connections ÐÒâÞÜÐâØçÕáÚØ ×ÐßãáÚÐÕâáï 
ßàØ ÚÐÖÔÞÜ ÒÚÛîçÕÝØØ ãáâàÞÙáâÒÐ. ¿àØ íâÞÜ 
ÝÕÞÑï×ÐâÕÛìÝÞ ÞâÚàëÒÐâì ÑàÐã×Õà ÔÛï ßàÞáÜÞâàÐ 
áÞÞÑéÕÝØÙ íÛÕÚâàÞÝÝÞÙ ßÞçâë Ø ÔàãÓØå ÔÐÝÝëå Yahoo!. 
ÁÞÞÑéÕÝØï íÛÕÚâàÞÝÝÞÙ ßÞçâë ÜÞÖÝÞ ßÕàÕÔÐÒÐâì 
á ßÞÜÞéìî ãçÕâÝÞÙ ×ÐßØáØ Yahoo! Mail. ¸áßÞÛì×ãï 
áÞÞâÒÕâáâÒãîéØÕ ßàØÛÞÖÕÝØï ãáâàÞÙáâÒÐ, ÜÞÖÝÞ 
ÞáãéÕáâÒÛïâì ßàÞáÜÞâà, áÞ×ÔÐÝØÕ, Ø×ÜÕÝÕÝØÕ 
Ø ãÔÐÛÕÝØÕ ÚÞÝâÐÚâÞÒ, áÞÑëâØÙ ÚÐÛÕÝÔÐàï Ø ×ÐÔÐÝØÙ. 
»îÑëÕ Ø×ÜÕÝÕÝØï ÞâàÐÖÐîâáï Ò ãçÕâÝÞÙ ×ÐßØáØ Yahoo!.

Yahoo! Connections ÞâÞÑàÐÖÐÕâ áÞáâÞïÝØÕ ßÞáÛÕÔÝÕÓÞ 
áÞÕÔØÝÕÝØï, ÑëÛÞ ÞÝÞ ãáßÕèÝëÜ ØÛØ ÝÕâ, Ð âÐÚÖÕ 
âÕÚãéÕÕ áÞáâÞïÝØÕ ÞÑÜÕÝÐ ÔÐÝÝëÜØ. ÍâÐ ãáÛãÓÐ 
âÐÚÖÕ ÞâÞÑàÐÖÐÕâ ÒàÕÜï ßÞáÛÕÔÝÕÓÞ Ø áÛÕÔãîéÕÓÞ 
×ÐßÛÐÝØàÞÒÐÝÝÞÓÞ ÞÑÜÕÝÐ ÔÐÝÝëÜØ.

Yahoo! Photos
Yahoo! Photos ßÞ×ÒÞÛïÕâ áÞÒÜÕáâÝÞ ØáßÞÛì×ÞÒÐâì 
äÞâÞÓàÐäØØ Ø ãßàÐÒÛïâì ØÜØ. Yahoo! ÄÞâÞÓàÐäØØ, 
áÞåàÐÝÕÝÝëÕ Ò ãáâàÞÙáâÒÕ, ÜÞÖÝÞ ßàÞáÜÐâàØÒÐâì 
Ø ßÕàÕÔÐÒÐâì á ãáâàÞÙáâÒÐ. ºàÞÜÕ âÞÓÞ, ÜÞÖÝÞ 
áÞ×ÔÐÒÐâì ááëÛÚØ ÝÐ Yahoo! Photos Ø ßàÞáÜÐâàØÒÐâì 
ÐÛìÑÞÜë Ò ¸ÝâÕàÝÕâÕ. ÍâÐ äãÝÚæØï àÐÑÞâÐÕâ 
áÞÒÜÕáâÝÞ á äãÝÚæØÕÙ Yahoo! Connections.

¿ÞáÛÕ ÚÐÖÔÞÙ áêÕÜÚØ äÞâÞÓàÐäØØ á ßÞÜÞéìî 
ãáâàÞÙáâÒÐ Yahoo! Photos ßàÕÔÛÐÓÐÕâ ÔÞÑÐÒØâì ÕÕ 
Ò ÐÛìÑÞÜ. ÄÞâÞÓàÐäØØ, ßÕàÕÔÐÝÝëÕ Ò Yahoo! Photos, 
ÞâÞÑàÐÖÐîâáï:
• Ò ÐÛìÑÞÜÕ ÝÐ ÒÕÑ-áÐÙâÕ Yahoo! Photos 

(Ò ØáåÞÔÝÞÜ àÐ×ÜÕàÕ);
• Ò ßàØÛÞÖÕÝØØ Yahoo! Photos ÝÐ ãáâàÞÙáâÒÕ 

(Ò ãÜÕÝìèÕÝÝÞÜ àÐ×ÜÕàÕ);
• Ò ßàØÛÞÖÕÝØØ «³ÐÛÕàÕï» (Ò ØáåÞÔÝÞÜ àÐ×ÜÕàÕ).
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´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
´ÞßÞÛÝØâÕÛìÝëÕ áÒÕÔÕÝØï Þ àÐÑÞâÕ äãÝÚæØØ Yahoo! 
Go, ÕÕ áâÞØÜÞáâØ Ø ÔÞßÞÛÝØâÕÛìÝÞÙ áßàÐÒÚÕ áÜ ßÞ 
ÐÔàÕáã www.yahoo.com/.
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´Ûï ÚÞÜßìîâÕàÐ
Lifeblog  

Nokia Lifeblog – íâÞ ÚÞÜßÛÕÚâ ¿¾, ÒÚÛîçÐîéØÙ 
ßàÞÓàÐÜÜÝÞÕ ÞÑÕáßÕçÕÝØÕ ÔÛï ÜÞÑØÛìÝÞÓÞ âÕÛÕäÞÝÐ 
Ø ÔÛï ÚÞÜßìîâÕàÐ, ÚÞâÞàÞÕ ßÞ×ÒÞÛïÕâ ÒÕáâØ ãçÕâ 
ÔÐÝÝëå ÜãÛìâØÜÕÔØÐ, áÞåàÐÝÕÝÝëå ÝÐ ãáâàÞÙáâÒÕ. 
Nokia Lifeblog ÐÒâÞÜÐâØçÕáÚØ ãßÞàïÔÞçØÒÐÕâ 
äÞâÞÓàÐäØØ, ÒØÔÕÞ×ÐßØáØ, ×ÒãÚÞÒëÕ äÐÙÛë, âÕÚáâÞÒëÕ 
áÞÞÑéÕÝØï, áÞÞÑéÕÝØï ÜãÛìâØÜÕÔØÐ Ø ßãÑÛØÚÐæØØ 
ÒÕÑ-ÖãàÝÐÛÐ Ò åàÞÝÞÛÞÓØçÕáÚÞÜ ßÞàïÔÚÕ, çâÞÑë Øå 
ÜÞÖÝÞ ÑëÛÞ ßàÞáÜÐâàØÒÐâì, ØáÚÐâì, áÞÒÜÕáâÝÞ 
ØáßÞÛì×ÞÒÐâì, ßãÑÛØÚÞÒÐâì Ø ÚÞßØàÞÒÐâì. 
¿àÞÓàÐÜÜÝÞÕ ÞÑÕáßÕçÕÝØÕ Nokia Lifeblog (ÚÐÚ ÔÛï 
ÚÞÜßìîâÕàÐ, âÐÚ Ø ÔÛï ÜÞÑØÛìÝÞÓÞ âÕÛÕäÞÝÐ) 
ßÞ×ÒÞÛïÕâ ÞâßàÐÒÛïâì ØÛØ ×ÐÝÞáØâì Ò ÒÕÑ-ÖãàÝÐÛ 
ÞÑêÕÚâë, çâÞÑë Øå ÜÞÓÛØ ãÒØÔÕâì ÔàãÓØÕ ßÞÛì×ÞÒÐâÕÛØ.

Nokia Lifeblog ÔÛï ÜÞÑØÛìÝÞÓÞ âÕÛÕäÞÝÐ 
ÐÒâÞÜÐâØçÕáÚØ ÞâáÛÕÖØÒÐÕâ ÞÑêÕÚâë ÜãÛìâØÜÕÔØÐ. 
¸áßÞÛì×ãÙâÕ ßàÞÓàÐÜÜÝÞÕ ÞÑÕáßÕçÕÝØÕ Nokia Lifeblog 
ÝÐ ãáâàÞÙáâÒÕ ÔÛï ßàÞáÜÞâàÐ ÞÑêÕÚâÞÒ, ßÕàÕÔÐçØ Øå 
ÔàãÓØÜ ßÞÛì×ÞÒÐâÕÛïÜ ØÛØ ßãÑÛØÚÐæØØ Ò ¸ÝâÕàÝÕâÕ. 
¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú áÞÒÜÕáâØÜÞÜã ÚÞÜßìîâÕàã 
á ßÞÜÞéìî áÞÒÜÕáâØÜÞÓÞ USB-ÚÐÑÕÛï ÔÛï ßÕàÕÔÐçØ 

ÔÐÝÝëå ØÛØ çÕàÕ× ÚÐÝÐÛ áÒï×Ø Bluetooth ÔÛï ßÕàÕÔÐçØ 
Ø áØÝåàÞÝØ×ÐæØØ ÞÑêÕÚâÞÒ ÝÐ ãáâàÞÙáâÒÕ á ÔÐÝÝëÜØ 
ÚÞÜßìîâÕàÐ.

¿àÞÓàÐÜÜÝÞÕ ÞÑÕáßÕçÕÝØÕ Nokia Lifeblog ÔÛï 
ÚÞÜßìîâÕàÐ ßÞ×ÒÞÛïÕâ ÞáãéÕáâÒÛïâì ßÞØáÚ 
Ø ßàÞáÜÞâà ÞÑêÕÚâÞÒ, áÞåàÐÝÕÝÝëå ÝÐ ãáâàÞÙáâÒÕ. 
±ÛÐÓÞÔÐàï ßÕàÕÔÐçÕ ßÞáàÕÔáâÒÞÜ ÝÐÖÐâØï ÞÔÝÞÙ 
ÚÝÞßÚØ, ßàØ ÚÞâÞàÞÙ ØáßÞÛì×ãÕâáï áÞÒÜÕáâØÜëÙ 
USB-ÚÐÑÕÛì ÔÛï ßÕàÕÔÐçØ ÔÐÝÝëå ØÛØ ÚÐÝÐÛ áÒï×Ø 
Bluetooth, Ø×ÑàÐÝÝëÕ äÞâÞÓàÐäØØ, ÒØÔÕÞ×ÐßØáØ, 
âÕÚáâÞÒëÕ áÞÞÑéÕÝØï ØÛØ áÞÞÑéÕÝØï ÜãÛìâØÜÕÔØÐ 
ßÕàÕÔÐîâáï ÞÑàÐâÝÞ ÝÐ ãáâàÞÙáâÒÞ.

² æÕÛïå ÞÑÕáßÕçÕÝØï áÞåàÐÝÝÞáâØ ÔÐÝÝëå ÜÞÖÝÞ 
áÞ×ÔÐÒÐâì àÕ×ÕàÒÝãî ÚÞßØî ÑÐ×ë ÔÐÝÝëå Nokia Lifeblog 
ÝÐ ÖÕáâÚÞÜ ÔØáÚÕ, ÚÞÜßÐÚâ-ÔØáÚÐå, DVD-ÔØáÚÐå, 
áêÕÜÝëå ãáâàÞÙáâÒÐå ØÛØ áÕâÕÒëå ÔØáÚÐå. ºàÞÜÕ âÞÓÞ, 
ÞÑêÕÚâë ÜÞÖÝÞ ßãÑÛØÚÞÒÐâì Ò ÒÕÑ-ÖãàÝÐÛÕ (ÑÛÞÓ).

 ¿àØÜÕçÐÝØÕ. ÍâÞ ßàØÛÞÖÕÝØÕ àÕÐÛØ×ÞÒÐÝÞ ÝÕ 
ÔÛï ÒáÕå ï×ëÚÞÒ.

´Ûï ×ÐßãáÚÐ ßàØÛÞÖÕÝØï Lifeblog ÝÐ ãáâàÞÙáâÒÕ 
ÝÐÖÜØâÕ  Ø ÒëÑÕàØâÕ ¼ÞØ ßàØÛ. > Lifeblog > 
ÄãÝÚæØØ > ¾âÚàëâì.
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ÃáâÐÝÞÒÚÐ ÝÐ ÚÞÜßìîâÕàÕ 
´Ûï ãáâÐÝÞÒÚØ Nokia Lifeblog ÝÐ áÞÒÜÕáâØÜÞÜ 
ÚÞÜßìîâÕàÕ ÝÕÞÑåÞÔØÜÞ áÛÕÔãîéÕÕ:
• ¿àÞæÕááÞà Intel Pentium á çÐáâÞâÞÙ 1 ³³æ ØÛØ ÕÓÞ 

íÚÒØÒÐÛÕÝâ, 128 ¼Ñ ¾·Ã.
• 400 ¼Ñ áÒÞÑÞÔÝÞÓÞ ßàÞáâàÐÝáâÒÐ ÝÐ ÖÕáâÚÞÜ ÔØáÚÕ 

(ÕáÛØ ÝÕÞÑåÞÔØÜÞ ãáâÐÝÞÒØâì Microsoft DirectX 
Ø Nokia PC Suite).

• ÀÐ×àÕèÕÝØÕ: 1024 ÝÐ 768 âÞçÕÚ; ÚÐçÕáâÒÞ 
æÒÕâÞßÕàÕÔÐçØ: 24 ÑØâÐ.

• ²ØÔÕÞÚÐàâÐ ÕÜÚÞáâìî 32 ¼Ñ.
• ¾ßÕàÐæØÞÝÝÐï áØáâÕÜÐ Microsoft Windows 2000 

ØÛØ Windows XP.

¿ÞàïÔÞÚ ãáâÐÝÞÒÚØ Nokia Lifeblog ÝÐ ÚÞÜßìîâÕàÕ:
1 ²áâÐÒìâÕ ÚÞÜßÐÚâ-ÔØáÚ, ÒåÞÔïéØÙ Ò ÚÞÜßÛÕÚâ 

ßÞáâÐÒÚØ ãáâàÞÙáâÒÐ.
2 ÃáâÐÝÞÒØâÕ ßÐÚÕâ ßàÞÓàÐÜÜ Nokia PC Suite 

(ÒÚÛîçÐï ÔàÐÙÒÕàë áÞÕÔØÝØâÕÛìÝëå ÚÐÑÕÛÕÙ 
Nokia ÔÛï USB-áÞÕÔØÝÕÝØï).

3 ÃáâÐÝÞÒØâÕ Nokia Lifeblog ÔÛï ÚÞÜßìîâÕàÐ. 

µáÛØ ßàØÛÞÖÕÝØÕ Microsoft DirectX 9.0 ÕéÕ ÝÕ 
ãáâÐÝÞÒÛÕÝÞ ÝÐ ÚÞÜßìîâÕàÕ, ÕÓÞ ãáâÐÝÞÒÚÐ 
ÒëßÞÛÝïÕâáï ÞÔÝÞÒàÕÜÕÝÝÞ á ãáâÐÝÞÒÚÞÙ 
ßàØÛÞÖÕÝØï Nokia Lifeblog ÔÛï ÚÞÜßìîâÕàÐ.

ÃáâÐÝÞÒÚÐ áÞÕÔØÝÕÝØï ÜÕÖÔã 
ãáâàÞÙáâÒÞÜ Ø ÚÞÜßìîâÕàÞÜ
¿ÞàïÔÞÚ ãáâÐÝÞÒÚØ áÞÕÔØÝÕÝØï ÜÕÖÔã ãáâàÞÙáâÒÞÜ 
Ø áÞÒÜÕáâØÜëÜ ÚÞÜßìîâÕàÞÜ á ßÞÜÞéìî 
áÞÒÜÕáâØÜÞÓÞ USB-ÚÐÑÕÛï:
1 ÃÑÕÔØâÕáì Ò âÞÜ, çâÞ ãáâÐÝÞÒÛÕÝ ßÐÚÕâ ßàÞÓàÐÜÜ 

Nokia PC Suite.
2 ¿ÞÔÚÛîçØâÕ USB-ÚÐÑÕÛì ÔÛï ßÕàÕÔÐçØ ÔÐÝÝëå 

Ú ãáâàÞÙáâÒã Ø Ú ÚÞÜßìîâÕàã. µáÛØ ãáâàÞÙáâÒÞ 
ßÞÔÚÛîçÐÕâáï Ú ÚÞÜßìîâÕàã ÒßÕàÒëÕ ßÞáÛÕ 
ãáâÐÝÞÒÚØ ßÐÚÕâÐ PC Suite, ÝÐ ÚÞÜßìîâÕàÕ 
ãáâÐÝÐÒÛØÒÐÕâáï áÞÞâÒÕâáâÒãîéØÙ ÔàÐÙÒÕà ÔÛï 
ÔÐÝÝÞÓÞ ãáâàÞÙáâÒÐ. ÍâÞ ÜÞÖÕâ ×ÐÝïâì ÝÕÚÞâÞàÞÕ 
ÒàÕÜï.

3 ·ÐßãáâØâÕ ßàØÛÞÖÕÝØÕ Nokia Lifeblog ÔÛï 
ÚÞÜßìîâÕàÐ.

¿ÞàïÔÞÚ ãáâÐÝÞÒÚØ áÞÕÔØÝÕÝØï ÜÕÖÔã ãáâàÞÙáâÒÞÜ 
Ø áÞÒÜÕáâØÜëÜ ÚÞÜßìîâÕàÞÜ á ßÞÜÞéìî âÕåÝÞÛÞÓØØ 
ÑÕáßàÞÒÞÔÝÞÙ áÒï×Ø Bluetooth:
1 ÃÑÕÔØâÕáì Ò âÞÜ, çâÞ ßÐÚÕâ ßàÞÓàÐÜÜ Nokia PC Suite 

ãáâÐÝÞÒÛÕÝ ÝÐ ÚÞÜßìîâÕàÕ.
2 ÃÑÕÔØâÕáì Ò âÞÜ, çâÞ ãáâàÞÙáâÒÞ ÑëÛÞ áÞßàïÖÕÝÞ 

á ÚÞÜßìîâÕàÞÜ çÕàÕ× ÚÐÝÐÛ áÒï×Ø Bluetooth 
á ØáßÞÛì×ÞÒÐÝØÕÜ äãÝÚæØØ Get Connected Ò 
Nokia PC Suite. ÁÜ. àÐ×ÔÕÛ «Nokia PC Suite» ÝÐ áâà. 37 
Ø àãÚÞÒÞÔáâÒÞ ßÞ íÚáßÛãÐâÐæØØ ãáâàÞÙáâÒÐ.
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3 ²ÚÛîçØâÕ äãÝÚæØî áÒï×Ø ßÞ ÚÐÝÐÛã Bluetooth 
ÝÐ ãáâàÞÙáâÒÕ Ø ÝÐ ÚÞÜßìîâÕàÕ. ¿ÞÔàÞÑÝãî 
ØÝäÞàÜÐæØî áÜ. Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ 
ãáâàÞÙáâÒÐ Ø Ò ÔÞÚãÜÕÝâÐæØØ ßÞ ÚÞÜßìîâÕàã.

ºÞßØàÞÒÐÝØÕ ÞÑêÕÚâÞÒ
¿ÞáÛÕ ãáâÐÝÞÒÚØ áÞÕÔØÝÕÝØï ÜÕÖÔã ãáâàÞÙáâÒÞÜ 
Ø áÞÒÜÕáâØÜëÜ ÚÞÜßìîâÕàÞÜ ßÞáàÕÔáâÒÞÜ 
áÞÒÜÕáâØÜÞÓÞ USB-ÚÐÑÕÛï ÔÛï ßÕàÕÔÐçØ ÔÐÝÝëå ØÛØ 
ÚÐÝÐÛÐ áÒï×Ø Bluetooth ÜÞÖÝÞ ÒëßÞÛÝïâì ÚÞßØàÞÒÐÝØÕ 
ÞÑêÕÚâÞÒ ÜÕÖÔã ãáâàÞÙáâÒÞÜ Ø ÚÞÜßìîâÕàÞÜ.

¿ÞàïÔÞÚ ÚÞßØàÞÒÐÝØï ÝÞÒëå ØÛØ Ø×ÜÕÝÕÝÝëå ÞÑêÕÚâÞÒ 
á ãáâàÞÙáâÒÐ ÝÐ ÚÞÜßìîâÕà Ø ÚÞßØàÞÒÐÝØï ÒëÑàÐÝÝëå 
ÞÑêÕÚâÞÒ á ÚÞÜßìîâÕàÐ ÝÐ ãáâàÞÙáâÒÞ:
1 ·ÐßãáâØâÕ ßàØÛÞÖÕÝØÕ Nokia Lifeblog ÝÐ 

ÚÞÜßìîâÕàÕ.
2 ² ßàØÛÞÖÕÝØØ Nokia Lifeblog ÔÛï ÚÞÜßìîâÕàÐ 

ÒëÑÕàØâÕ File > Copy from phone and to Phone.

½ÞÒëÕ ÞÑêÕÚâë ÚÞßØàãîâáï á ãáâàÞÙáâÒÐ ÝÐ ÚÞÜßìîâÕà. 
¾ÑêÕÚâë, ÞâÞÑàÐÖÐÕÜëÕ Ò ÞÚÝÕ To phone ÝÐ 
ÚÞÜßìîâÕàÕ, ÚÞßØàãîâáï ÝÐ ãáâàÞÙáâÒÞ.

¿ãÑÛØÚÐæØï Ò ¸ÝâÕàÝÕâÕ
´Ûï áÞÒÜÕáâÝÞÓÞ ØáßÞÛì×ÞÒÐÝØï áÐÜëå ÛãçèØå 
ÞÑêÕÚâÞÒ Nokia Lifeblog ÞâßàÐÒìâÕ Øå Ò ÒÕÑ-ÖãàÝÐÛ 

Ò ¸ÝâÕàÝÕâÕ, çâÞÑë ÔàãÓØÕ ßÞÛì×ÞÒÐâÕÛØ áÜÞÓÛØ 
Øå ãÒØÔÕâì.

¿àÕÖÔÕ ÒáÕÓÞ, ÝÕÞÑåÞÔØÜÞ áÞ×ÔÐâì ãçÕâÝãî ×ÐßØáì 
á ßÞÜÞéìî ãáÛãÓØ ÒÕÑ-ÖãàÝÐÛÐ, áÞ×ÔÐâì ÞÔØÝ ØÛØ 
ÝÕáÚÞÛìÚÞ ÒÕÑ-ÖãàÝÐÛÞÒ, ÚÞâÞàëÕ ÑãÔãâ 
ØáßÞÛì×ÞÒÐâìáï ÚÐÚ æÕÛÕÒÞÕ ÜÕáâÞ àÐáßÞÛÞÖÕÝØï 
²ÐèØå ßãÑÛØÚÐæØÙ, Ø ÔÞÑÐÒØâì ãçÕâÝãî ×ÐßØáì ÒÕÑ-
ÖãàÝÐÛÐ Ò ßàØÛÞÖÕÝØÕ Nokia Lifeblog. ÀÕÚÞÜÕÝÔãÕÜÐï 
áÛãÖÑÐ ÒÕÑ-ÖãàÝÐÛÐ ÔÛï ßàØÛÞÖÕÝØï Nokia Lifeblog – 
íâÞ áÛãÖÑÐ TypePad ÚÞÜßÐÝØØ Six Apart, 
àÐáßÞÛÞÖÕÝÝÐï ßÞ ÐÔàÕáã www.typepad.com.

½Ð ãáâàÞÙáâÒÕ: ÔÞÑÐÒìâÕ ãçÕâÝãî ×ÐßØáì ÒÕÑ-ÖãàÝÐÛÐ 
Ò ÝÐáâàÞÙÚÐå ßàØÛÞÖÕÝØï Nokia Lifeblog. ½Ð 
ÚÞÜßìîâÕàÕ: Ø×ÜÕÝØâÕ ãçÕâÝëÕ ×ÐßØáØ Ò ÞÚÝÕ 
Edit log accounts.

¿ÞàïÔÞÚ ßãÑÛØÚÐæØØ Ò ¸ÝâÕàÝÕâÕ ÞÑêÕÚâÞÒ 
á ãáâàÞÙáâÒÐ:
1 ² ßÐßÚÕ Timeline ØÛØ Favourites ÒëÑÕàØâÕ ÞÑêÕÚâë, 

ÚÞâÞàëÕ ÝÕÞÑåÞÔØÜÞ ÞßãÑÛØÚÞÒÐâì Ò ¸ÝâÕàÝÕâÕ.
2 ²ëÑÕàØâÕ ÄãÝÚæØØ > Post to Web.
3 µáÛØ äãÝÚæØï ØáßÞÛì×ãÕâáï ÒßÕàÒëÕ, ßàØÛÞÖÕÝØÕ 

Nokia Lifeblog ßÞÛãçÐÕâ áßØáÞÚ ×ÐßØáÕÙ 
ÒÕÑ-ÖãàÝÐÛÐ á áÕàÒÕàÐ, ÝÐ ÚÞâÞàÞÜ åàÐÝØâáï 
ÒÕÑ-ÖãàÝÐÛ.

4 ¾âÚàëÒÐÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ ßãÑÛØÚÐæØØ 
ÒÕÑ-ÖãàÝÐÛÐ. ²ëÑÕàØâÕ ÒÕÑ-ÖãàÝÐÛ, ÚÞâÞàëÙ 
áÛÕÔãÕâ ØáßÞÛì×ÞÒÐâì, Ø× áßØáÚÐ Post to:. 
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µáÛØ ÑëÛØ áÞ×ÔÐÝë ÝÞÒëÕ ÒÕÑ-ÖãàÝÐÛë, ÔÛï 
ÞÑÝÞÒÛÕÝØï áßØáÚÐ ÒÕÑ-ÖãàÝÐÛÞÒ ÒëÑÕàØâÕ 
ÄãÝÚæØØ > Refresh blog list. 

5 ²ÒÕÔØâÕ ×ÐÓÞÛÞÒÞÚ Ø áÞßàÞÒÞÔØâÕÛìÝãî 
ØÝäÞàÜÐæØî ÔÛï ßãÑÛØÚÐæØØ. ² ßÞÛÕ ÞáÝÞÒÝÞÓÞ 
âÕÚáâÐ ÜÞÖÝÞ âÐÚÖÕ ÒÒÕáâØ ÑÞÛÕÕ ßÞÔàÞÑÝãî 
ØÝäÞàÜÐæØî ØÛØ ÞßØáÐÝØÕ.

6 ¿ÞáÛÕ âÞÓÞ, ÚÐÚ ÒáÕ ÑãÔÕâ ÓÞâÞÒÞ, ÒëÑÕàØâÕ 
ÄãÝÚæØØ > ¿ÕàÕÔÐâì.

¿ÞàïÔÞÚ ßãÑÛØÚÐæØØ Ò ¸ÝâÕàÝÕâÕ ÞÑêÕÚâÞÒ 
á ÚÞÜßìîâÕàÐ:
1 ² ßÐßÚÕ Timeline ØÛØ Favourites ÒëÑÕàØâÕ ÞÑêÕÚâë 

(ÜÐÚáØÜãÜ 50), ÚÞâÞàëÕ ÝÕÞÑåÞÔØÜÞ ÞßãÑÛØÚÞÒÐâì 
Ò ¸ÝâÕàÝÕâÕ.

2 ²ëÑÕàØâÕ File > Post to the Web.... ¾âÚàÞÕâáï ÞÚÝÞ 
Post to the Web.

3 ²ÒÕÔØâÕ ×ÐÓÞÛÞÒÞÚ Ø áÞßàÞÒÞÔØâÕÛìÝãî 
ØÝäÞàÜÐæØî ÔÛï ßãÑÛØÚÐæØØ. ² ßÞÛÕ ÞáÝÞÒÝÞÓÞ 
âÕÚáâÐ ÜÞÖÝÞ âÐÚÖÕ ÒÒÕáâØ ÑÞÛÕÕ ßÞÔàÞÑÝãî 
ØÝäÞàÜÐæØî ØÛØ ÞßØáÐÝØÕ.

4 ²ëÑÕàØâÕ ÒÕÑ-ÖãàÝÐÛ, ÚÞâÞàëÙ áÛÕÔãÕâ 
ØáßÞÛì×ÞÒÐâì, Ø× áßØáÚÐ Post to:.

5 ¿ÞáÛÕ âÞÓÞ, ÚÐÚ ÒáÕ ÑãÔÕâ ÓÞâÞÒÞ, éÕÛÚÝØâÕ 
ÚÝÞßÚã Send.

¸ÜßÞàâ ÞÑêÕÚâÞÒ Ø× ÔàãÓØå 
ØáâÞçÝØÚÞÒ
ºàÞÜÕ Ø×ÞÑàÐÖÕÝØÙ Ò äÞàÜÐâÕ .jpeg, áÞ×ÔÐÝÝëå 
á ßÞÜÞéìî ãáâàÞÙáâÒ ÔÛï àÐÑÞâë á Ø×ÞÑàÐÖÕÝØïÜØ, 
Ò ßàØÛÞÖÕÝØÕ Nokia Lifeblog ÜÞÖÝÞ âÐÚÖÕ 
ØÜßÞàâØàÞÒÐâì Ø×ÞÑàÐÖÕÝØï Ò äÞàÜÐâÕ .jpeg Ø .3gp, 
Ð âÐÚÖÕ ÒØÔÕÞÚÛØßë Ò äÞàÜÐâÕ .mp4, ×ÒãÚÞÒëÕ äÐÙÛë 
Ò äÞàÜÐâÕ .amr Ø âÕÚáâÞÒëÕ äÐÙÛë Ò äÞàÜÐâÕ .txt 
Ø× ÔàãÓØå ØáâÞçÝØÚÞÒ (âÐÚØå ÚÐÚ ÚÞÜßÐÚâ-ÔØáÚØ, 
DVD-ÔØáÚØ ØÛØ ßÐßÚØ ÝÐ ÖÕáâÚÞÜ ÔØáÚÕ).

¿ÞàïÔÞÚ ØÜßÞàâÐ Ø×ÞÑàÐÖÕÝØÙ ØÛØ ÒØÔÕÞ×ÐßØáÕÙ 
á áÞÒÜÕáâØÜÞÓÞ ÚÞÜßìîâÕàÐ Ò ßàØÛÞÖÕÝØÕ Nokia 
Lifeblog ÔÛï ÚÞÜßìîâÕàÐ:
1 ² ÞÚÝÕ Timeline ØÛØ Favourites ÒëÑÕàØâÕ File > 

Import from PC.... ¾âÚàÞÕâáï ÞÚÝÞ Import.
2 ¿àÞáÜÞâàØâÕ áßØáÞÚ, çâÞÑë ÝÐÙâØ äÐÙÛ 

á Ø×ÞÑàÐÖÕÝØÕÜ ØÛØ ÒØÔÕÞ×ÐßØáìî, ×ÒãÚÞÒÞÙ ØÛØ 
âÕÚáâÞÒëÙ äÐÙÛ ØÛØ ßÕàÕÙÔØâÕ Ò ÔàãÓØÕ ßÐßÚØ, 
çâÞÑë ÝÐÙâØ äÐÙÛ, ÚÞâÞàëÙ áÛÕÔãÕâ ØÜßÞàâØàÞÒÐâì. 
²ÞáßÞÛì×ãÙâÕáì áßØáÚÞÜ Look in ÔÛï ßàÞáÜÞâàÐ 
ØÝäÞàÜÐæØØ ÝÐ ÔàãÓØå ÔØáÚÐå ØÛØ ãáâàÞÙáâÒÐå.

3 ²ëÑÕàØâÕ ßÐßÚã, äÐÙÛ ØÛØ ÝÕáÚÞÛìÚÞ äÐÙÛÞÒ. 
ÁÞÔÕàÖØÜÞÕ ÜÞÖÝÞ ßÞáÜÞâàÕâì Ò ÞÑÛÐáâØ Preview:.

4 ÉÕÛÚÝØâÕ Open ÔÛï ØÜßÞàâÐ ßÐßÚØ (ÒÚÛîçÐï 
ÒÛÞÖÕÝÝëÕ ßÐßÚØ) ØÛØ ÒëÑàÐÝÝëå äÐÙÛÞÒ.
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¿àÞáÜÞâà Ò ÞÚÝÐå «²àÕÜÕÝÝÐï 
èÚÐÛÐ» Ø «¸×ÑàÐÝÝÞÕ»
¿ÞáÛÕ ×ÐßãáÚÐ ßàØÛÞÖÕÝØï Nokia Lifeblog ÝÐ 
ÚÞÜßìîâÕàÕ ÜÞÖÝÞ ÒÞáßÞÛì×ÞÒÐâìáï ÝÕáÚÞÛìÚØÜØ 
áßÞáÞÑÐÜØ ßÕàÕÜÕéÕÝØï Ò ÞÚÝÐå Timeline Ø Favourites. 
ÁÐÜëÙ ÑëáâàëÙ áßÞáÞÑ – íâÞ ßÕàÕâÐáÚØÒÐÝØÕ ßÞÛ×ãÝÚÐ 
Ø ßÕàÕÔÒØÖÕÝØÕ ÒßÕàÕÔ ØÛØ ÝÐ×ÐÔ, ÑëáâàÞ ØÛØ 
ÜÕÔÛÕÝÝÞ. ºàÞÜÕ íâÞÓÞ, ÜÞÖÝÞ éÕÛÚÝãâì èÚÐÛã 
ÒàÕÜÕÝØ, çâÞÑë ÒëÑàÐâì ÔÐâã, ÒÞáßÞÛì×ÞÒÐâìáï 
äãÝÚæØÕÙ Go to date... ØÛØ ÚÛÐÒØèÐÜØ-áâàÕÛÚÐÜØ.

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
´Ûï ßÞÛãçÕÝØï ÔÞßÞÛÝØâÕÛìÝÞÙ ØÝäÞàÜÐæØØ 
ÞÑ ãáÛãÓÐå ÒÕÑ-ÖãàÝÐÛÐ Ø Øå áÞÒÜÕáâØÜÞáâØ 
á ßàØÛÞÖÕÝØÕÜ Nokia Lifeblog ßÞáÕâØâÕ áâàÐÝØæã 
Ò ¸ÝâÕàÝÕâÕ ßÞ ÐÔàÕáã www.nokia.com/lifeblog 
ØÛØ ÝÐÖÜØâÕ F1 Ò ßàØÛÞÖÕÝØØ Nokia Lifeblog ÔÛï 
ÚÞÜßìîâÕàÐ, çâÞÑë ÞâÚàëâì áßàÐÒÚã Nokia Lifeblog.

Nokia PC Suite 

Nokia PC Suite – íâÞ ÝÐÑÞà ßàØÛÞÖÕÝØÙ ÔÛï 
ÚÞÜßìîâÕàÐ, ßàÕÔÝÐ×ÝÐçÕÝÝëÙ ÔÛï àÐÑÞâë 
á ãáâàÞÙáâÒÞÜ Nokia N72.

´Ûï ãáâÐÝÞÒÚØ Ø ØáßÞÛì×ÞÒÐÝØï Nokia PC Suite 
ÝÕÞÑåÞÔØÜ ÚÞÜßìîâÕà á ¾Á Microsoft Windows 2000 
ØÛØ XP á ÒÞ×ÜÞÖÝÞáâìî áÒï×Ø á ßÞÜÞéìî USB-ÚÐÑÕÛï 
ÔÛï ßÕàÕÔÐçØ ÔÐÝÝëå ØÛØ ßÞ ÚÐÝÐÛã Bluetooth.

´Ûï àÐÑÞâë á ßÐÚÕâÞÜ Nokia PC Suite ÝÕÞÑåÞÔØÜÞ 
ãáâÐÝÞÒØâì ÕÓÞ ÝÐ ÚÞÜßìîâÕàÕ. ´ÞßÞÛÝØâÕÛìÝãî 
ØÝäÞàÜÐæØî áÜ. ÝÐ ÚÞÜßÐÚâ-ÔØáÚÕ.

¿ÞÛÝÞÕ àãÚÞÒÞÔáâÒÞ ßÞ íÚáßÛãÐâÐæØØ Nokia PC Suite 
ÝÐåÞÔØâáï ÝÐ ÚÞÜßÐÚâ-ÔØáÚÕ Ò íÛÕÚâàÞÝÝÞÜ äÞàÜÐâÕ.

¿ÞÔÚÛîçÕÝØÕ ãáâàÞÙáâÒÐ 
Ú ÚÞÜßìîâÕàã
¼ÐáâÕà ÝÐáâàÞÙÚØ ßÞÔÚÛîçÕÝØï ßÞ×ÒÞÛïÕâ 
ßÞÔÚÛîçÐâì ãáâàÞÙáâÒÞ Ú áÞÒÜÕáâØÜÞÜã ÚÞÜßìîâÕàã. 
¿Þ ×ÐÒÕàèÕÝØØ ÒáÕå íâÐßÞÒ ÝÐáâàÞÙÚØ 
ãáâÐÝÐÒÛØÒÐÕâáï áÞÕÔØÝÕÝØÕ ÜÕÖÔã ãáâàÞÙáâÒÞÜ 
Ø ÚÞÜßìîâÕàÞÜ, ßÞ×ÒÞÛïîéÕÕ ×ÐßãáÚÐâì ßàØÛÞÖÕÝØï 
Nokia PC Suite, ÔÛï àÐÑÞâë ÚÞâÞàëå âàÕÑãÕâáï 
ßÞÔÚÛîçÕÝØÕ Ú ÚÞÜßìîâÕàã.
1 ÃáâÐÝÞÒØâÕ Nokia PC Suite. ¼ÐáâÕà ÝÐáâàÞÙÚØ 

ßÞÔÚÛîçÕÝØï ÞâÚàëÒÐÕâáï ÐÒâÞÜÐâØçÕáÚØ.
2 ²ëÑÕàØâÕ âØß ØáßÞÛì×ãÕÜÞÓÞ ßÞÔÚÛîçÕÝØï 

ÔÛï áÞÕÔØÝÕÝØï ãáâàÞÙáâÒÐ á ÚÞÜßìîâÕàÞÜ.
3 ´Ûï ßÞÔÚÛîçÕÝØï ãáâàÞÙáâÒÐ Ú ÚÞÜßìîâÕàã 

áÛÕÔãÙâÕ ÒëÒÞÔØÜëÜ ÝÐ íÚàÐÝ ØÝáâàãÚæØïÜ.
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ÇâÞÑë ÞâÚàëâì ÜÐáâÕà ÝÐáâàÞÙÚØ ßÞÔÚÛîçÕÝØï ßÞ×ÖÕ 
(ÝÐßàØÜÕà ÔÛï ÝÐáâàÞÙÚØ ÔàãÓÞÓÞ âØßÐ ßÞÔÚÛîçÕÝØï) 
ÒëÑÕàØâÕ Get Connected Ò Nokia PC Suite.

ÁØÝåàÞÝØ×ÐæØï
¿àØÛÞÖÕÝØÕ Nokia PC Sync ßàÕÔÝÐ×ÝÐçÕÝÞ ÔÛï 
áØÝåàÞÝØ×ÐæØØ ÚÞÝâÐÚâÞÒ, ÚÐÛÕÝÔÐàï, áßØáÚÐ ÔÕÛ 
Ø ×ÐÜÕâÞÚ ÜÕÖÔã ãáâàÞÙáâÒÞÜ Ø áÞÒÜÕáâØÜÞÙ ÛØçÝÞÙ 
ØÝäÞàÜÐæØÞÝÝÞÙ áØáâÕÜÞÙ (»¸Á) ÚÞÜßìîâÕàÐ 
Ø ÞÑÕáßÕçÕÝØï ØÔÕÝâØçÝÞáâØ ØÝäÞàÜÐæØØ 
Ò ãáâàÞÙáâÒÕ Ø ÝÐ áÞÒÜÕáâØÜÞÜ ÚÞÜßìîâÕàÕ.
1 ·ÐßãáâØâÕ Nokia PC Suite.
2 ¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú ÚÞÜßìîâÕàã á ßÞÜÞéìî 

áÞÒÜÕáâØÜÞÓÞ USB-ÚÐÑÕÛï ØÛØ ßÞ ÚÐÝÐÛã Bluetooth.
3 ²ëÑÕàØâÕ ÁØÝåàÞÝØ×ÐæØï Ò Nokia PC Suite.

 ¿àØÜÕçÐÝØÕ. ¿àØ ßÕàÒÞÜ ßÞÔÚÛîçÕÝØØ 
×ÐßãáÚÐÕâáï ÜÐáâÕà, ÚÞâÞàëÙ ßÞÜÞÓÐÕâ ÝÐáâàÞØâì 
àÕÖØÜ áØÝåàÞÝØ×ÐæØØ ßÞ ãÜÞÛçÐÝØî.

 ÁÞÒÕâ. ÃáâàÞÙáâÒÞ Ø ÚÞÜßìîâÕà ÜÞÖÝÞ ÝÐáâàÞØâì 
ÔÛï ÒëßÞÛÝÕÝØï ÐÒâÞÜÐâØçÕáÚÞÙ áØÝåàÞÝØ×ÐæØØ 
ÔÐÝÝëå ßàØ ßÞÔÚÛîçÕÝØØ ãáâàÞÙáâÒÐ Ú ÚÞÜßìîâÕàã, 
ÝÐ ÚÞâÞàÞÜ ×ÐßãéÕÝ ßÐÚÕâ Nokia PC Suite.

ÀÕ×ÕàÒÝÞÕ ÚÞßØàÞÒÐÝØÕ 
Ø ÒÞááâÐÝÞÒÛÕÝØÕ
ÀÕ×ÕàÒÝÞÕ ÚÞßØàÞÒÐÝØÕ ÔÐÝÝëå ãáâàÞÙáâÒÐ ØÛØ 
ÒÞááâÐÝÞÒÛÕÝØÕ áÞåàÐÝÕÝÝëå ÔÐÝÝëå á áÞÒÜÕáâØÜÞÓÞ 
ÚÞÜßìîâÕàÐ ÞÑàÐâÝÞ ÝÐ ãáâàÞÙáâÒÞ.
1 ·ÐßãáâØâÕ Nokia PC Suite.
2 ¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú ÚÞÜßìîâÕàã á ßÞÜÞéìî 

áÞÒÜÕáâØÜÞÓÞ USB-ÚÐÑÕÛï ØÛØ ßÞ ÚÐÝÐÛã Bluetooth.
3 ²ëÑÕàØâÕ ÀÕ×ÕàÒÝÞÕ ÚÞßØàÞÒÐÝØÕ 

Ø ÒÞááâÐÝÞÒÛÕÝØÕ Ò Nokia PC Suite.
4 ½Ð áâàÐÝØæÕ ²ëÑÞà ×ÐÔÐçØ ÒëÑÕàØâÕ ÁÞ×ÔÐâì 

àÕ×ÕàÒÝãî ÚÞßØî... ØÛØ ²ÞááâÐÝÞÒØâì ÔÐÝÝëÕ...
5 ÁÛÕÔãÙâÕ ÒëÒÞÔØÜëÜ ÝÐ íÚàÐÝ ØÝáâàãÚæØïÜ.

 ÁÞÒÕâ. ²Þ Ø×ÑÕÖÐÝØÕ ßÞâÕàØ ÔÐÝÝëå 
àÕÚÞÜÕÝÔãÕâáï àÕÓãÛïàÝÞ ÒëßÞÛÝïâì àÕ×ÕàÒÝÞÕ 
ÚÞßØàÞÒÐÝØÕ áÞÔÕàÖØÜÞÓÞ ãáâàÞÙáâÒÐ.

ÁÞåàÐÝÕÝØÕ Ø×ÞÑàÐÖÕÝØÙ 
Ø ÒØÔÕÞÚÛØßÞÒ
¿àØÛÞÖÕÝØÕ Image Store ßÞ×ÒÞÛïÕâ áÞåàÐÝïâì 
Ø×ÞÑàÐÖÕÝØï Ø ÒØÔÕÞÚÛØßë á ãáâàÞÙáâÒÐ ÝÐ 
áÞÒÜÕáâØÜëÙ ÚÞÜßìîâÕà. ¿àØÛÞÖÕÝØÕ ÒëßÞÛÝïÕâ 
ßàÞÒÕàÚã ßÐÜïâØ ãáâàÞÙáâÒÐ Ø ÚÐàâë ßÐÜïâØ ÝÐ 
ÝÐÛØçØÕ ÝÞÒëå Ø×ÞÑàÐÖÕÝØÙ Ø ÒØÔÕÞÚÛØßÞÒ, ÚÞâÞàëÕ 
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ÑëÛØ áÞ×ÔÐÝë á ÜÞÜÕÝâÐ ßÞáÛÕÔÝÕÓÞ áÕÐÝáÐ 
áÞåàÐÝÕÝØï, Ø áÞåàÐÝïÕâ Øå ÝÐ ÚÞÜßìîâÕàÕ.

·ÐÚÞÝÞÜ ÞÑ ÞåàÐÝÕ ÐÒâÞàáÚØå ßàÐÒ ÜÞÓãâ Ñëâì 
ãáâÐÝÞÒÛÕÝë ÞÓàÐÝØçÕÝØï ÝÐ ÚÞßØàÞÒÐÝØÕ, 
ÜÞÔØäØÚÐæØî, ßÕàÕÔÐçã Ø ×ÐÓàã×Úã ÝÕÚÞâÞàëå 
ÚÐàâØÝÞÚ, Üã×ëÚÐÛìÝëå ÚÞÜßÞ×ØæØÙ (Ò âÞÜ çØáÛÕ 
ÜÕÛÞÔØÙ) Ø ÔàãÓØå ÔÐÝÝëå.

1 ·ÐßãáâØâÕ Nokia PC Suite.
2 ¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú ÚÞÜßìîâÕàã á ßÞÜÞéìî 

áÞÒÜÕáâØÜÞÓÞ USB-ÚÐÑÕÛï ØÛØ ßÞ ÚÐÝÐÛã Bluetooth.
3 ²ëÑÕàØâÕ ÁÞåàÐÝÕÝØÕ Ø×ÞÑàÐÖÕÝØÙ Ò Nokia 

PC Suite.
4 ¿àØ ßÕàÒÞÜ ØáßÞÛì×ÞÒÐÝØØ ßàØÛÞÖÕÝØï Image Store 

ÞâÚàëÒÐÕâáï ÜÐáâÕà ÝÐáâàÞÙÚØ. ´Ûï áÞåàÐÝÕÝØï 
äÐÙÛÞÒ á ãáâàÞÙáâÒÐ ÝÐ áÞÒÜÕáâØÜÞÜ ÚÞÜßìîâÕàÕ 
ÝÕÞÑåÞÔØÜÞ ×ÐÒÕàèØâì ÝÐáâàÞÙÚã ßÐàÐÜÕâàÞÒ. 
ÁÛÕÔãÙâÕ ÒëÒÞÔØÜëÜ ÝÐ íÚàÐÝ ØÝáâàãÚæØïÜ.

5 ²ëÑÕàØâÕ ÁÞåàÐÝØâì áÕÙçÐá Ò ÞáÝÞÒÝÞÜ ÞÚÝÕ 
Image Store. ¿àØÛÞÖÕÝØÕ Image Store ÒëßÞÛÝïÕâ 
ßÞØáÚ ÝÞÒëå Ø×ÞÑàÐÖÕÝØÙ Ø ÒØÔÕÞÚÛØßÞÒ, 
áÞ×ÔÐÝÝëå á ÜÞÜÕÝâÐ ßÞáÛÕÔÝÕÓÞ áÕÐÝáÐ 
áÞåàÐÝÕÝØï, Ò ßÐÜïâØ âÕÛÕäÞÝÐ ØÛØ ÝÐ ÚÐàâÕ 
ßÐÜïâØ. ² ×ÐÒØáØÜÞáâØ Þâ âØßÞÒ äÐÙÛÞÒ, 
ÒëÑàÐÝÝëå Ò ÝÐáâàÞÙÚÐå, ÒáÕ ÝÞÒëÕ Ø×ÞÑàÐÖÕÝØï 
ØÛØ ÒØÔÕÞ×ÐßØáØ áÞåàÐÝïîâáï ÝÐ ÚÞÜßìîâÕàÕ.

¿ÕàÕÔÐçÐ ØÝäÞàÜÐæØØ 
Ø Ø×ÞÑàÐÖÕÝØÙ
Á ßÞÜÞéìî ßàØÛÞÖÕÝØï Nokia Phone Browser ÜÞÖÝÞ 
àÐÑÞâÐâì á áÞÔÕàÖØÜëÜ ßÐßÞÚ ãáâàÞÙáâÒÐ çÕàÕ× 
¿àÞÒÞÔÝØÚ Windows. ¿àÕÔãáÜÞâàÕÝÐ ßÕàÕÔÐçÐ 
ØÝäÞàÜÐæØØ Ø Ø×ÞÑàÐÖÕÝØÙ á ãáâàÞÙáâÒÐ ÝÐ 
áÞÒÜÕáâØÜëÙ ÚÞÜßìîâÕà Ø ÞÑàÐâÝÞ.

·ÐÚÞÝÞÜ ÞÑ ÞåàÐÝÕ ÐÒâÞàáÚØå ßàÐÒ ÜÞÓãâ Ñëâì 
ãáâÐÝÞÒÛÕÝë ÞÓàÐÝØçÕÝØï ÝÐ ÚÞßØàÞÒÐÝØÕ, 
ÜÞÔØäØÚÐæØî, ßÕàÕÔÐçã Ø ×ÐÓàã×Úã ÝÕÚÞâÞàëå 
ÚÐàâØÝÞÚ, Üã×ëÚÐÛìÝëå ÚÞÜßÞ×ØæØÙ (Ò âÞÜ çØáÛÕ 
ÜÕÛÞÔØÙ) Ø ÔàãÓØå ÔÐÝÝëå.

1 ·ÐßãáâØâÕ Nokia PC Suite.
2 ¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú ÚÞÜßìîâÕàã á ßÞÜÞéìî 

áÞÒÜÕáâØÜÞÓÞ USB-ÚÐÑÕÛï ØÛØ ßÞ ÚÐÝÐÛã Bluetooth.
3 ²ëÑÕàØâÕ ¿ÕàÕÔÐçÐ äÐÙÛÞÒ Ò Nokia PC Suite.
4 ² ¿àÞÒÞÔÝØÚÕ Windows ÒëÑÕàØâÕ ¼ÞÙ 

ÚÞÜßìîâÕà > Nokia Phone Browser > Nokia N72.
5 ²ëÑÕàØâÕ ÝÐ ãáâàÞÙáâÒÕ ÒÛÞÖÕÝÝãî ßÐßÚã ÔÛï 

ßàÞáÜÞâàÐ.
 ÁÞÒÕâ. ´Ûï ÞÑÝÞÒÛÕÝØï áÞÔÕàÖØÜÞÓÞ ãáâàÞÙáâÒÐ 

ÒëÑÕàØâÕ View > Refresh.
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¿ÕàÕÔÐçÐ Üã×ëÚØ
¿àØÛÞÖÕÝØÕ Nokia Audio Manager ßàÕÔÝÐ×ÝÐçÕÝÞ ÔÛï 
áÞ×ÔÐÝØï Ø ÞàÓÐÝØ×ÐæØØ æØäàÞÒëå Üã×ëÚÐÛìÝëå 
äÐÙÛÞÒ ÝÐ áÞÒÜÕáâØÜÞÜ ÚÞÜßìîâÕàÕ Ø ßÕàÕÔÐçØ 
íâØå äÐÙÛÞÒ ÝÐ áÞÒÜÕáâØÜÞÕ ãáâàÞÙáâÒÞ, Ð âÐÚÖÕ 
ÔÛï ßÕàÕÔÐçØ á ÞÔÝÞÓÞ ãáâàÞÙáâÒÐ ÝÐ ÔàãÓÞÕ. 

·ÐÚÞÝÞÜ ÞÑ ÞåàÐÝÕ ÐÒâÞàáÚØå ßàÐÒ ÜÞÓãâ Ñëâì 
ãáâÐÝÞÒÛÕÝë ÞÓàÐÝØçÕÝØï ÝÐ ÚÞßØàÞÒÐÝØÕ, 
ÜÞÔØäØÚÐæØî, ßÕàÕÔÐçã Ø ×ÐÓàã×Úã ÝÕÚÞâÞàëå 
ÚÐàâØÝÞÚ, Üã×ëÚÐÛìÝëå ÚÞÜßÞ×ØæØÙ (Ò âÞÜ çØáÛÕ 
ÜÕÛÞÔØÙ) Ø ÔàãÓØå ÔÐÝÝëå.

1 ·ÐßãáâØâÕ Nokia PC Suite.
2 ¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú ÚÞÜßìîâÕàã á ßÞÜÞéìî 

áÞÒÜÕáâØÜÞÓÞ USB-ÚÐÑÕÛï ØÛØ ßÞ ÚÐÝÐÛã Bluetooth.
3 ²ëÑÕàØâÕ ¿ÕàÕÔÐçÐ Üã×ëÚØ Ò Nokia PC Suite.

¿ÞÔÚÛîçÕÝØÕ Ú ¸ÝâÕàÝÕâã
¿àØÛÞÖÕÝØÕ One Touch Access ÐÒâÞÜÐâØçÕáÚØ 
ÒëßÞÛÝïÕâ ÝÐáâàÞÙÚã ÔÞáâãßÐ Ú ÜÞÔÕÜã ÝÐ ÞáÝÞÒÕ 
ØÝäÞàÜÐæØØ, ßÞÛãçÕÝÝÞÙ Þâ ÞßÕàÐâÞàÐ áÞâÞÒÞÙ 
áÕâØ ØÛØ ßÞáâÐÒéØÚÐ ãáÛãÓ (ãáÛãÓÐ áÕâØ). ÁÕâÕÒÞÕ 
ßÞÔÚÛîçÕÝØÕ ÜÞÖÝÞ ÑëáâàÞ ãáâÐÝÞÒØâì, ØáßÞÛì×ãï 
ãáâàÞÙáâÒÞ Ò ÚÐçÕáâÒÕ ÜÞÔÕÜÐ, á ßÞÜÞéìî áÞÕÔØÝÕÝØï 
GPRS áÕâØ GSM.

ÃÑÕÔØâÕáì, çâÞ Ò ãáâàÞÙáâÒÕ ÒÚÛîçÕÝÞ áÞÕÔØÝÕÝØÕ 
Ò àÕÖØÜÕ ßÕàÕÔÐçØ ÔÐÝÝëå. ´ÞßÞÛÝØâÕÛìÝãî 
ØÝäÞàÜÐæØî ÜÞÖÝÞ ßÞÛãçØâì ã ßÞáâÐÒéØÚÐ ãáÛãÓ.

µáÛØ ÝÕÞÑåÞÔØÜÞ ØáßÞÛì×ÞÒÐâì ÜÞÔÕÜ á ßÞÔÔÕàÖÚÞÙ 
âÕåÝÞÛÞÓØØ ÑÕáßàÞÒÞÔÝÞÙ áÒï×Ø Bluetooth, ÔàÐÙÒÕàë 
ÜÞÔÕÜÐ Bluetooth áÛÕÔãÕâ ãáâÐÝÞÒØâì ßÕàÕÔ ×ÐßãáÚÞÜ 
ßàØÛÞÖÕÝØï One Touch Access.

ÃáâÐÝÞÒÚÐ ÜÞÔÕÜÐ
² ßàØÛÞÖÕÝØÕ One Touch Access ÒÚÛîçÕÝ ÜÐáâÕà 
ÝÐáâàÞÙÚØ, ÚÞâÞàëÙ ßÞ×ÒÞÛïÕâ áÚÞÝäØÓãàØàÞÒÐâì 
ÝÐáâàÞÙÚØ ßÞÔÚÛîçÕÝØï. ÁÛÕÔãÙâÕ ÒëÒÞÔØÜëÜ ÝÐ 
íÚàÐÝ ØÝáâàãÚæØïÜ.

ÃáâÐÝÞÒÛÕÝØÕ ÜÞÔÕÜÝÞÓÞ áÞÕÔØÝÕÝØï
1 ·ÐßãáâØâÕ Nokia PC Suite.
2 ¿ÞÔÚÛîçØâÕ âÕÛÕäÞÝ Ú áÞÒÜÕáâØÜÞÜã ÚÞÜßìîâÕàã.
3 ²ëÑÕàØâÕ ¿ÞÔÚÛîçÕÝØÕ Ú ¸ÝâÕàÝÕâã Ò Nokia 

PC Suite.
4 ¿àØÛÞÖÕÝØÕ One Touch Access ãáâÐÝÐÒÛØÒÐÕâ 

ßÞÔÚÛîçÕÝØÕ Ú ¸ÝâÕàÝÕâã çÕàÕ× 10 áÕÚãÝÔ. ´Ûï 
ãáâÐÝÞÒÚØ ßÞÔÚÛîçÕÝØï ÜÞÖÝÞ âÐÚÖÕ ÒëÑàÐâì 
¿ÞÔÚÛîçØâì.
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´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
´Ûï ßÞÛãçÕÝØï ÔÞßÞÛÝØâÕÛìÝÞÙ ØÝäÞàÜÐæØØ Ø ÔÛï 
×ÐÓàã×ÚØ ßÞáÛÕÔÝÕÙ ÒÕàáØØ Nokia PC Suite ßÞáÕâØâÕ 
áâàÐÝØæã www.nokia.com/pcsuite.

¿àØÛÞÖÕÝØÕ Adobe 
Photoshop Album Starter 
Edition 

¿àØÛÞÖÕÝØÕ Adobe Photoshop Album Starter Edition 3.0 
(ßàÕÔÒÐàØâÕÛìÝÐï ÒÕàáØï) ßÞÜÞÓÐÕâ ÞáãéÕáâÒÛïâì 
ßÞØáÚ, àÕâãèØàÞÒÐÝØÕ Ø àÐáßàÞáâàÐÝÕÝØÕ äÞâÞÓàÐäØÙ 
á ßÞÜÞéìî áÞÒÜÕáâØÜÞÓÞ ÚÞÜßìîâÕàÐ. ´ÐÝÝÐï ÒÕàáØï 
ßàØÛÞÖÕÝØï Starter Edition ßÞ×ÒÞÛïÕâ:
• ¸áßÞÛì×ÞÒÐâì ïàÛëÚØ ÔÛï ãßÞàïÔÞçÕÝØï 

äÞâÞÓàÐäØÙ á æÕÛìî ÞÑÛÕÓçÕÝØï Øå ßÞØáÚÐ.
• ¸áßÞÛì×ÞÒÐâì ÞÚÝÞ ßàÞáÜÞâàÐ ÚÐÛÕÝÔÐàï ÔÛï 

æÕÝâàÐÛØ×ÞÒÐÝÝÞÓÞ ßàÞáÜÞâàÐ ÒáÕå æØäàÞÒëå 
äÞâÞÓàÐäØÙ.

• ÃáâàÐÝïâì ÞÑéØÕ ÔÕäÕÚâë äÞâÞÓàÐäØÙ ÞÔÝØÜ 
ÝÐÖÐâØÕÜ.

• ÀÐáßàÞáâàÐÝïâì äÞâÞÓàÐäØØ àÐ×ÛØçÝëÜØ 
áßÞáÞÑÐÜØ: ßÕàÕÔÐÒÐâì ßÞ íÛÕÚâàÞÝÝÞÙ ßÞçâÕ, 
ßÕçÐâÐâì ÔÞÜÐ ØÛØ ÞâßàÐÒÛïâì ÝÐ ÜÞÑØÛìÝëÕ 
ãáâàÞÙáâÒÐ.

 ¿àØÜÕçÐÝØÕ. ÍâÞ ßàØÛÞÖÕÝØÕ àÕÐÛØ×ÞÒÐÝÞ ÝÕ 
ÔÛï ÒáÕå ï×ëÚÞÒ.

ÃáâÐÝÞÒÚÐ
ÃáâÐÝÞÒØâÕ ßàØÛÞÖÕÝØÕ Starter Edition ÔÛï 
ÚÞÜßìîâÕàÐ á ÚÞÜßÐÚâ-ÔØáÚÐ, ÒåÞÔïéÕÓÞ Ò ÚÞÜßÛÕÚâ 
ßÞáâÐÒÚØ ãáâàÞÙáâÒÐ. ´Ûï àÐÑÞâë ßàØÛÞÖÕÝØï Starter 
Edition âàÕÑãÕâáï ÞßÕàÐæØÞÝÝÐï áØáâÕÜÐ Microsoft 
Windows 2000 ØÛØ XP, Nokia PC Suite 6.5 ØÛØ ÑÞÛÕÕ 
ßÞ×ÔÝÕÙ ÒÕàáØØ ÔÛï ÞÑÕáßÕçÕÝØï áÒï×Ø ÜÕÖÔã 
ãáâàÞÙáâÒÞÜ Ø ÚÞÜßìîâÕàÞÜ, Ð âÐÚÖÕ Apple 
QuickTime 6.5.1. ØÛØ ÑÞÛÕÕ ßÞ×ÔÝÕÙ ÒÕàáØØ ÔÛï 
ßàÞáÜÞâàÐ Ø àÕÔÐÚâØàÞÒÐÝØï ÒØÔÕÞÚÛØßÞÒ.

Nokia PC Suite ßÞáâÐÒÛïÕâáï ÝÐ ÚÞÜßÐÚâ-ÔØáÚÕ ÒÜÕáâÕ 
á ãáâàÞÙáâÒÞÜ. µáÛØ Ò áØáâÕÜÕ ÝÕ ãáâÐÝÞÒÛÕÝÞ 
ßàØÛÞÖÕÝØÕ Apple QuickTime, ÕÓÞ ÜÞÖÝÞ ãáâÐÝÞÒØâì 
áÞ áâàÐÝØæë www.apple.com/quicktime/download.

ÁÛÕÔãÙâÕ ÒëÒÞÔØÜëÜ ÝÐ íÚàÐÝ ØÝáâàãÚæØïÜ ßÞ 
ãáâÐÝÞÒÚÕ.

¿ÕàÕÔÐçÐ äÞâÞÓàÐäØÙ 
Ø ÒØÔÕÞÚÛØßÞÒ á ãáâàÞÙáâÒÐ 
ÝÐ ÚÞÜßìîâÕà
ÁãéÕáâÒãîâ ÔÒÐ áßÞáÞÑÐ ßÕàÕÔÐçØ äÞâÞÓàÐäØÙ 
á ãáâàÞÙáâÒÐ Ò ßàØÛÞÖÕÝØÕ Starter Edition.
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¿ÞàïÔÞÚ ÐÒâÞÜÐâØçÕáÚÞÙ ßÕàÕÔÐçØ äÞâÞÓàÐäØÙ 
Ø ÒØÔÕÞÚÛØßÞÒ ÝÐ áÞÒÜÕáâØÜëÙ ÚÞÜßìîâÕà:
1 ¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú áÞÒÜÕáâØÜÞÜã 

ÚÞÜßìîâÕàã ßÞáàÕÔáâÒÞÜ USB-ÚÐÑÕÛï ÔÛï 
ßÕàÕÔÐçØ ÔÐÝÝëå. ½Ð íÚàÐÝÕ ÚÞÜßìîâÕàÐ 
ÞâÚàëÒÐÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ Adobe Photo 
Downloader, Ò ÚÞâÞàÞÜ ÒëÔÕÛÕÝë äÐÙÛë á ÝÞÒëÜØ 
äÞâÞÓàÐäØïÜØ Ø ÒØÔÕÞ×ÐßØáïÜØ, áÔÕÛÐÝÝëÜØ 
ßÞáÛÕ ßÞáÛÕÔÝÕÙ ßÕàÕÔÐçØ.

2 ÇâÞÑë ÝÐçÐâì ßÕàÕÔÐçã, éÕÛÚÝØâÕ Get Photos. 
²áÕ ÒëÑàÐÝÝëÕ äÐÙÛë ØÜßÞàâØàãîâáï 
Ò ßàØÛÞÖÕÝØÕ Starter Edition. °ÛìÑÞÜë, áÞ×ÔÐÝÝëÕ 
Ò ßàØÛÞÖÕÝØØ «³ÐÛÕàÕï» âÕÛÕäÞÝÐ, ÑãÔãâ 
ÐÒâÞÜÐâØçÕáÚØ ßÕàÕÔÐÝë Ò ßàØÛÞÖÕÝØÕ 
Starter Edition Ø ØÔÕÝâØäØæØàÞÒÐÝë ÚÐÚ ïàÛëÚØ.

3 ¿ÞáÛÕ ßÕàÕÔÐçØ äÐÙÛÞÒ Ò ßàØÛÞÖÕÝØÕ 
Starter Edition Øå ÜÞÖÝÞ ãÔÐÛØâì á ãáâàÞÙáâÒÐ.

ÇâÞÑë ÒÚÛîçØâì ØÛØ ÞâÚÛîçØâì ÐÒâÞÜÐâØçÕáÚÞÕ 
ÞâÞÑàÐÖÕÝØÕ ÔØÐÛÞÓÞÒÞÓÞ ÞÚÝÐ Adobe Photo 
Downloader éÕÛÚÝØâÕ ßàÐÒÞÙ ÚÝÞßÚÞÙ ×ÝÐçÞÚ ÝÐ 
ßÐÝÕÛØ ×ÐÔÐç.

¿ÞàïÔÞÚ ßÕàÕÔÐçØ äÞâÞÓàÐäØÙ ÝÐ áÞÒÜÕáâØÜëÙ 
ÚÞÜßìîâÕà ÒàãçÝãî:
1 ¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú áÞÒÜÕáâØÜÞÜã 

ÚÞÜßìîâÕàã ßÞáàÕÔáâÒÞÜ USB-ÚÐÑÕÛï 
ØÛØ ßÞ ÚÐÝÐÛã Bluetooth.

2 ·ÐßãáâØâÕ ßàØÛÞÖÕÝØÕ Starter Edition.

3 ½Ð ßÐÝÕÛØ ááëÛÞÚ éÕÛÚÝØâÕ Get photos > From 
Camera, Mobile Phone ØÛØ Card Reader. ¾âÚàÞÕâáï 
ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ Adobe Photo Downloader.

4 ÉÕÛÚÝØâÕ Get Photos ÔÛï ÝÐçÐÛÐ ßÕàÕÔÐçØ. ²áÕ 
ÒëÑàÐÝÝëÕ äÐÙÛë ØÜßÞàâØàãîâáï Ò ßàØÛÞÖÕÝØÕ 
Starter Edition. °ÛìÑÞÜë, áÞ×ÔÐÝÝëÕ Ò ßàØÛÞÖÕÝØØ 
«³ÐÛÕàÕï» âÕÛÕäÞÝÐ, ÑãÔãâ ÐÒâÞÜÐâØçÕáÚØ ßÕàÕÔÐÝë 
Ò ßàØÛÞÖÕÝØÕ Starter Edition Ø ØÔÕÝâØäØæØàÞÒÐÝë 
ÚÐÚ ïàÛëÚØ. 

5 ¿ÞáÛÕ ßÕàÕÔÐçØ äÐÙÛÞÒ Ò ßàØÛÞÖÕÝØÕ 
Starter Edition Øå ÜÞÖÝÞ ãÔÐÛØâì á ãáâàÞÙáâÒÐ.

¿ÕàÕÔÐçÐ äÞâÞÓàÐäØÙ 
Ø ÒØÔÕÞÚÛØßÞÒ á ÚÞÜßìîâÕàÐ 
ÝÐ ãáâàÞÙáâÒÞ
¿ÞàïÔÞÚ ßÕàÕÔÐçØ Ø×ÜÕÝÕÝÝëå äÞâÞÓàÐäØÙ 
Ø ÒØÔÕÞÚÛØßÞÒ ÞÑàÐâÝÞ ÝÐ ãáâàÞÙáâÒÞ:
1 ¿ÞÔÚÛîçØâÕ ãáâàÞÙáâÒÞ Ú áÞÒÜÕáâØÜÞÜã 

ÚÞÜßìîâÕàã ßÞáàÕÔáâÒÞÜ USB-ÚÐÑÕÛï ØÛØ ßÞ 
ÚÐÝÐÛã Bluetooth.

2 ·ÐßãáâØâÕ ßàØÛÞÖÕÝØÕ Starter Edition.
3 ²ëÑÕàØâÕ äÞâÞÓàÐäØØ Ø ÒØÔÕÞ×ÐßØáØ, ÚÞâÞàëÕ 

ÝÕÞÑåÞÔØÜÞ ßÕàÕÔÐâì ÝÐ ãáâàÞÙáâÒÞ.
4 ÉÕÛÚÝØâÕ Share ÝÐ ßÐÝÕÛØ ááëÛÞÚ Ø ÒëÑÕàØâÕ 

Send to Mobile Phone.
5 ½ÐÖÜØâÕ OK.
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¿àÞáÜÞâà äÞâÞÓàÐäØÙ ÒÞ ÒÕáì íÚàÐÝ
¿àÞáÜÞâà äÞâÞÓàÐäØÙ ÒÞ ÒÕáì íÚàÐÝ, Ð âÐÚÖÕ Øå 
ßÞÒÞàÞâ, àÕâãèØàÞÒÐÝØÕ Ø ÞâÜÕâÚÐ ÔÛï ßÕçÐâØ.

¿ÞàïÔÞÚ ßàÞáÜÞâàÐ äÞâÞÓàÐäØÙ ÒÞ ÒÕáì íÚàÐÝ:
1 ²ëÑÕàØâÕ äÞâÞÓàÐäØØ.
2 ² ÜÕÝî File ÒëÑÕàØâÕ View > Full Screen Slideshow. 

½ÐçØÝÐÕâáï ßÞÚÐ× áÛÐÙÔÞÒ.
3 ÇâÞÑë ßÞÒÕàÝãâì, ÞâàÕâãèØàÞÒÐâì Ø ÞâÜÕâØâì 

äÞâÞÓàÐäØØ ÔÛï ßÕçÐâØ, á ßÞÜÞéìî ÜëèØ 
ÒëÑÕàØâÕ ×ÝÐçÚØ Ò ÝØÖÝÕÙ çÐáâØ íÚàÐÝÐ.

¿ÕàÕÔÐçÐ äÞâÞÓàÐäØÙ ßÞ 
íÛÕÚâàÞÝÝÞÙ ßÞçâÕ ÔÛï 
áÞÒÜÕáâÝÞÓÞ ØáßÞÛì×ÞÒÐÝØï
ÀÐ×ÜÕà äÐÙÛÞÒ á äÞâÞÓàÐäØïÜØ 
Ø ßÞáÛÕÔÞÒÐâÕÛìÝÞáâïÜØ áÛÐÙÔÞÒ ÐÒâÞÜÐâØçÕáÚØ 
ãÜÕÝìèÐÕâáï, ÚÞÓÔÐ ÞÝØ ßÕàÕÔÐîâáï Ò ÚÐçÕáâÒÕ 
ÒÛÞÖÕÝØÙ íÛÕÚâàÞÝÝÞÙ ßÞçâë Ò ßàØÛÞÖÕÝØØ 
Starter Edition.

¿ÞàïÔÞÚ ßÕàÕÔÐçØ äÞâÞÓàÐäØÙ Ø ßÞáÛÕÔÞÒÐâÕÛìÝÞáâÕÙ 
áÛÐÙÔÞÒ ßÞ íÛÕÚâàÞÝÝÞÙ ßÞçâÕ:
1 ²ëÑÕàØâÕ äÞâÞÓàÐäØØ.
2 ½Ð ßÐÝÕÛØ ááëÛÞÚ ÒëÑÕàØâÕ Share > Email.

3 µáÛØ äÞâÞÓàÐäØØ ØÛØ áÛÐÙÔë ßÕàÕÔÐîâáï ßÞ 
íÛÕÚâàÞÝÝÞÙ ßÞçâÕ ÒßÕàÒëÕ, ÝÕÞÑåÞÔØÜÞ ÒëÑàÐâì 
ÚÛØÕÝâáÚÞÕ ßàØÛÞÖÕÝØÕ íÛÕÚâàÞÝÝÞÙ ßÞçâë. 
¿àØ ßÞáÛÕÔãîéÕÙ ÞÑàÐÑÞâÚÕ ßÞçâÞÒÞÙ 
ÚÞààÕáßÞÝÔÕÝæØØ ßàØÛÞÖÕÝØÕÜ Starter Edition 
ÑãÔÕâ ØáßÞÛì×ÞÒÐâìáï ÒëÑàÐÝÝÞÕ ÚÛØÕÝâáÚÞÕ 
ßàØÛÞÖÕÝØÕ.

4 ²ëÑÕàØâÕ, ÚÐÚ áÛÕÔãÕâ ÞâßàÐÒÛïâì äÞâÞÓàÐäØØ – 
Ò ÒØÔÕ ßÞáÛÕÔÞÒÐâÕÛìÝÞáâØ áÛÐÙÔÞÒ ØÛØ Ò ÒØÔÕ 
ÞâÔÕÛìÝëå ÒÛÞÖÕÝØÙ.

5 ½ÐÖÜØâÕ OK. ¾âÚàÞÕâáï ÞÚÝÞ á áÞÞÑéÕÝØÕÜ 
íÛÕÚâàÞÝÝÞÙ ßÞçâë.

¿ÕçÐâì äÞâÞÓàÐäØÙ
¿ÕçÐâì ÒëáÞÚÞÚÐçÕáâÒÕÝÝëå äÞâÞÓàÐäØÙ ÛîÑÞÓÞ 
äÞàÜÐâÐ.
1 ²ëÑÕàØâÕ äÞâÞÓàÐäØØ.
2 ²ëÑÕàØâÕ Print ÝÐ ßÐÝÕÛØ ááëÛÞÚ Ø ÒëÑÕàØâÕ Print 

Ò ÜÕÝî.
3 ²ëÑÕàØâÕ äÞàÜÐâ Ø àÐ×ÜÕà.
4 ÉÕÛÚÝØâÕ Print.
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ÃßÞàïÔÞçÕÝØÕ Ø ßÞØáÚ äÞâÞÓàÐäØÙ 
ßÞ ÔÐâÕ
¿àØÛÞÖÕÝØÕ Starter Edition ÐÒâÞÜÐâØçÕáÚØ 
ãßÞàïÔÞçØÒÐÕâ äÞâÞÓàÐäØØ ßÞ ÔÐâÕ, çâÞ ãßàÞéÐÕâ 
Øå ßÞØáÚ.

ÁãéÕáâÒãîâ ÔÒÐ áßÞáÞÑÐ ßÞØáÚÐ äÞâÞÓàÐäØÙ ßÞ ÔÐâÕ: 
Ò ÞÚÝÕ äÞâÞÐÛìÑÞÜÐ Ø Ò ÞÚÝÕ ÚÐÛÕÝÔÐàï.

¿ÞàïÔÞÚ ßÞØáÚÐ äÞâÞÓàÐäØÙ Ò äÞâÞÐÛìÑÞÜÕ:
1 ²ëÑÕàØâÕ Photo Well ÝÐ ßÐÝÕÛØ ááëÛÞÚ.
2 ½Ð ÒàÕÜÕÝÝÞÙ èÚÐÛÕ ßÞÔ ßÐÝÕÛìî ááëÛÞÚ 

ÒëÑÕàØâÕ ÜÕáïæ ÔÛï äÞâÞÓàÐäØÙ, ÚÞâÞàëÕ 
ÝÕÞÑåÞÔØÜÞ ßÞáÜÞâàÕâì. ÄÞâÞÓàÐäØØ, áÔÕÛÐÝÝëÕ 
Ò íâÞÜ ÜÕáïæÕ, ÞâÞÑàÐÖÐîâáï Ò äÞâÞÐÛìÑÞÜÕ.

¿ÞàïÔÞÚ ßÞØáÚÐ ßÞØáÚÐ äÞâÞÓàÐäØÙ Ò ÞÚÝÕ ÚÐÛÕÝÔÐàï:
1 ²ëÑÕàØâÕ Calendar View ÝÐ ßÐÝÕÛØ ááëÛÞÚ.
2 ² ÞÚÝÕ ßàÞáÜÞâàÐ ÚÐÛÕÝÔÐàï ÒëÑÕàØâÕ ÔÕÝì, 

çâÞÑë ßÞáÜÞâàÕâì ÒáÕ äÞâÞÓàÐäØØ, áÔÕÛÐÝÝëÕ 
Ò íâÞâ ÔÕÝì.

3 ¿ÕàÕåÞÔ Þâ ÜÕáïæÐ Ú ÜÕáïæã ÞáãéÕáâÒÛïÕâáï 
á ßÞÜÞéìî ÚÝÞßÞÚ áÞ áâàÕÛÚÐÜØ, àÐáßÞÛÞÖÕÝÝëå 
ÒÒÕàåã ÚÐÛÕÝÔÐàï.

ÃßÞàïÔÞçÕÝØÕ Ø ßÞØáÚ äÞâÞÓàÐäØÙ 
ßÞ ïàÛëÚÐÜ
´Ûï ßÞØáÚÐ äÞâÞÓàÐäØÙ ßÞ ×ÐßÕçÐâÛÕÝÝëÜ ÝÐ 
ÝØå ÛîÔïÜ, ÜÕáâÐÜ, áÞÑëâØïÜ ØÛØ ßÞ ÔàãÓØÜ 
åÐàÐÚâÕàØáâØÚÐÜ ØáßÞÛì×ãÙâÕ ïàÛëÚØ á ÚÛîçÕÒëÜØ 
áÛÞÒÐÜØ. ¿àØ áÞ×ÔÐÝØØ ïàÛëÚÐ äÞâÞÓàÐäØØ ÝÕ 
âàÕÑãÕâáï ßÞÜÝØâì ØÜï äÐÙÛÐ ØÛØ ßÐßÚØ ÔÛï ÚÐÖÔÞÙ 
äÞâÞÓàÐäØØ.

½ÐÖÜØâÕ ÃßÞàïÔÞçØâì ÝÐ ßÐÝÕÛØ ááëÛÞÚ ÔÛï ÞâÚàëâØï 
ßÐÝÕÛØ ÏàÛëÚØ.

¿ÞàïÔÞÚ áÞ×ÔÐÝØï áÞÑáâÒÕÝÝÞÓÞ ïàÛëÚÐ:
1 ÉÕÛÚÝØâÕ New Ò ÞÑÛÐáâØ Tag Ø ÒëÑÕàØâÕ New Tag.
2 ² ÔØÐÛÞÓÞÒÞÜ ÞÚÝÕ ÁÞ×ÔÐâì ïàÛëÚ ØáßÞÛì×ãÙâÕ 

ÜÕÝî ºÐâÕÓÞàØï ÔÛï ÒëÑÞàÐ ßÞÔÚÐâÕÓÞàØØ, 
Ú ÚÞâÞàÞÙ âàÕÑãÕâáï ÞâÝÕáâØ íâÞâ ïàÛëÚ.

3 ² âÕÚáâÞÒÞÜ ßÞÛÕ Name ÒÒÕÔØâÕ ØÜï, ÚÞâÞàÞÕ 
áÛÕÔãÕâ ßàØáÒÞØâì ïàÛëÚã.

4 ² âÕÚáâÞÒÞÜ ßÞÛÕ Note ÒÒÕÔØâÕ ÛîÑãî ØÝäÞàÜÐæØî 
Þ ïàÛëÚÕ.

5 ½ÐÖÜØâÕ OK.

ÏàÛëÚ ÞâÞÑàÐÖÐÕâáï Ò ÞÑÛÐáâØ Tag ßÞÔ ÒëÑàÐÝÝÞÙ 
ÚÐâÕÓÞàØÕÙ ØÛØ ßÞÔÚÐâÕÓÞàØÕÙ.

´Ûï ÒÛÞÖÕÝØï ïàÛëÚÐ Ò äÞâÞÓàÐäØî ßÕàÕÜÕáâØâÕ 
ïàÛëÚ Ø× ÞÑÛÐáâØ Tag ÝÐ äÞâÞÓàÐäØî Ò äÞâÞÐÛìÑÞÜÕ.
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´Ûï ßÞØáÚÐ äÞâÞÓàÐäØÙ ÔÒÐÖÔë éÕÛÚÝØâÕ ïàÛëÚ 
Ò ÞÑÛÐáâØ Tag; ÒëßÞÛÝïÕâáï ßÞØáÚ ÒáÕå äÞâÞÓàÐäØÙ, 
Ò ÚÞâÞàëÕ ÒÛÞÖÕÝ íâÞâ ÚÞÝÚàÕâÝëÙ ïàÛëÚ.

´Ûï áãÖÕÝØï ÔØÐßÐ×ÞÝÐ ßÞØáÚÐ äÞâÞÓàÐäØÙ Ø ßÕàÕåÞÔÐ 
Ú ÚÞÝÚàÕâÝÞÜã ÜÕáïæã éÕÛÚÝØâÕ ßÞÛ×ãÝÞÚ ÝÐ 
ÒàÕÜÕÝÝÞÙ èÚÐÛÕ. 

µáÛØ áÞ×ÔÐÕâáï ÝÞÒëÙ ÐÛìÑÞÜ ÝÐ ãáâàÞÙáâÒÕ, Ò ÐÛìÑÞÜ 
ÔÞÑÐÒÛïîâáï äÞâÞÓàÐäØØ Ø ÒëßÞÛÝïÕâáï ßÕàÕÔÐçÐ 
äÞâÞÓàÐäØÙ Ò ßàØÛÞÖÕÝØÕ Starter Edition, ØÝäÞàÜÐæØï 
ÐÛìÑÞÜÐ ÞâÞÑàÐÖÐÕâáï Ò ÒØÔÕ ÝÞÒÞÓÞ ïàÛëÚÐ ßÞÔ 
×ÐÓÞÛÞÒÚÞÜ Imported tags.

ÀÕâãèØàÞÒÐÝØÕ äÞâÞÓàÐäØÙ
¿àØÛÞÖÕÝØÕ Starter Edition áÞÔÕàÖØâ ØÝáâàãÜÕÝâë ÔÛï 
ãáâàÐÝÕÝØï ÝÐØÑÞÛÕÕ àÐáßàÞáâàÐÝÕÝÝëå ÔÕäÕÚâÞÒ 
äÞâÞÓàÐäØÙ. 

¿ÞàïÔÞÚ àÕâãèØàÞÒÐÝØï äÞâÞÓàÐäØÙ:
1 ²ëÑÕàØâÕ äÞâÞÓàÐäØî Ò äÞâÞÐÛìÑÞÜÕ.
2 ÉÕÛÚÝØâÕ Fix photo ÝÐ ßÐÝÕÛØ ááëÛÞÚ. ¿àØÛÞÖÕÝØÕ 

Starter Edition áÞ×ÔÐÕâ ÚÞßØî ØáåÞÔÝÞÙ äÞâÞÓàÐäØØ 
ÔÛï Ø×ÜÕÝÕÝØï.
´Ûï ÐÒâÞÜÐâØçÕáÚÞÓÞ àÕâãèØàÞÒÐÝØï äÞâÞÓàÐäØÙ 
ÒëÑÕàØâÕ Auto Smart Fix.
´Ûï àÕâãèØàÞÒÐÝØï äÞâÞÓàÐäØÙ ÒàãçÝãî ÒëÑÕàØâÕ 
Fix Photo Window... Ø ÞÔÝã Ø× áÛÕÔãîéØå ÝÐáâàÞÕÚ: 

General – ÐÒâÞÜÐâØçÕáÚÐï ÚÞààÕÚæØï æÒÕâÐ, 
ãàÞÒÝÕÙ æÒÕâÞßÕàÕÔÐçØ, ÚÞÝâàÐáâÝÞáâØ ØÛØ 
àÕ×ÚÞáâØ.
Crop – ÒëàÕ×ÐÝØÕ äÞâÞÓàÐäØØ ÔÛï ãÛãçèÕÝØï 
ÚÞÜßÞ×ØæØØ ØÛØ ßÞÒëèÕÝØï ÒëàÐ×ØâÕÛìÝÞáâØ 
Ø×ÞÑàÐÖÕÝØï.
Red Eye – ãáâàÐÝÕÝØÕ íääÕÚâÐ «ÚàÐáÝëå ÓÛÐ×», 
ÒÞ×ÝØÚÐîéÕÓÞ ßàØ ØáßÞÛì×ÞÒÐÝØØ ÒáßëèÚØ.

²ÞáßàÞØ×ÒÕÔÕÝØÕ Ø Ø×ÜÕÝÕÝØÕ 
ÒØÔÕÞ×ÐßØáÕÙ
´Ûï ÒÞáßàÞØ×ÒÕÔÕÝØï ÒØÔÕÞ×ÐßØáÕÙ ÔÒÐÖÔë éÕÛÚÝØâÕ 
äÐÙÛ á ÒØÔÕÞ×ÐßØáìî, ×ÐâÕÜ éÕÛÚÝØâÕ Play ßÞÔ ÞÚÝÞÜ 
ÒÞáßàÞØ×ÒÕÔÕÝØï ÒØÔÕÞ.

¿ÞàïÔÞÚ Ø×ÜÕÝÕÝØï, ßÕàÕãßÞàïÔÞçÕÝØï Ø ãÔÐÛÕÝØï 
áîÖÕâÞÒ Ò ÒØÔÕÞäØÛìÜÐå:
1 ÉÕÛÚÝØâÕ ßàÐÒÞÙ ÚÝÞßÚÞÙ äÐÙÛ á äØÛìÜÞÜ 

Ø ÒëÑÕàØâÕ Edit Mobile Movie. ² ÞÚÝÕ ßàÞáÜÞâàÐ 
ÒØÔÕÞ ßÞïÒØâáï ßÕàÒëÙ ÚÐÔà ÒØÔÕÞÚÛØßÐ. ÁØÝØÙ 
ÜÐàÚÕà ÝÐ ÒàÕÜÕÝÝÞÙ èÚÐÛÕ, àÐáßÞÛÞÖÕÝÝÞÙ ÝØÖÕ 
ÞÚÝÐ ßàÞáÜÞâàÐ ÒØÔÕÞ, ÞÑÞ×ÝÐçÐÕâ 
ßàÞáÜÐâàØÒÐÕÜëÙ ÚÐÔà.

2 ´Ûï ÒÞáßàÞØ×ÒÕÔÕÝØï, ßàØÞáâÐÝÞÒÐ, ßàÕÚàÐéÕÝØï 
ÒÞáßàÞØ×ÒÕÔÕÝØï, ßÕàÕåÞÔÐ Ò ÝÐçÐÛÞ ØÛØ ÚÞÝÕæ 
ÒØÔÕÞÚÛØßÐ ØáßÞÛì×ãÙâÕ ÚÛÐÒØèØ ãßàÐÒÛÕÝØï, 
àÐáßÞÛÞÖÕÝÝëÕ ßÞÔ ÞÚÝÞÜ ßàÞáÜÞâàÐ ÒØÔÕÞ. 
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¿Þ ÚÐÔàÐÜ ÒØÔÕÞÚÛØßÐ ÜÞÖÝÞ âÐÚÖÕ 
ßÕàÕÜÕéÐâìáï, ßÕàÕâÐáÚØÒÐï áØÝØÙ ÜÐàÚÕà ÒÔÞÛì 
ÒàÕÜÕÝÝÞÙ èÚÐÛë.

3 ´Ûï ÒëÑÞàÐ ÞâàÕ×ÚÐ ÒØÔÕÞÚÛØßÐ, ÚÞâÞàëÙ 
ÝÕÞÑåÞÔØÜÞ ÞÑàÕ×Ðâì, ßÕàÕÜÕáâØâì ØÛØ ãÔÐÛØâì, 
ÒëßÞÛÝØâÕ ÞÔÝÞ Ø× áÛÕÔãîéØå ÔÕÙáâÒØÙ:
• ¿ÕàÕâÐéØâÕ ÜÐàÚÕàë ÒëÑÞàÐ, àÐáßÞÛÞÖÕÝÝëÕ 

Ò ÝÐçÐÛÕ Ø ÚÞÝæÕ ÒàÕÜÕÝÝÞÙ èÚÐÛë.
• ´Ûï ÞâÜÕâÚØ ÝÐçÐÛìÝÞÓÞ ÜÞÜÕÝâÐ ÒàÕÜÕÝØ 

ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã 
«Shift», ×ÐâÕÜ éÕÛÚÝØâÕ âÞçÚã ÝÐ ÒàÕÜÕÝÝÞÙ 
èÚÐÛÕ. ́ Ûï ÞâÜÕâÚØ ÚÞÝÕçÝÞÓÞ ÜÞÜÕÝâÐ ÒàÕÜÕÝØ 
ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã «Ctrl», 
×ÐâÕÜ éÕÛÚÝØâÕ âÞçÚã ÝÐ ÒàÕÜÕÝÝÞÙ èÚÐÛÕ.

¿ÞáÛÕ ÒëÑÞàÐ ÝÕÞÑåÞÔØÜÞÓÞ ÞâàÕ×ÚÐ ÜÞÖÝÞ 
ßÕàÕâÐáÚØÒÐâì ßÞÛ×ãÝÞÚ ÒëÑÞàÐ ÒÔÞÛì ÒàÕÜÕÝÝÞÙ 
èÚÐÛë.

4 ´Ûï ãÔÐÛÕÝØï ÒëÑàÐÝÝÞÓÞ ÞâàÕ×ÚÐ ÒØÔÕÞ×ÐßØáØ 
éÕÛÚÝØâÕ ÚÝÞßÚã ÃÔÐÛØâì ÝÐ ßÐÝÕÛØ 
ØÝáâàãÜÕÝâÞÒ.
´Ûï ÞÑàÕ×ÚØ ÒëÑàÐÝÝÞÓÞ ãçÐáâÚÐ Ø ãÔÐÛÕÝØï 
çÐáâÕÙ, ÝÐåÞÔïéØåáï ×Ð ÕÓÞ ßàÕÔÕÛÐÜØ, éÕÛÚÝØâÕ 
ÚÝÞßÚã Crop ÝÐ ßÐÝÕÛØ ØÝáâàãÜÕÝâÞÒ.
´Ûï ÚÞßØàÞÒÐÝØï ÒëÑàÐÝÝÞÓÞ ÞâàÕ×ÚÐ Ø ÒáâÐÒÚØ ÕÓÞ 
Ò ÔàãÓãî ÒàÕÜÕÝÝãî âÞçÚã, éÕÛÚÝØâÕ ÚÝÞßÚã Copy 
ÝÐ ßÐÝÕÛØ ØÝáâàãÜÕÝâÞÒ. ¿ÕàÕâÐéØâÕ áØÝØÙ ÜÐàÚÕà 
ÒÔÞÛì ÒàÕÜÕÝÝÞÙ èÚÐÛë Ò âàÕÑãÕÜãî âÞçÚã 
Ø éÕÛÚÝØâÕ ÚÝÞßÚã Paste.

´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï
´Ûï ßÞÛãçÕÝØï ÔÞßÞÛÝØâÕÛìÝÞÙ ØÝäÞàÜÐæØØ 
Þ äãÝÚæØïå ßàÞÓàÐÜÜë ÒëÑÕàØâÕ ÁßàÐÒÚÐ > ÁßàÐÒÚÐ 
Adobe Photoshop Album Ò ÓÛÐÒÝÞÜ ÜÕÝî.

´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî 
Þ ßàØÛÞÖÕÝØØ Starter Edition áÜ. ßÞ ÐÔàÕáã 
www.adobe.com/products/photoshopalbum/starter.html.


